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T.0.V.A. 7.3 User’s Manual 2 ABOUT THE T.0.V.A.

Part I

Getting Started

Welcome to the T.O.V.A. 7.3 User’s Manual. Feel free to jump right in and install the T.O.V.A. by skipping
to Part IT (section II on page 7), but we’ve included this section in case you're not familiar with the T.O.V.A.
We'll tell you a bit about the T.O.V.A. and answer some common questions about it.

1 About This User’s Manual

This manual is the T.O.V.A. version 7.3 User’s Manual. It is meant to help you with all things technological
with regards to the T.O.V.A. This includes:

e Installing and uninstalling the T.O.V.A.
e A guide to using the T.O.V.A. on your operating system.

e A reference manual about the T.O.V.A. software and hardware.

This User’s Manual does not explain how to use the T.O.V.A. in a clinical or research context. For that
information, please see:

The Clinical Manual , which helps the clinician understand how the T.O.V.A. fits in their assessment
and monitoring of attention deficits.

The Screening Manual , which helps non-clinicians understand how to use the T.O.V.A. to screen for
attention deficits.

The Professional Manual , which describes the internal guts of the T.O.V.A., from a neuropsychological
test construction and statistical point of view.

2 About the T.O.V.A.

What is the T.O.V.A.?

The T.O.V.A. is an objective, neurophysiological measure of attention, not a subjective rating of behavior.
It is a 21.6 minute long, very simple “computer game” that measures your responses to either visual or
auditory stimuli. These measurements are then compared to the measurements of a group of people without
attention disorders who took the T.O.V.A.

The T.0O.V.A. assists clinicians by:

e Confirming clinical impression
e Measuring response to treatment

e Following attention over time
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‘Who uses the T.0.V.A.?

The clinical version of the T.O.V.A. is used by licensed clinicians, such as psychologists, physicians (including
psychiatrists, neurologists, pediatricians and family practitioners), and nurse clinicians to assist them in
accurately diagnosing and treating attention disorders.

The screening version of the T.0.V.A. is used in non-clinical settings, such as schools, human resource
departments, and rehabilitation programs.

What makes the T.O.V.A. unique?

e T.0.V.A. has a standardized computer game-like format and is easily administered.
e Any personnel can be trained to administer the test.
e Its reports are immediately available and easy-to-read.

e It measures both visual and auditory information processing, yet in separate tests to clearly identify
processing deficits.

e It is extensively normed for both children and adults (ages 4 to 80+)
e It precisely measures reaction times (+1 ms)
e It is language and culture free.

e It promotes efficient and effective communication with parents and schools by means of the Home and
School Intervention report.

For more information, please see our web site at http://www.tovatest.com/.

2.1 Some Frequently Asked Questions about the T.O.V.A.
2.1.1 How does the T.O.V.A. Test work?

It’s quite simple: the T.O.V.A. flashes stimuli on the screen (or beeps stimuli on speakers) and the subject
taking the T.O.V.A. Test responds as quickly and as accurately as they can with a small hand-held mi-
croswitch. This kind of ‘stimulus and response’ test is called a continuous performance test (CPT), and the
T.O.V.A. is one of many on the market. Of course, we think it’s the best!

Both the auditory and visual T.O.V.A. Tests are a little over 20 minutes long. The visual test has two simple
images that alternately flash on the screen, and the subject presses the button after the correct square. The
auditory test has a high and low pitched tone, and the subject presses the button after the high tone. Both
tests are horribly, terribly, inhumanly boring. But this is a good thing because you just can’t fake it with
the T.O.V.A.

The T.0.V.A. takes the subject’s responses and compares them to a study with thousands of ‘normal’ people
— that is, people who were screened for attention (and other) disorders and were deemed normal. This is
called the T.O.V.A. norming study, and it allows us to figure out where the subject’s responses fall on the
‘bell curve’ of normal. It critical that the number of people in a norming study is large, and the T.O.V.A.
still has the largest norming study of any CPT. The T.0O.V.A. also compares the subject’s responses to a
study with people diagnosed ADHD.

These comparisons are not diagnoses! Only a clinician can make a diagnosis. The T.0O.V.A. simply helps
the clinician with their diagnosis and treatment of attention disorders.
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2.1.2 What does the T.0O.V.A. measure?

The T.0.V.A. measures attentional variables — that is, it measures how people respond to a long, boring
test. There are dozens of peer-reviewed papers on the T.O.V.A. (see the T.0.V.A. Professional Manual for
an annotated bibliography) that show how these variables correspond to disorders of attention.

In particular, the T.O.V.A. measures (listed in order of importance):

Reaction Time Variability: How consistently (or not) a subject responded to the T.0.V.A. stimuli. Peo-
ple without attention disorders respond to the stimuli very consistently, and those who do have an
attention disorder tend to not be as consistent.

Reaction Time: People with attention disorders tend to respond to stimuli slower than normals.

Commissions: People with attention disorders tend to make more errors of impulsivity, which is when they
press the button when they shouldn’t.

Omissions: Most people don’t actually miss any stimuli, although omissions do tend to be higher for those
with attention disorders.

2.1.3 What’s all this about precision timing?

Because reaction times, and even more importantly, the variability of reaction times, are the core of any
CPT, the T.O.V.A. was designed with a very high timing accuracy. Although people respond to stimuli
on order hundreds of milliseconds, the consistency of reaction times can be only tens of milliseconds. And
because that’s the most sensitive variable in a CPT, it’s crucial that the reaction timing on a CPT be precise
— and reliable.

We like to say that the T.O.V.A. has ‘research-grade’ timing accuracy, because our timing is just that good.
But what’s just as important is that the timing is reliable. And so we go out of our way to make sure the
T.O0.V.A. is a reliable test.

Unfortunately, most modern operating systems like Windows, Macintosh and Linux don’t guarantee reliabil-
ity when it comes to timing. In fact, they do the opposite: they guarantee that eventually they will introduce
latencies and variable delays in timing. Believe us, we’ve tried to make them work for the T.O.V.A. Modern
operating systems have been designed from the ground up to be reasonably fast to user demands, but not
to be reliably and consistently fast. Have you ever seen your computer hesitate just a split second before it
does what you asked it to do? Happens all the time, right? That hesitation will make any CPT running on
these operating systems unreliable.

Thus, you can’t administer the T.O.V.A. Test in Windows.

We realize other people say you can, but they’ve never (to our knowledge) objectively measured their timing
performance with an external timing validation system. We have. We've measured timing reliability under
Windows (and Macintosh OS X), and it stinks.

So how do we get around this timing issue?

Instead of administering the test in Windows, we restart your computer into the Precision Test Environ-
ment (PTE). In the PTE, we’re able to ‘own’ the computer and thus guarantee reliability. And we make
it as seamless as possible, so all you have to do is choose to administer the test and we’ll take care of the
rest. When you’re done testing, we’ll take you right back to Windows.

Technically speaking, the PTE is currently based on the venerable Disk Operating System (DOS), but you
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don’t have to know anything about DOS to use it. The T.0.V.A. takes care of all the details. You won'’t
have to do anything special — the T.O.V.A. will handle the transition for you.

2.1.4 'Why do you charge per test?

We charge per test because we care that you have the very latest in tools to help you improve people’s
lives. This may sound like advertising, but we truly do believe it. Your clinical tools should be constantly
improving as new research and new ideas comes down the pipeline, and the T.O.V.A. will do this.

So instead of charging you an arm and a leg for the T.O.V.A., and leaving you in the dust as it improves,
we instead charge you per test and then give you new versions of the T.O.V.A. for free. Yes, for free. More
norms? Free. Improved user interface? Free. New statistics? Free.

And, we support you like no other testing company can: technical support is free. Whenever you have
question or problem with the T.0.V.A., contact us and we’ll help you. We're crazy about supporting our
users, so really don’t hesitate to call us if you can’t figure out something about the T.O.V.A.

And, even more importantly, clinical support is free. This means we have on-staff MDs and PhDs whose
job it is to help you interpret T.O.V.A. results. Do you have questions on how to use the T.O.V.A. to
measure medication effects? Do you not understand how comorbid disorders affect T.O.V.A. performance?
Are you baffled by the results of your last subject? Call us! We’ll help you understand it.

So, in summary, our per-test charge allows us to provide you with an excellent, constantly evolving test of
attention with full customer service.

We think that’s a pretty good deal.

2.1.5 What is the history of the T.O.V.A.?

The T.O.V.A. has its roots in a 1966 National Institute of Health research project. The equipment that gave
that CPT literally took up an entire wall. With the onset of the personal computer, it was ported to the
Apple Ile (and called the VIRTEST), then the Macintosh, and finally to the PC. This means the T.O.V.A.
has over 40 years of ongoing research behind it!

2.1.6 What will the future of the T.O.V.A. look like?

We're very excited about future versions of the T.O.V.A. We’ll be moving to a fully cross-platform and
internationalized program, and we're improving the T.O.V.A. hardware and timing technologies even more.
Since you already have the T.O.V.A., you also know that you’ll be getting all these software updates for
free.

2.2 T.O.V.A. 7.3 System Requirements

2.2.1 Windows 2000/XP installation requirements

e PC running Windows 2000 or XP
e DOS-compatible parallel port (this does not include USB parallel port adapters)

e Printing requires any Windows-compatible printer
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e 5MB or more free on disk

e Requires administrative privileges to install and run

2.2.2 Windows 95/98/ME installation requirements
e PC running Windows 95, 98, 98SE, or ME
— Windows ME requires the use of a boot floppy disk or CD-ROM
e DOS-compatible parallel port (this does not include USB parallel port adapters)
e Printing requires a DOS-compatible parallel port printer

e 5MB or more free on disk

2.2.3 DOS installation requirements

e PC with x386 or better processor running MS DOS 6.22, or FreeDOS 0.9 or later

e DOS-compatible parallel port (this does not include USB parallel port adapters)

Printing requires a DOS-compatible parallel port printer
e 5MB or more free on disk
e VGA or better graphics card

e 2 MB of memory (450 kB free conventional memory, 1 MB of XMS memory)

2.3 What’s in the T.O.V.A. 7.3 Kit

The following items should be included in the kit:

Software: The T.0O.V.A. 7.3 CD, with ‘Installation Guide’ and ‘Quick Reference Card’ pamphlets.

Hardware: The T.0.V.A. microswitch, Scorebox and (if you have the auditory version of the T.0.V.A.)
the T.O.V.A. Speaker Driver, ribbon connector, and speakers.

Manuals the T.0.V.A. User’s Guide, T.O.V.A. Professional Guide, and either the Clinical or the Screening
Guide.

Supplement Materials A welcome letter that has a unique Customer Number and Serial Number
which is needed for obtaining additional interpretation credits. The serial number is unique to each
T.0.V.A. Scorebox and serves as an identification number for support and service. Note that the serial
number is also printed on a sticker on the T.O.V.A. Scorebox.

2.4 What’s new in the T.O.V.A. 7.37

Although we have had a few ‘pre-release’ versions of the T.O.V.A. in the last few years (specifically the
T.0.V.A. 7.1 and 7.2) the real last stable release of the T.0.V.A. was the T.O.V.A. 7.0. We think you’ll be
pleased with the changes between the 7.0 and the 7.3:
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2.4.1 New Features

e Support for Windows 2000 & XP

— Starts the T.O.V.A. in Windows for file operations, reporting, printing, etc.

— Automatically and seamlessly restarts itself into the Precision Test Environment (PTE) for accu-
rate timing without requiring any special expertise on your PC

— Support for Windows printers, including USB and network printers
— Windows installers for both the T.O.V.A. and T.0.V.A. documentation

e Automatically generated group, subject, and session numbers.
e Major upgrade in the file interface:

— See subject names in the browse dialogs

Sort tests by test date, subject number, subject name, and file name.
— ‘Data path’ sets the location for reading and writing data files (useful for network drives)
— ‘Export path’ sets the location for writing exported T.O.V.A. reports

— Integrated copy, move and delete features

e Added home interventions

2.4.2 Major upgrades

e Huge improvements in the T.O.V.A. Report

— Reordered variables, in order of priority
— More consistent and applicable interpretation messages

— Improved norms

Improved main screen

Better Settings interface, with new settings for T.O.V.A. stimulus size and color

e Dramatically improved online help

Exported reports are now a single file

T.0.V.A. 7.3 CD is now a boot CD and Install CD

And suffice it to say that the quality of the T.O.V.A. has gone way up. A dramatic change in our development
practices in the last two years have started paying off in better quality products coming to you faster.

On that note, without saying too much, we think you’ll be even more pleased when you see the changes in
the next few versions of the T.O.V.A.; we've got some major upgrades coming. And, as always, you’ll get
them for free.
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Part II

Installing the T.O.V.A.

In Part IT of this manual, we’ll help you install the T.O.V.A. hardware and software. We’ll start with the
hardware:

e Installing the T.0O.V.A. hardware see section 3 on page 8.
. and then install the software, which depends on your computer’s operating system:

e Installing the T.0O.V.A. on Windows 2000 & XP see section 4 on page 11.
e Installing the T.0O.V.A. on Windows 95, 98 & ME see section 5 on page 22.
e Installing the T.0.V.A. on DOS see section 6 on page 32.

And finally, in the event you have to remove the T.O.V.A. from your computer, you can also find ‘uninstall’
instructions too:

e Uninstalling the T.O.V.A. in Windows see section 7 on page 36.
e Uninstalling the T.O.V.A. in DOS see section 8 on page 38.
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3 Installing the T.O.V.A. Hardware

The T.O.V.A. is software and hardware. The hardware you have depends on which version of the T.O.V.A.
you have. In fact, you can figure out which version you have by looking at your hardware: if you have a set
of computer speakers in your T.O.V.A. kit, then you ordered the auditory version.

Both the visual-only and the visual and auditory T.O.V.A. Tests have:

T.O.V.A. microswitch: The T.O.V.A. microswitch is the input device to the T.O.V.A. Test. Instead
of wildly inaccurate mice or keyboards (inaccurate in both the time and ergonomic domains), the
T.O.V.A. uses a standardized microswitch which performs reliably and consistently across literally
millions of presses.

T.O.V.A. Scorebox: the T.0.V.A. Scorebox keeps track of how many interpretation credits you have, and
whether your test is the clinical or screening version of the T.O.V.A.

Figure 1: T.O.V.A. hardware for the visual test: the T.O.V.A. microswitch and Scorebox.

If you also have the auditory T.0.V.A. Test, then you’ll have:

T.O.V.A. Speaker Driver: The T.0.V.A. Speaker Driver generates the auditory stimuli (tones) necessary
for the auditory T.O.V.A. Test.

Powered speakers: The powered speakers play the tones generated by the T.O.V.A. Speaker Driver.

Ribbon cable: The ribbon cable is shipped with the T.O.V.A. in case you need to use a parallel printer (or
other parallel port device) with the T.O.V.A. Speaker Driver. Otherwise, you won’t need the ribbon
cable.

Loop-back plug: The loop-back plug is a small connector which helps your printer port recognize the
T.O.V.A. microswitch. You won’t be connecting this unless T.0.V.A. Technical Support asks you to.

¥ iR

Figure 2: T.O.V.A. hardware for the visual and auditory tests: the T.O.V.A. microswitch, Scorebox,
Speaker Driver, and ribbon cable.
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3.1

(SR

Setting up the Visual-only T.O.V.A. Test

. Unpack all of the T.O.V.A. hardware from the T.O.V.A. kit.

Make sure your computer is off.

Identify the parallel port on your computer. It’s on the back, and it’s shaped like a very tall ‘D’ with
25 small holes in it. The plastic inside the connector is usually pink or black.

Identify the T.O.V.A. microswitch and Scorebox.

Plug the Scorebox, the small beige box, into the parallel port on your computer. You’ll see the word
“computer” with small arrows on it; plug that end into your computer.

That’s it! Your hardware is installed. We'll lead you through testing it later in this manual after we
install the software.

L

Figure 3: Basic T.0O.V.A. hardware (visual T.O.V.A. Test only) on a typical laptop.

Setting up the Visual and Auditory T.O.V.A. Test

Unpack all of the T.O.V.A. hardware from the T.O.V.A. kit.
Make sure your computer is off.

Identify the parallel port on your computer. It’s on the back, and it’s shaped like a very tall ‘D’ with
25 small holes in it. The plastic inside the connector is usually pink or black.

The T.0.V.A. microswitch, Scorebox, and Speaker Driver should all be connected together. Plug the
connector that is by itself at one end of the ribbon cable into the parallel port of your computer.

Plug the powered computer speakers into a wall socket (or power strip) and turn them on (you should
see some kind of power light).

Plug the audio connector from the speakers into the back of the T.0.V.A. Speaker Driver (the ‘T’
shaped beige box).

That’s it! Your hardware is installed. We’ll lead you through testing it later in the manual after we
install the software.

Figure 4: T.O.V.A. hardware (visual and auditory T.O.V.A. Tests) on a typical laptop.
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3.3 Optional: Using a Legacy Sound Blaster-compatible Sound Card

In the unlikely event that you’re running the T.O.V.A. on a pre-1999 PC and you know that the DOS-
mode environment of your Windows 9x PC has drivers for your sound card, then you may use a Sound
Blaster-compatible sound card instead of the T.O.V.A. Speaker Driver. To do this, simply plug the powered
computers speakers’ audio connector into the ‘line out’ jack of your sound card. In the T.O.V.A. setup (see
Part II), you’ll also need to choose ‘Sound Blaster-compatible sound card’ for your sound source.

3.4 Optional: Using a Parallel Port Printer

If you still have a parallel port printer that you’re using for the T.O.V.A., then go ahead and plug it into
the back of the Scorebox. You'll still have to use a parallel port printer if you're using the T.O.V.A. on a
DOS, Windows 95, 98 or ME computer.

If you are running the T.0O.V.A. on a Windows 2000 or XP computer, we do not recommend using a parallel
y g p 5 gap

port printer if you can help it. Note that the T.O.V.A. 7.3 can now use all Windows-compatible printers
(including USB and network printers).
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4 Installing the T.O.V.A. 7.3 on Windows 2000 & XP

4.1 Before You Install the T.O.V.A. 7.3

WARNING! If you have existing T.0O.V.A. data files on your computer, we always recommend that you
back up your data before installing or uninstalling the T.O.V.A. While installing or uninstalling the T.O.V.A.
7.3 should never remove your T.O.V.A. data files, you can never be too careful!

IMPORTANT: If you have an older T.O.V.A. release (specifically the T.0.V.A. 7.0.x), you should try to
install the T.O.V.A. 7.3 into the same path (by default, C:\TOVA_7). If you install the new version over
the old version, the T.O.V.A. 7.0.x will automatically be moved and preserved. We’ll lead you through this
process below, but we thought you might want to be pre-warned so you can find your old installation first.

IMPORTANT: If you previously installed a pre-release T.O.V.A. version (versions 7.1 or 7.2), uninstall
it before installing the T.0.V.A. 7.3! This is very important, as many things have changed between these
pre-release versions and the 7.3. We strongly recommend you give us a call and we’ll step you through it.

IMPORTANT: You need administrative access to your PC in order to install and run the T.O.V.A. If you
own your computer, then you most likely have administrative access to your computer. If your computer
is part of a big institution and you have IT staff that install programs for you... well, then, you probably
don’t. Contact your IT staff and ask if you can get administrative privileges to your PC. If they start asking
pesky questions about why, just tell them to give our Technical Support a call, and we’ll be happy to talk
with them about it. Note that future versions of the T.O.V.A. will allow you to run as a restricted user, but
not the T.O.V.A. 7.3 (sorry).

UNIMPORTANT! Hooray for you, you're actually reading the installation guide! We appreciate it, as
many people never read our fine manuals.

4.2 Starting the T.O.V.A. 7.3 CD

Go ahead and insert the T.O.V.A. 7.3 CD into your CD-ROM drive. The Install TOVA program (Figure 5)
should automatically start. If the program doesn’t appear when you insert the CD, go to ‘My Computer’
and double-click on the CD drive to launch it manually. If that doesn’t do it, then right-click the CD drive,
select ‘Open’, and in the Explorer window double-click on the Install TOVA program icon.

B install TOVA EEX
©OTOVA 7.3
Install Programs View Documentation

] nstallthe T OV A 724343 [ ‘ Installation Guide ‘

Install T.0 W A Documentation

‘ Install Foxit PDF Reader ‘ ‘ Quick Reference Card ‘

Clinical Manual

‘ Exit ‘ ‘ Help ‘ ‘ Professional Manual ‘

' Run this program when the ©0 is launched

Figure 5: The ‘Install TOVA’ program

The Install TOVA program allows you to install the T.O.V.A. 7.3 and install T.O.V.A. documentation. It
also allows you to view the manuals on the fly - just click on any of the ‘View Documentation’ buttons to
immediately see the documentation. Yes, even the T.O.V.A. 7.3 User’s Manual is available this way.
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4.3 Installing the T.O.V.A. 7.3

In Install TOVA, click on the ‘Install TOVA 7.3-4552’ button to launch the T.O.V.A. 7.3 installer. Note
that those four digits after the dash is your T.O.V.A. ‘build’ number, which is always helpful to know for
any call to T.O.V.A. Technical Support.

We strongly recommend that you accept all defaults when installing the T.O.V.A. 7.3, except as noted in
the ‘License Agreement’ and ‘Destination Directory’ sections below.

Note: If ‘BOOT.INT’ cannot be found on your system, you may see the dialog in Figure 6.

WARNING X

‘BOOT.IMI' was nat found on the same drive az
your Windows installation. |n order to make the
T.0M.A Boot Image Environment work, on
your computer, pou will hawve to manually move
the Boot Image Environment components to
your boot diive,

Please contact T.0 W A Technical Support
with the above ermor message at B00.729.2836
[F14.223.8770) or email uz at
supparti@toyatest. com.

Figure 6: Warning: ‘boot.ini’ not found

In this case, you may continue to install the T.O.V.A. 7.3, but you will not be able to use the Precision Test
Environment (PTE), which is a critical component for administering T.O.V.A. Tests. You'll definitely want
to contact T.O.V.A. Technical Support so we can help you figure out what’s going on.

4.3.1 Welcome screen

This program will install the T.04.4. 7.3 on pour computer,

Its strongly recommended that you exit 3l windows programs
before runring this Seh

Clisk Cancel to quit Setup and close ary programs you have
tuning. Click Next to conlinue with the Setup program.

WARNING: This pragram is protected by copyright law and
intemational treaties

Unauthorized reproduction or ditibulion of this program, or any
partion of it may 1esul in severe civl and criminal penalties, and
willbe piosecuted to the masimum extent possible unde lav

Figure 7: The T.0.V.A. 7.3 installer welcome screen

When you see Figure 7, the installation has begun. Click ‘Next’.
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4.3.2 License agreement

ZT.0V.A 73

License Agreement o

T.0.4.4, - TEST OF Y&RIABLES OF ATTENTION ~
SOFT'WARE LICENSE AGREEMENT

The TOVA Company
4201 KATELLA AVENUE H215
LOS ALAMITOS, C& 90720

NOTICE
PLEASE READ THE FOLLOWING AGREEMENT CAREFULLY. OPENING THIS
ENVELOPE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND
(COMDITIONS, IFYOU DO NOT AGREE '/ITH THEM, PROMPTLY RETURN THE
UNOPENED PACKAGE AND YOUR LICENSE FEE W/ILL BE REFUNDED P
@ [Bgres
" | Disagree

< Back et Cancel \

Figure 8: The T.0.V.A. software license

If you accept our License Agreement (Figure 8), choose ‘I Agree’ and click ‘Next’. If you don’t accept it, then
you can’t install the T.O.V.A. 7.3, so click ‘Cancel’ and then ‘Exit’ on the next dialog. And then give us a
call, because we’d love to know why you don’t agree with it. We think it’s a pretty good license agreement,
if we do say so ourselves.

4.3.3 Choosing the install folder (“destination directory”)

£ T.0V.A 7.3 3
Destination Location o
=S

Setup willinstall T.0.V.A. 7.3 in the follawing folder.

“we stronaly recommend that you do not chanoe the default installation folder. If wou must
install the T.0..A. 7.3 into a different folder, ciick Browse, and select anather folder,

You can choase nat to install T.0.V.4, 7.3 by clicking Cancel ta exit Setup.

Destination Folder

CATOVA_7 Browse.

ise Installation Wizard®

S i

il Cancel

Figure 9: Choosing a destination path

Figure 9 shows the Destination Location dialog. Now you need to decide where on your computer to install
the T.O.V.A. Here are a series questions that will help you decide:

1. Is there any version of the T.O.V.A. currently installed on this system?

No: Skip to question #6.

Yes or I don’t know: Proceed to question #2.
2. Is the T.O.V.A. 7.3 currently installed on this system?

I don’t know: Check ‘Add/Remove Programs’ under your Windows Control Panel. It will list your
installed programs, including the ‘T.O.V.A. 7.3" if it is installed.

Yes: You are just updating your T.O.V.A. 7.3 installation. Great! Install this later version of the
T.0.V.A. 7.3 to the same location as the previous version, choosing the same settings (‘Desti-
nation directory’, ‘Install shortcuts for All Users?’) as last time. You’re finished with these
questions!
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No: Proceed to question #3.
3. Is there a pre-release T.O.V.A. (version 7.1 or 7.2) currently installed on this system?

I don’t know: Check ‘Add/Remove Programs’ under your Windows Control Panel. Tt will list your
installed programs, including the pre-release T.O.V.A. if it is installed.

Yes: Please do not proceed any further. Cancel the T.O.V.A. 7.3 installer, use ‘Add/Remove Pro-
grams’ to uninstall the pre-release T.O.V.A., and then install the T.O.V.A. 7.3. You should
uninstall any pre-release T.0.V.A. Documentation as well.

No: Proceed to question #4.
4. TIs the T.O.V.A. 7.0 currently installed on this system?

I don’t know: The best place to look for the T.O.V.A. 7.0 is in its default location at ‘C:\TOVA_7’.
It may have been installed in the same location on other drives as well. The directory will contain
a file named TOVA.EXE.

No: Either you have a very old version of the T.O.V.A. (contact T.O.V.A. Technical Support), or you
may want to review questions 1, 2, and 3 again.

Yes: Proceed to question #5.
5. Where is the T.O.V.A. 7.0 currently installed on this system?

I don’t know: You know the 7.0.3. is installed somewhere but you just can’t find it, even using the
suggestions in Question #4. Please contact T.O.V.A. Technical Support.

Something like ‘C:\TOVA_70’: You likely have previously installed and removed the T.O.V.A. 7.3
(or a pre-release version). Install the T.O.V.A. 7.3 to the same drive and directory as you did
previously (do not install it into the tova_70 folder). You're finished with this chart!

Something like ‘C:\TOVA_7’ or ‘D:\TOVA_7’: Select that directory to install the T.O.V.A. 7.3 and
click ‘Next’. Your T.O.V.A. 7.0.x folder will be renamed to so that you can install the T.O.V.A.
7.3 in its place. You’re finished with these questions!

6. We recommend that you use the Precision Test Environment (PTE) as it’s easier than remembering to
insert and remove the T.0.V.A. Boot CD every time you want to enter or exit T.0.V.A. Test mode.
If you will be using the T.O.V.A. Boot CD, however, you will want to install the T.O.V.A. to a FAT32
partition, and not an NTFS partition.

Will you be using the BOOT CD instead of the PTE?

No: Simply click ‘Next’ to select the default destination directory of ‘C:\TOVA_7’. You’re finished
with these questions!

Yes: Proceed to question #7.
7. Do you know what ‘NTFS’, ‘FAT32’, or ‘partitions’ are?

Yes: Congratulations, you're a geek like us. Install the T.O.V.A. 7.3 to one of your FAT32 partitions,
so that when you reboot to FreeDOS on the BOOT CD, you will be able to access your T.O.V.A.
7.3 installation.

No: Congratulations, you're not a geek like us (which is probably the better option here). If you
know that you want or need to use the T.O.V.A. 7.3 Boot CD, but you don’t know why, contact
T.0O.V.A. Technical Support.

Based on the outcome of the above questions, you can either just hit ‘Next’ and continue, or go ahead and
click on the ‘Browse’ button in order to input a different path.
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4.3.4 Renaming your existing T.0.V.A. 7.0 installation

If you have an older version of the T.O.V.A. on your computer, you may then see the following dialog:

Rename T.O.V.A. 7.0 Installation a
SN

4 older T.0.V.A. 7.0 instalation was faund. The T.0 V.4 7.3 needs ta 1ename your older
T.0MA 7.0instalation folder

We stiangly recommend that you rename this folder
" Ho, do nat rename this folder

5 Yes, rename my folde to:
CATOVA_70

ise Instalation \Wizard®

Figure 10: Renaming an existing T.O.V.A. 7.0 installation

This means that you’ve chosen to install your T.O.V.A. 7.3 to the same location as your T.O.V.A. 7.0.x
installation. Great! We want to rename and thus move your 7.0.x installation so that you can install the
T.0.V.A. 7.3 in its place. If you have existing data files under this path (for instance, ‘C:\TOVA_7\FILE’), the
T.0.V.A. 7.3 installer will eventually ask you if you want to automatically copy them into the new T.O.V.A.
7.3 installation. Click ‘Next’ to accept the default values and continue.

4.3.5 Installing files

£ T.0V.4 2.3 5]
Start Installation 6
=N

“You are now ready to install the T.0.V.A. 7.3

Click the Mext button to begin the installation or the Back button to reenter the installation
information.

ise Installation Wizard®

Figure 11: Ready to start the installation

Click ‘Next’ to proceed to install the T.O.V.A. 7.3.

Installing 6
R

Curtent Fie =
Copying fil:
CATOVA Mfoms\fomE.rpt

ENEEENNEEEEEENEEENEEENEEENEEEEEE
AllFiles

Time Remaining 0 minutes 2 seconds

ise Installation W/izard®

| =

Figure 12: Installing files
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While the T.O.V.A. 7.3 files are installing, you'll see Figure 12. It shouldn’t be long before the process

completes.

4.3.6 Copying your data files

If you see the following dialog, we found and renamed your 7.0.x installation, and we can now automatically
copy the 7.0.x data files to your new 7.3 installation.

Figure 13: Ready to copy over existing data files

However, if you see this dialog:

then you've got two choices:

£ T.0V.A 7.3

e stiangly recommend that you copy the T.0V.4. data files from the alder T.0.%.4, 7.0
installation ta the nev T.0.V.A. 7.3 installaion

" Donot copy the T.0.V.A. data files.

& Copythe T.0M.A datafies located in

CATOVA_PINFILE Browse.

ise Instalation \Wizard®

Copy Data Files o

RN

ZT.0V.A 73

Copy Data Files c

RN

If you have an older T.0 % 4. 7.0 installation on this computer, we stonaly recommend that
and indicate where the T.0.V.A. data files are located.
@ No, don't copy any files.

" Yes, copy the T.0.V.A. data fles located in

<No Path Selected>

ise Installation wizard®

pou copy the T.0V.A, data files to the new T.0N A, 7. 3installation. To copy the files, select
es' ate

Figure 14: No existing data files found

1. If there’s no previous installation of the T.O.V.A. on this computer, then ignore this dialog and just

hit ‘Next’.

2. If you do have the older T.O.V.A. 7.0.x installed on your computer, then the T.O.V.A. 7.3 installer
couldn’t find it. If you want to copy over data files from the previous installation, hit the ‘Browse’
button and point the installer to where those data file are located (usually they’re in the FILE folder
in the TOVA_7 folder located on one of your drives). If you just can’t find it, go ahead and finish your
installation, accepting all remaining defaults, and contact T.O.V.A. Technical Support. We can help
you copy over your data files to the new location.

If you saw neither dialog, no worries, it means you’ve previously installed the T.O.V.A. 7.3.

The TOVA Company
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4.3.7 Installing shortcuts

Install Shorteuts o

& Install shortculs for al users,

" Irstall shiortcuts for just this user,

[V Add a shorteut to the desktop

ise Installation wizard®

[ Cancel

Figure 15: How shortcuts should be installed

We recommend installing the T.O.V.A. shortcuts for all users. You may or may not want us to add a shortcut
for the T.O.V.A. 7.3 to your desktop. It’s up to you.

4.3.8 Installation finished

£ T.0V.A. 2.3 X
The T.0.A 7.2 has been successhully installed.

Click the Firish button ta exit this installation.

Figure 16: T.O.V.A. 7.3 installer is finished!

Congratulations! You’ve finished installing the T.O.V.A. You should have a shortcut in your Start menu
under the T.O.V.A. program group and perhaps an additional one on your desktop. You may use either to
run the T.O.V.A.

For the curious, we have also added a T.O.V.A. shortcut in your Windows Startup folder in ‘Programs’
under the Start menu. See the section on T.0.V.A. Modes (section 37 on page 176) if you want to know
why.

Next, on to the T.0.V.A. Documentation!

4.4 Installing the TOVA 7.3 Documentation

This entire section is optional, although we strongly recommend you do install the T.O.V.A. documentation.
It’s always handy to have it on the computer that the T.O.V.A. is on. To get started:

1. Return to the ‘Install TOVA’ program. If it’s not already running, insert the T.O.V.A. CD or go to
‘My Computer’ and double-click on the CD drive to launch it manually.
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2. Select ‘Install T.O.V.A. 7.3 Documentation’.

4.4.1 Welcome to the T.O.V.A. 7.3 documentation installer

0.V.A. 7.3 Documentation X
This program willinstall T.0¥.4. 7.3 Documentation onto your
computer.

Click Cancel to quit Setup. Click Newt to continue with the Setup
progiam.

WARNING: These documents are protected by copyright law and
intemational tieaties.

Unathorized reproduction or distribution of this documentation. or

any portion of it, may result in severe civil and criminal penalties,
and will be prosecuted to the maximum extent possible under law,

Figure 17: Welcome screen

If you see the screen in Figure 17, installation has begun, and you're on your way.

4.4.2 Choosing the install (“destination”) folder

£2 1.0.V.A. 7.3 Documentation

Destination Location 6

Setup willinstall T.0.V.A4. 7.3 Documentation in the follawing folder.

“wie stonaly recommend that you do not chanoe the default installation folder. 1f ou must
instal the T.04.4, 7.3 Documentation into a different folder, click Browse, and select
another folder,

“You can choose not to install T.0.V.A, 7.3 Documentation by clicking Cancel to exit Setup.

Destination Folder

Ciitava_7hdocs Browse.

ise Installation Wizard®

< Back

Cancel

Figure 18: Choosing the install directory

If you installed the T.O.V.A. 7.3 to a different directory from the default, you may want to select the same
Install or “Destination” directory in Figure 18 for the 7.3 documentation, but it’s not necessary.
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4.4.3 Installing the Foxit Reader

£2 T.0..A. 7.3 Documentation X
Install Foxit Reader? G

T.0M.A. documentation is installed in the Portable Document Format (POF),

If you do nat have a PDF viewe; Adobe Reader) installed on this computer,
chonse the default option to instal the: documentation using the Fosit PDF Reader.

& Install Documentation with Fosit Feader

" Install Only the D ocumentation

ise Installation wizard®

< Back Cancel

Figure 19: Installing Foxit Reader

If you do not have a PDF reader installed (e.g., Adobe Reader), accept the default option to install the
documentation with a built-in PDF reader. If you already have a PDF reader installed, select ‘Documentation
only’.

Note that we’ve included a free PDF reader on the T.O.V.A. 7.3 CD just for you. So you can also select
‘Documentation only’ and then later install the Foxit PDF reader (see section 5.4.5 on page 30).

4.4.4 Installing shortcuts

£2 1.0.V.A. 7.3 Documentation

Install Shortcuts o

(% Install shortcuts for all users,

" Install shorteuts for just this user.

ise Installation Wizard®

<aack [

il Cancel

Figure 20: Where to install shortcuts

You should install T.O.V.A. documentation shortcuts for the same users you did the T.O.V.A. application.
In other words, if you did not install T.O.V.A. shortcuts for ‘all users’, you will probably want to install the
T.0.V.A. documentation for ‘just this user’ as well (see Figure 20).

4.4.5 Start installing files

That’s about it. On the dialog shown in Figure 21 choose ‘Next’.
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£ T.0.V.A. 7.3 Documentation

Start Installation o

“Y'ou are now ready to install T.0.V.A. 7.3 Documentation,

Click the Next button to begin the installation or the Back buticr to resnter the installation
information.

ise Installation wizard®

< Back Cancel

Figure 21: Start installing files

T.0.V.4. 7.3 Documentation

Installing
RN

g - a8
Copying Documentation flles:
€ \ova_P\docs!Professional Manual pdf

Current File

ENENEEEEEENNEEEEEN
AllFiles

Time Flemaining O minutes 4 seconds

(1] ]

ise Installation W/izand®

| | [caneat

Figure 22: Progress installing files

42 T.0.Y.A. 7.3 Documentation X

T.0V.A 7.3 Documentation has been successfully installed.
Click the Firish button to esit this nstallaion

To access the documentation, choose the 'Start! o
Programs (o1 All Programs], 'T.0V.A " and then the document
you wish o view,

Figure 23: Install finished

You'll see Figure 22 and then Figure 23. Click ‘Finish’ because you are finished installing the T.O.V.A. 7.3
Documentation.

4.4.6 Optional: Installing the free Foxit PDF Reader

We've included a free (just for you!) version of a PDF reader program called ‘Foxit Reader’. If you chose
‘Documentation only’ when installing the documentation and you don’t have a PDF reader installed on this
computer, then you should install Foxit Reader.

1. Return to the ‘Install TOVA’ program. If it’s not already running, insert the T.O.V.A. CD or go to
‘My Computer’ and double-click on the CD drive to launch it manually.

2. Select ‘Install Foxit PDF Reader’.
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We recommend that you choose all the defaults.

4.4.7 You’re done installing the T.O.V.A.! Now what?

We strongly recommend that you go ahead and read the quick and helpful "Using the T.O.V.A. under
Windows 2000 and XP’ guide: section 11 on page 42.
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5 Installing the T.O.V.A. 7.3 on Windows 95, 98, & ME

You have the T.O.V.A. 7.3 and you're about to install it on your, er, slightly older PC that’s running
Windows 95, 98, 98SE, or ME. These instructions are for you!

5.1 Before You Install the T.O.V.A. 7.3

WARNING! If you have existing T.O.V.A. data files on your computer, we always recommend that you
back up your data before installing or uninstalling the T.O.V.A. While installing or uninstalling the T.O.V.A.
7.3 should never remove your T.0.V.A. data files, you can never be too careful!

IMPORTANT: If you previously installed a pre-release T.O.V.A. version (versions 7.1 or 7.2), uninstall
it before installing the T.0.V.A. 7.8/ This is very important, as many things have changed between these
pre-release versions and the 7.3. We strongly recommend you give us a call and we’ll step you through it.

IMPORTANT: You can install the T.O.V.A. 7.3 under Windows, but you may not run the T.0.V.A.
7.3 from within Windows! To run or operate the T.O.V.A., you must be under DOS and out of the
Windows environment. We’ll help you set up an easy and quick way to get to DOS mode below. For more
information on why you can’t run under Windows, see the ‘Why can’t I test in Windows?’ section.

UNIMPORTANT! Hooray for you, you're actually reading the installation guide! We appreciate it, as
many people never read our fine manuals.

5.2 Starting the T.O.V.A. 7.3 CD

Go ahead and insert the T.0.V.A. 7.3 CD into your CD-ROM drive. The Install TOVA program (Figure 24)
should automatically start. If the program doesn’t appear when you insert the CD, go to ‘My Computer’
and double-click on the CD drive to launch it manually. If that doesn’t do it, then right-click the CD drive,
select ‘Open’, and in the Explorer window double-click on the Install TOVA program icon.

B install TOVA EEX
OTOVA 7.3
Install Programs View Documentation

] nstallthe T OV A 724343 [ ‘ Installation Guide ‘

Install T.0 W A Documentation

‘ Install Fosit PDF Reader ‘ ‘ Quick Reference Card ‘

Clinical Manual

‘ Exit ‘ ‘ Help ‘ ‘ Professional Manual ‘

' Run this program when the ©D is launched

Figure 24: The ‘Install TOVA’ program

The Install TOVA program allows you to install the T.O.V.A. 7.3 and install T.O.V.A. documentation. It
also allows you to view the manuals on the fly - just click on any of the ‘View Documentation’ buttons to
immediately see the documentation. Yes, even the T.O.V.A. 7.3 User’s Manual is available this way.
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5.3 Installing the T.O.V.A. 7.3

In Install TOVA, click on the ‘Install TOVA 7.3-4552’ button to launch the T.O.V.A. 7.3 installer. Note
that those four digits after the dash is your T.O.V.A. ‘build’ number, which is always helpful to know for
any call to T.O.V.A. Technical Support.

We strongly recommend that you accept all defaults when installing the T.O.V.A. 7.3, except as noted in
the ‘License Agreement’ and ‘Destination Directory’ sections below.

5.3.1 Welcome screen

This program willinstall the T.0.4.4. 7.3 on your compuler.

Its strongly recommended that you exit 2l windows programs
before runring this Seh

Click Cancel to quit Setup and close any programs you have
running, Click Next to continue with the Setup program.

WARNING: This program is protected by copyright law and
b intemational treaties,

Unavtharized repraduction or distibulion of this pragram, or any
partion of it may resul in severe civl and criminal penalties, and
wil be prosecuted to the masimum extert possible under law

Figure 25: The T.O.V.A. 7.3 installer welcome screen

When you see Figure 25, the installation has begun. Click ‘Next’.

5.3.2 License agreement

2 T.0V.A 73 X
License Agreement G

T.0:.A - TEST OF VARIABLES OF ATTENTION -~
SOFTWARE LICENSE ABREEMENT E|
The TOVA Company

4281 KATELLA AVENUE #215

LOS ALAMITOS, Ca 90720

NOTICE

PLEASE READ THE FOLLOWING AGREEMENT CAREFULLY. DPENING THIS
ENVELDPE INDICATES 'YOUR ACCEPTANCE OF THESE TERMS AND
CONDITIONS. IF YOU DO NOT AGREE /ITH THEM, PROMPTLY RETURN THE
IUNOPENED PACKAGE AND YOUR LICENSE FEE w/ILL BE REFUNDED

@ [Bared

" | Disagree

< Back Newt> Cancel ‘

Figure 26: The T.O.V.A. software license

If you accept our License Agreement (Figure 26), choose ‘I Agree’ and click ‘Next’. If you don’t accept
it, then you can’t install the T.O.V.A. 7.3, so click ‘Cancel’ and then ‘Exit’ on the next dialog. And then
give us a call, because we’d love to know why you don’t agree with it. We think it’s a pretty good license
agreement, if we do say so ourselves.
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5.3.3 Choosing the install folder (“destination directory”)

2T.0V.473 Ed
Destination Location o

Setup willinstall T.0.V.A. 7.3 the follawing folder

“You can cheose not to install T.0.V.A, 7.3 by clicking Cancel to exit Setup.

Desfination Folder

CATOVA_T Browse,

ise Instalation \Wizard®

Figure 27: Choosing a destination path

Figure 27 shows the Destination Location dialog. Now you need to decide where on your computer to install
the T.O.V.A. Here are a series questions that will help you decide:

1. Is there any version of the T.O.V.A. currently installed on this system?

No: Simply click ‘Next’ to select the default destination directory of C:\TOVA_7 and skip to the next
section. You’re finished with these questions!

Yes or I don’t know: Proceed to question #2.
2. Is the T.O.V.A. 7.3 currently installed on this system?

I don’t know: Check ‘Add/Remove Programs’ under your Windows Control Panel. It will list your
installed programs, including the ‘T.O.V.A. 7.3’ if it is installed.

Yes: You are just updating your T.O.V.A. 7.3 installation. Great! Install this later version of the
T.0.V.A. 7.3 to the same location as the previous version, choosing the same settings (‘Desti-
nation directory’, ‘Install shortcuts for All Users?’) as last time. You’re finished with these
questions!

No: Proceed to question #3.
3. Is there a pre-release T.O.V.A. (version 7.1 or 7.2) currently installed on this system?

I don’t know: Check ‘Add/Remove Programs’ under your Windows Control Panel. It will list your
installed programs, including the pre-release T.O.V.A. if it is installed.

Yes: Please do not proceed any further. Cancel the T.0.V.A. 7.3 installer, use ‘Add/Remove Pro-
grams’ to uninstall the pre-release T.O.V.A., and then install the T.O.V.A. 7.3. You should
uninstall any pre-release T.0.V.A. Documentation as well.

No: Proceed to question #4.
4. Is the T.O.V.A. 7.0 currently installed on this system?

I don’t know: The best place to look for the T.O.V.A. 7.0 is in its default location at C:\TOVA_7. It
may have been installed in the same location on other drives as well. The directory will contain
a file named TOVA.EXE.

No: Either you have a very old version of the T.O.V.A. (contact T.0.V.A. Technical Support), or you
may want to review questions 1, 2, and 3 again.

Yes: Proceed to question #5.

5. Where is the T.O.V.A. 7.0 currently installed on this system?
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I don’t know: You know the 7.0.3. is installed somewhere but you just can’t find it, even using the
suggestions in Question #4. Please contact T.O.V.A. Technical Support.

Something like ‘C:\TOVA_70’: You likely have previously installed and removed the T.O.V.A. 7.3
(or a pre-release version). Install the T.O.V.A. 7.3 to the same drive and directory as you choose
in the previous installation (and not in the ‘TOVA_7 directory). You're finished with this chart!

Something like ‘C:\TOVA_7’ or ‘D:\TOVA_7’: Select that directory to install the T.O.V.A. 7.3 and
click ‘Next’. Your T.O.V.A. 7.0.x folder will be renamed to so that you can install the T.O.V.A.
7.3 in its place. You’re finished with these questions!

5.3.4 Renaming your existing T.O.V.A. 7.0 installation

If you have an older version of the T.O.V.A. on your computer, you may then see the following dialog:

2 T.0V.A 1.3

Rename T.O.V.A. 7.0 Installation
=N

A older T.0.V.A. 7.0 instalation was faund. The T.0 V.4 7.3 needs t rename your older
1

T.0.V.A. 7.0 instalation folder

“w'e stangly recommend that you rename this folder,

(Mo, do not rename this folder

& Yes, rename my folder to:

CATOVA_70

ise Installation Wizard®

Figure 28: Renaming an existing T.0.V.A. 7.0 installation

This means that you’ve chosen to install your T.O.V.A. 7.3 to the same location as your T.O.V.A. 7.0.x
installation. Great! We want to rename and thus move your 7.0.x installation so that you can install the
T.0.V.A. 7.3 in its place. If you have existing data files under this path (for instance, ‘C:\TOVA_7\FILE’), the
T.0.V.A. 7.3 installer will eventually ask you if you want to automatically copy them into the new T.O.V.A.
7.3 installation. Click ‘Next’ to accept the default values and continue.

5.3.5 Installing files

£ T.0V.A.2.3 X
Start Installation o
SN
You are now teady to install the T.0.V.A. 7.3
Clck the Nest button to begin the nstallation or the Back bution to reentet ths installation
nfomation
ise Installation Wizard®
< Back Hes Cancel

Figure 29: Ready to start the installation

Click ‘Next’ to proceed to install the T.O.V.A. 7.3.

The TOVA Company 800.729.2886 562.594.7700 infoQtovatest.com 25



T.0.V.A. 7.3 User’s Manual 5 INSTALLING THE T.O.V.A. 7.3 ON WINDOWS 95, 98, & ME

Installing

Curent File

Copying fil

e:
CATONA,_Phforms'form.ipt

ENENEENEENEEENEEENEENNEEEEEEEEEE
AllFiles

Time Remaining 0 minutes 2 seconds

ENEEEEEEEEEEEEEEEE

ise Irstallation w/izard®

| | [carcel

Figure 30: Installing files

While the T.O.V.A. 7.3 files are installing, you'll see Figure 30. It shouldn’t be long before the process
completes.

5.3.6 Copying your data files

If you see the following dialog, we found and renamed your 7.0.x installation, and we can now automatically
copy the 7.0.x data files to your new 7.3 installation.

£ T.0V.4 2.3 5]
Copy Data Files O
RN

We stiongly recommend that you copy the T.0.V.4. data fies fiom the older T.0.¥.4. 7.0
installation ta the nev T.0.V.A. 7.3 installaion

" Donotcopy the T.0V.A. data fies.

" Copy the T.0Y.A, data files located in:

CATOVA_TOVFILE Byouise.

ise Installation Wizard®

Cancel |

Figure 31: Ready to copy over existing data files

However, if you see this dialog:

£ T10VA 73 X
Copy Data Files G
=9

1f you hiave an older T.0M.4. 7.0 installaion on this camputer. we strongly recommend that
you capy the T.0.V.A, data fes to the new T.0.V.4, 7.3 installation. To capy the ks, select
"es' and indicate whers the 7.0V 4. data files are located.

& No, dorit copy any fles:

" Yes. copy the T.0.VA. data fles located in

<No Path Selected>

s Installation wizard®

Figure 32: No existing data files found

then you’ve got two choices:

1. If there’s no previous installation of the T.O.V.A. on this computer, then ignore this dialog and just
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hit ‘Next’.

2. If you do have the older T.O.V.A. 7.0.x installed on your computer, then the T.O.V.A. 7.3 installer
couldn’t find it. If you want to copy over data files from the previous installation, hit the ‘Browse’
button and point the installer to where those data file are located (usually they’re in the FILE folder
in the TOVA_7 folder located on one of your drives). If you just can’t find it, go ahead and finish your
installation, accepting all remaining defaults, and contact T.0O.V.A. Technical Support. We can help
you copy over your data files to the new location.

If you saw neither dialog, no worries, it means you’ve previously installed the T.O.V.A. 7.3.

5.3.7 Installation Finished

2 T0VA 73 X

Figure 33: T.O.V.A. 7.3 installer is finished!

Congratulations! You’ve finished installing the T.O.V.A. You will not find any shortcut in your Start menu
or on your desktop: this is because on Windows 95/98ME computers, the T.O.V.A. may only operate in
DOS environment and not under Windows.

Now, let’s install the documentation.

5.4 Installing the TOVA 7.3 Documentation

This entire section is optional, although we strongly recommend you do install the T.O.V.A. documentation.
It’s always handy to have it on the computer that the T.O.V.A. is on. To get started:

1. Return to the ‘Install TOVA’ program. If it’s not already running, insert the T.O.V.A. CD or go to
‘My Computer’ and double-click on the CD drive to launch it manually.

2. Select ‘Install T.O.V.A. 7.3 Documentation’.
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5.4.1 Welcome to the T.O.V.A. 7.3 documentation installer

£ T.0.V.A. 7.3 Documentation X

This program willinstall .04, 7.3 Documentation ont your
compulter.

Ciick Cancelto quit Setup. Click Next to continue with the Setup
pragram.

WARNING: These documents are protected by copyright law and
intemational treaties.

Unauthorized reproduction or distribution of this documentation, or

any portion of it, may resut in severe civil and criminal penalies,
and wil be prasecuted to the makimum extent passible under la

Cancel

Figure 34: Welcome screen

If you see the screen in Figure 34, installation has begun, and you're on your way.

5.4.2 Choosing the install (“destination”) folder

£ T.0.V.A. 7.3 Documentation

Destination Location 6

Setup willinstall T.0.V.A. 7.3 Documentation in the follawing folder.

We stiongl resarmend that you do not change ths default instalation folder.If you must
install the T.0.%.A. 7.2 Documentation into a different folder, click Browse, and select
another folder.

*You can choose not to install T.0V A 7.3 Documentation by clicking Cancel to exit Setup.

Destination Folder

CMtova_7hdacs Browse:

ise Installation Wizard®

< Back Cancel

Figure 35: Choosing the install directory

If you installed the T.0.V.A. 7.3 to a different directory from the default, you may want to select the same
Install or “Destination” directory in Figure 35 for the 7.3 documentation, but it’s not necessary.

5.4.3 Installing the Foxit Reader

22 T.0.V.A. 7.3 Documentation,

Install Foxit Reader? o

T.0M.A. documentation is installed in the Portable Document Format (POF),

If you do nat have @ PDF viewer program [such as Adabe eader] installed on this computer,
chonse the default option to instal the: documentation using the Fosit PDF Reader.

& Install Documentation with Fosit Feader

" Install Only the D ocumentation

s Installation wizard®

< Back Cancel

Figure 36: Installing Foxit Reader

If you do not have a PDF reader installed (e.g., Adobe Reader), accept the default option to install the
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documentation with a built-in PDF reader. If you already have a PDF reader installed, select ‘Documentation
only’.

Note that we’ve included a free PDF reader on the T.O.V.A. 7.3 CD just for you. So you can also select
‘Documentation only’ and then later install the Foxit PDF reader (see section 5.4.5 on page 30).

5.4.4 Start installing files

That’s about it. On the dialog shown in Figure 37 choose ‘Next’.

2 T.0.V.A. 7.3 Documentation x]
Start Installation 6

“You are now ready to install T.0..A. 7.3 Documentation.

Click the Next button to begin the installation or the Back button to reenter the: installation
information,

ise Installation Wizard®

S i

3 Cancel

Figure 37: Start installing files

T.0.V.4. 7.3 Documentation

Installing o
RN
& - &
Curtent Fle =
Copying Documentalion fles:
Cova_P\docs \Professional Manual pdf
ENENEEENENNEEEEEEE
AllFiles
Time Femaining 0 minutes 4 seconds

ise Irstallation w/izard®

| | [carcel

Figure 38: Progress installing files

£ T.0.Y.A. 7.3 Documentation X

T.0V.A 73 Documentation has been successfully installed
Click the Finish button to exit this installation,
To access the documentation. choose the 'Start’ menu,

~ Progiams (or All Programs’), T.0.V.A.", and then the document
youwish to view

Figure 39: Install finished

You’ll see Figure 38 and then Figure 39. Click ‘Finish’ because you are finished installing the T.O.V.A. 7.3
Documentation.
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5.4.5 Optional: Installing the free Foxit PDF Reader

We've included a free (just for you!) version of a PDF reader program called ‘Foxit Reader’. If you chose
‘Documentation only’ when installing the documentation and you don’t have a PDF reader installed on this
computer, then you should install Foxit Reader.

1. Return to the ‘Install TOVA’ program. If it’s not already running, insert the T.O.V.A. CD or go to
‘My Computer’ and double-click on the CD drive to launch it manually.

2. Select ‘Install Foxit PDF Reader’.

We recommend that you choose all the defaults.

5.5 Creating a T.0.V.A. Shortcut (Windows 95/98 only)

Note: Windows ME users should not use these instructions, but should instead use the T.0.V.A. Boot CD.
See the ‘Administering the T.O.V.A. in Windows ME’ section (see section 13 on page 88).

5.5.1 To create the shortcut

These instructions assume the user understands basic use of the mouse and has familiarity with Windows
95/98 utilities such as Explorer and My Computer. If not, refer to the online help in Windows 95, a Windows
95 tutorial book, or your friend the computer wizard.

1. From the Windows 95 or 98 desktop, double-click on the ‘My Computer’ icon and proceed to the
directory where you installed the T.O.V.A., by default C:\TOVA_7. Look for ‘TOVA_APP’ or ‘TOVA_APP.
EXE’. It’s the icon that looks like a picture of a window without anything inside.

2. This step will be slightly different depending on your operating system:

On Windows 98: Right-click on the icon and choose ‘Send to’, ‘Desktop (create shortcut)’. A ‘Short-
cut to T.O.V.A.” icon will be created on your Windows desktop. Proceed to the next section, ‘To
configure the shortcut’.

On Windows 95: In Windows 95 there are two steps:

(a) Right-click on the icon and select ‘Create Shortcut’.

(b) Left-click and drag that new shortcut icon out of that folder and all window(s) all the way to
the desktop. When the dimmed icon appears on the desktop, release the button. A ‘Shortcut
to tova_app.exe’ icon appears on your desktop. Now proceed to the next section, ‘To configure
the shortcut’.

5.5.2 To configure the shortcut

By this time you should have created a shortcut on the desktop. If not, proceed to the previous section, ‘To
create the shortcut’.

1. Right-click the icon named ‘Shortcut to tova_app.exe’. and select ‘Properties’.

2. Select the ‘Program’ tab from the top of the window.
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3. Select ‘Advanced...” from the bottom of the window.

4. In the ‘Advanced Program Settings’, select ‘MS-DOS mode’. ‘Use current MS-DOS configuration’
should also be selected and you will probably want to de-select ‘Warn before entering MS-DOS mode’.

5. Click on OK, then OK again in the previous dialog box.

6. Optional but recommended: Right-click on the shortcut icon on your desktop, select ‘Rename’, and
change it to ‘T.0O.V.A. Test’, or something else that will remind you that this shortcut runs T.O.V.A.
in MS-DOS mode.

You should now be able to use this shortcut to enter DOS mode and run the T.O.V.A.

5.5.3 You’re done installing the T.O.V.A.! Now what?

We strongly recommend that you go ahead and read the quick and helpful guides for your operating system:

e Windows 95/98 uses should see ‘Administering the T.O.V.A. in Windows 95 & 98’ (section 12 on page
68).

e Windows ME uses should see ‘Administering the T.0.V.A. in Windows ME’ (section 13 on page 88).
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6 Installing the T.O.V.A. 7.3 on DOS

You're one of the few, the proud, the braver-than-most, who are still running a DOS computer. These
instructions should help you install the T.O.V.A. 7.3. And since you use DOS already, we won’t bother to
keep saying hit ‘Enter’ after a command or other silly things like that.

WARNING! If you have a DOS PC, you probably are running an older version of the T.O.V.A. which
means you have T.0O.V.A. data files on your computer. While installing or uninstalling the T.O.V.A. 7.3
should never remove your T.0.V.A. data files, we always recommend that you back up your data before
installing or uninstalling the T.O.V.A. You can never be too careful!

6.1 Moving Older T.O.V.A. Versions out of the Way

If you have a previous version of the T.O.V.A. (like the T.O.V.A. 7.0.x) installed in its default location of
\TOVA_7 then you’ll want to move it out of the way before we continue. Turn on your DOS computer and,
at the DOS prompt:

1. Type ‘C:’ and then ‘CD \’.
2. Type ‘DIR’ (if necessary ‘DIR /P’ to page the listing) and check for a folder called TOVA_7.

3. If you don’t see that folder, no worries, continue on with the installation. If you do see that folder, go
ahead and rename it: type ‘MOVE TOVA_7 TOVA_70’. This will (obviously) move your older installation,
so if you ever have to access it again you’ll have to type (from the root) ‘TOVA_70\TOVA’ to run the
older version.

6.2 Getting the T.O.V.A. 7.3 Installer

Most people don’t use floppy disks any more, so we no longer ship the T.O.V.A. 7.3 DOS installer on a
separate floppy disk. We're sorry if that’s a pain, but chalk it up to the inevitable march of progress. You’ve
got three basic options to get the T.O.V.A. 7.3 DOS installer on your computer:

1. Run the installer from the CD

A surprising number of DOS machines have access to a CD drive. If that’s the case with your PC,
then:

(a) Insert the T.0.V.A. 7.3 CD into your CD drive.

(b) At the DOS command prompt, type the CD drive letter, a colon, and press ‘Enter’. For example,
‘D:’.

(¢) Type ‘\DOS\INSTALL’ and then press ‘Enter’ to start the T.O.V.A. 7.3 DOS installer.

2. Call us to get the T.O.V.A. 7.3 installer on a floppy disk

We'll gladly ship you a floppy disk if you need one — just give us a calll When you get the floppy disk,
turn on your computer, wait for your computer to boot, put the floppy in the drive, and type ‘A:’ at
the DOS prompt.

3. Make your own floppy installer!

If you don’t have a CD drive on your DOS PC, then borrow a slightly more modern machine which
has both a CD and floppy drive and is running Windows.
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Put a formatted but empty 3.5” floppy disk in the floppy drive.
Slip the CD into the drive, and close the ‘Install T.O.V.A.” program that starts.

Right-click on the T.O.V.A. 7.3 CD icon and choose ‘Open’.

Double-click on the folder called ‘DOS’ and you should see a half-dozen files including one called
‘INSTALL.EXE’ (or possibly just ‘INSTALL’).

(f) From the Edit menu, choose ‘Select All’. In the File menu, choose ‘Send To’ and then choose ‘3.5
Floppy (A:).

(g) The files will then copy over to the disk.

(h) Now eject the disk (and the CD, you're done with that too).

)
)
¢) Double-click on ‘My Computer’ (on your desktop, or in the Start menu).
)
)

(i) Turn on your computer, wait for your computer to boot, put the floppy in the drive, and type
‘A:’ at the DOS prompt.

6.3 Installing the T.O.V.A. 7.3

No matter how you get here, you should now be in a directory with the DOS installer in it. Type INSTALL
and the T.O.V.A. 7.3 DOS installer will start up (Figure 40).

Figure 40: T.O0.V.A. 7.3 DOS installer splash screen

Next, press ‘I’ and then ‘Enter’ to choose to install the T.O.V.A. 7.3 (Figure 41).

o followed by the ENTER key.

Lor E to Exit -1

Figure 41: Install or exit DOS installer

Next, choose the drive on which you want to install the T.O.V.A. (Figure 42). Usually this is the default
option (C:), but if you’d like to put the T.O.V.A. on a different drive you can. Just please remember which
drive you put it on; we’ll need that information at the end.

The TOVA Company 800.729.2886 562.594.7700 info@tovatest.com 33



T.0.V.A. 7.3 User’s Manual 6 INSTALLING THE T.0O.V.A. 7.3 ON DOS

Figure 42: Choose an installation drive

Next you’re going to choose an installation directory (Figure 43). But, before you continue, we want to
emphasize that if the T.O.V.A. 7.0.x is already installed on this computer, you should have renamed it
already (section 6.1 on page 32). This is important because the two installations will overwrite each other
with potentially nasty consequences: the T.O.V.A. 7.0.x will not run again, and the T.O.V.A. 7.3 folder will
have a lot T.O.V.A. 7.0.x out-of-date files in it, which will confuse both you and us.

By the way, if you have an install of the prerelease T.O.V.A. 7.1 or 7.2, or even the T.O.V.A. 7.3, already on
your computer, then feel free to directly overwrite that installation. Your data will be safe, and the proper
files will be updated.

Finally, we strongly recommend that you install the T.O.V.A. into the default directory \TOVA_7. It’s just
easier to keep track of if it’s in the normal place.

Figure 43: Choose an installation directory

Hit ‘Enter’ to proceed with the installation, and the installer will start installing the T.O.V.A. (Figure 44).

Proceed with Installation of T.0.U.A. to Drive C (¥/N)7 ——>

Figure 44: Proceed confirmation

Hit ‘Enter’ to proceed with the installation, and the installer will start installing the T.O.V.A. (Figure 45).
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Figure 45: T.0.V.A. 7.3 DOS installer in progress

If everything goes according to plan, all the files will be copied (Figure 46).

<< ALL FILES SUCCESSFULLY TRANSFERRED >>>

Figure 46: Successful DOS installation

And finally the DOS installer will put a batch file on the root of your installation drive (Figure 47).

Figure 47: Creating a batch file

. and you're done installing the T.0.V.A. 7.3 in DOS (Figure 48)!

Figure 48: DOS installation done

If you had a T.O.V.A. 7.0.x installation on your hard drive, then there’s one final step: let’s copy over the
data from the previous version to the new version. All of your data files in the old version were stored in the
FILE folder in the T.O.V.A. directory, which is usually \TOVA_7. Assuming that you renamed the T.0.V.A.
7.0.x folder to TOVA_70 and that you just installed the T.O.V.A. 7.3 in TOVA_7, then type (careful to get all
the slashes just right) ‘XCOPY /S TOVA_7O\FILE\ TOVA_7\FILE'.
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7 Uninstalling the T.O.V.A. 7.3 in Windows

There may be times when you’ll want to uninstall the T.O.V.A. 7.3. We've done our best to make the

process simple and straight-forward.

WARNING! While installing or uninstalling the T.0.V.A. 7.3 should never remove your T.O.V.A. data
files, we always recommend that you back up your data before installing or uninstalling the T.O.V.A. You

can never be too careful!

1. Go to Add/Remove Programs under the Control Panel. In the ‘Add/Remove Programs’ dialog, you
will see a list of your installed programs, including ‘T.O.V.A. 7.3’.

2. Highlight ‘T.O.V.A. 7.3’ and click on ‘Remove’ (Depending on your Windows version, the button may
say ‘Change/Remove’ or ‘Add/Remove’).

Select Uninstall Method o
A

Welcome ta the T.0V.A. 7.3 Installr urinstall progrem
You can choose to automaticall uninstall this scftware o ta choose exactly which changes are
made to your system.

Select the Custom buiton ta choase which madiications to make during the uninstall, Select the

wl u
Automatic bultan for the defaull uninstall options. Select Repair to reinstal changed fies/egisty
keys [recires instalation medic).

@ Automatic
€ LCustom

“wiise |rstallation Wizard®

Figure 49: Welcome to the T.O.V.A. 7.3 Uninstaller!

3. As demonstrated in Figure 49, we recommend you use the default selection of ‘Automatic’ and click

‘Next’.

T.0.V.A. 7.3 Installer X
Perform Uninstall o
-

“You are now ready to uningtall the T.OM.A, 7.2 Ingtaller from your system.

©Click the Finish button to perform the uninstall. Click the Back button te change any of the urinstall
optiorss. Click the Cancel button to exit the urinstal

“wise Installation \wizard®

<Back [ Emsh Cancel

Figure 50: Ready to uninstall the T.O.V.A. 7.3

4. Next you’ll see Figure 50. Click ‘Next’ again.
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T.0.V.A. 7.3 Installer X
Perform Uninstall o
r=S
Perfoming uninstall of T.OV.A. 7.3 Installer
Press the Cancel button to cancel the uninstall process and exit this program.
Removing File:
CATOVA_Z\tova log
‘wise Installation Wizard®
Cancsl |

Figure 51: Uninstalling the T.O.V.A. 7.3

5. Briefly, you will see the above dialog which displays the progress in uninstalling the T.O.V.A. When
uninstall is complete, the dialog will disappear, and return you to the ‘Add/Remove Programs’ dialog,
where ‘T.0O.V.A. 7.3’ should no longer be listed.

Your uninstallation is complete.

7.1 What’s Left Behind?

When you uninstall the T.O.V.A., we try not to leave behind a mess. Therefore, we remove everything we
can from your system, except:

e Your data files, of course, in ‘TOVA_7\FILE’ or wherever you installed them.
e A few registry entries in ‘HKEY _LOCAL_MACHINE\SOFTWARE\The TOVA Company\tova 7.3’.
e On Windows 2000 and XP computers, there will also be:

— Backups of your boot.ini file in ‘TOVA_7\B0OOT’.
— Our installed font, ‘Free Monospaced Symbol (TrueType) in your Windows font directory.
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8 Uninstalling the T.O.V.A. 7.3 in DOS

In DOS, uninstalling is the same as thing as deleting. This is not a good thing: you’ll need to be VERY careful
about deleting in order not to delete your T.O.V.A. data files. Thus, WE DO NOT RECOMMEND
“UNINSTALLING” DOS INSTALLATIONS OF THE T.O.V.A. . Sorry for yelling, but we’ve seen
too many people lose their data not to yell about it.

What we recommend doing is simply renaming your T.O.V.A. directory and just leaving it around for safe
keeping. To rename your folder, simply:

1. Type ‘C:” and then ‘CD \’.

2. Type ‘MOVE TOVA_7 TOVA_70LD’, or choose some other name for the destination. The point is to just
get the folder out of the way, without risking deleting your data files.

If you wish to remove all traces of the T.O.V.A., INCLUDING ALL OF YOUR T.O.V.A. DATA
FILES(!), then from the root of the hard drive (usually C:) type ‘DELTREE TOVA_7’ and blammo, there
goes your entire T.O.V.A. installation along with any data files you might have had. To remove the very
last traces of the T.O.V.A. on your machine, type ‘del \TOVA.BAT’ and that’s it, there should be nothing
T.0.V.A. related left on your computer.
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Part 111

Administering the T.O.V.A. Test

In Part IIT of this manual, we’ll give you practical, basic instructions in how to administer the T.O.V.A.
Test using the T.O.V.A. 7.3. The instructions are divided up by operating system:

e Administering the T.O.V.A. in Windows 2000 & XP see section 11 on page 42
e Administering the T.0O.V.A. in Windows 95 & 98 see section 12 on page 68

e Administering the T.0O.V.A. in Windows ME see section 13 on page 88

e Administering the T.0O.V.A. in DOS see section 14 on page 108
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9 Overview of Administering the T.O.V.A. Test

There’s a simple series of steps you’ll need to do in order to administer the T.O.V.A. Test. We’ve outlined
them in detail for each operating system that the T.0.V.A. works on, but here’s an overview of the steps
for all of the operating systems:

1. Create a new subject or a new session for an existing subject.

e At this point, Windows 2000/XP computers will automatically switch to the Precision Test En-
vironment (PTE).

2. Check the T.O.V.A. hardware
Present the T.O.V.A. stimuli

> W

Administer the Practice Test
5. Administer the T.O.V.A. Test
6. Interpret the T.O.V.A. Test
e At this point, Windows 2000/XP computers will automatically switch back into Windows.
7. Print the T.O.V.A. Report

Pretty straight forward, really. A very handy thing to know is that all of these steps are detailed on
your ‘Quick Reference Card’ which came in the CD case with the T.O.V.A. 7.3 CD.

10 Navigating around the T.O.V.A.

Although the T.O.V.A. looks a bit different from the Windows applications you’re used to, it operates in
much the same way. You can use your mouse to click on menu items or on dialog boxes just as you’d expect.

Sometimes, however, you might find it more convenient and faster to just use the keyboard to navigate
around the T.O.V.A. Or, in some rare cases, you might be forced into using the keyboard because your
mouse is not supported when the T.O.V.A. is in the Precision Test Environment (PTE). In either case, the
T.O.V.A. is fast and easy to use from the keyboard.

The T.0.V.A. has similar key strokes to Windows, so the keys should be relatively familiar already:

e Use ‘Enter’ to select the highlighted option.
e Use ‘Tab’ to switch to the next field (or set of fields).
e Use the arrow keys to move around the fields.

e Use the space bar to set or unset items.
There are a few other keys that you’ll want to know about with the T.O.V.A.:

e Use ‘Esc’ to refresh the screen (including when it’s just a blank black screen).
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e Use the function keys (as detailed in the ‘Administering’ sections below) to quickly select T.O.V.A.
functions:
F1 How to navigate around the T.O.V.A.
F2 Prepare for a new subject or new session
F3 Check the T.O.V.A. hardware
F4 Display the T.O.V.A. stimuli
F5 Administer the Practice Test
F6 Administer Test (Windows mode: Enter Test Mode)
F7 Interpret Test
F8 Print Report
F9 Open File
F10 Request Credits
F11 File Management
F12 Exit (Test mode: Exit Test Mode)

If you forget all of this, at least remember that pressing F1 in the T.O.V.A. will get you a quick tutorial on
how to navigate in the T.O.V.A.
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11 Administering the T.O.V.A. in Windows 2000 & XP

The T.O.V.A. 7.3 is designed to run in both Windows 2000 and XP and in the Precision Test Environment
(PTE). In this section, we’ll talk about the new T.O.V.A. “modes” — one for each environment — and how
you can use them to complete a T.O.V.A. session.

Let’s start by running the T.O.V.A. Double-click on the ‘T.O.V.A.” desktop icon or choose it from the
Start menu under the ‘T.O.V.A.” program group. This launches the T.O.V.A. in what we call “Windows
mode”. Windows mode allows you to everything in the T.O.V.A. you would expect, except administer a
test. Administering a test requires us to switch to “Test mode”.

But we’re getting ahead of ourselves; first, we need to select some of the basic preferences of the T.O.V.A.

Note: If you've already setup the T.O.V.A., you can skip ahead to ‘What is Windows mode?’ below
(section 11.2 on page 46).

11.1 Setting up the T.O.V.A.

Figure 52: Time to setup the T.O.V.A.

When you run the T.O.V.A. 7.3 for the first time, or if something should happen to corrupt or destroy the
existing preferences file, you will encounter the T.O.V.A. setup (Figure 52).

The quickest and easiest way to get through this is simply to accept all defaults. Press ‘Enter’ repeatedly to
accept each of the dialogs. They are the correct settings for most users, and if they turn out to be wrong,
you can always go back and change the settings under ‘Settings’ in the Setup menu. See section 19 on page
134 for more details on T.O.V.A. Settings and Preferences.

If you decide to accept all defaults, you may skip right to ‘Setup Complete’, section 11.1.10 on page 46 below.
If you want to learn more about each of these settings, let’s look at them now.

11.1.1 Setup requirements

Make sure that you fulfill the requirements listed in Figure 52 before continuing with the setup. If you
cannot, you may choose ‘Cancel’” or simply accept all defaults and make changes to the settings later. Once
you’ve attached all the necessary hardware, press ‘Enter’ to choose ‘OK’ to proceed.
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11.1.2 Setup instructions

Figure 53: Navigating the T.O.V.A. setup

You will come to the setup instructions (Figure 53). They are self-explanatory. Choose ‘OK’ to proceed.

11.1.3 Monitor type

Figure 54: Choosing your monitor type

There are still a few of you out there with monochrome or non-color monitors. The rest of us can accept the
default of ‘Color’ (Figure 54). Choose ‘OK’ to proceed.

11.1.4 Units of measurement

Figure 55: Choosing your units of measurement

In this dialog (Figure 55) select the type of units you want to use and choose ‘OK’ to proceed.
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11.1.5 Printer

Figure 56: Selecting your printer

Will you use a Windows printer (Windows 2000 and XP only), a parallel port DOS printer (the first three
choices), or print your reports to a text file? This dialog (Figure 56) lets you choose. Choose ‘OK’ to proceed.

11.1.6 Sound source

[Press o select or 'Esc' to cancel] [Use 1 & » 'Tab' to move]

Figure 57: Source for Auditory T.0.V.A. sound

If you'll be administering the Auditory T.O.V.A. Test (Figure 57), you will need to generate the audio either
through the T.0.V.A. Speaker Driver or through a Sound Blaster-compatible sound card. Most T.O.V.A.
users use the T.O.V.A. Speaker Driver. Choose ‘OK’ to proceed.

11.1.7 Ports

Figure 58: Printer port
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Figure 59: Scorebox port

Figure 60: Microswitch port

Figure 61: Speaker port

Most of our users will use a single parallel port, LPT1, for their Printer (Figure 58), Scorebox (Figure 59),
Microswitch (Figure 60), and T.O.V.A. Speaker Driver (Figure 61). Some of them may even be combined
into a single device. Choose ‘OK’ to proceed.
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11.1.8 Show subject names in dialog boxes

Figure 62: Show Subject Names

It will probably help you to include Subject Names in the T.O.V.A. data file dialogs, but if other subjects
might watch you while browsing for their data file, you likely want to hide that information. If you choose to
‘Show Subject Names’ and choose ‘OK’, you will be reminded to “protect subject confidentiality” (Figure 62).
Choose ‘OK’ to proceed.

11.1.9 Confirming settings

Figure 63: Confirm your settings

This dialog (Figure 63) is to confirm your choices. Choose ‘OK’ to proceed or ‘Redo’ to start over.

11.1.10 Setup complete!

Congratulations! You’ve finished setting up the T.O.V.A. Don’t forget: you can always go back and change
any of these settings individually by choosing ‘Settings’ under the Setup menu.

11.2 What is Windows Mode?

Once you’ve past the setup and are running the T.O.V.A., you’ll find it either looks very strange (like an
old DOS application), or very familiar (if you’ve just upgraded your T.O.V.A.). Yes, the T.O.V.A. is still a
DOS application. However, it can now run under Windows 2000 and XP. Under the ‘T.0.V.A. Continuous
Performance Test’ banner, you’ll see in smaller letters, “Windows mode”. This is to help differentiate it
from “Test mode”, which we’ll describe later.
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Figure 64: The T.O.V.A. in “Windows mode”

The purpose of Windows mode is to allow you to do everything that the T.O.V.A. can do under Windows:

e Create a new T.0.V.A. data file (New Subject/New Session)
e Open an existing T.O.V.A. data file

e Interpret a T.O.V.A. Test

e View/export/print reports (to a Windows printer)

e Select interventions for reports

e Perform other ‘File Management’ tasks.

e Check Scorebox information

e Request additional interpretation credits

e Modify settings

e Peruse the Online Help

One special note on printing reports: thanks to a tool called DOSPRINT, you can even print your T.O.V.A.
reports to a Windows printer. This includes USB and network printers.

Conspicuously absent from this list, of course, is administering a T.0O.V.A. Test. That’s because, although
you can perform all the above functions in Windows, Windows prevents the T.0O.V.A. from doing precise
timing. That’s why we have the Precision Test Environment (PTE) - to let the T.O.V.A. run in an environ-
ment where Windows can’t effect timing. When the T.O.V.A. is running in the PTE, we call it running in
“Test mode”.

11.3 What is Test Mode?

Once you've created a new T.0.V.A. data file in Windows mode and filled in all the necessary Subject
information, and you want to administer the T.O.V.A. Test, or even a Practice Test, you need to enter “Test
mode”, which requires rebooting your Windows system into the Precision Test Environment (PTE). We’ll
talk more about that process shortly.
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[To use the menu bar press 'Alt' + Letter and 1 1] [Use 'Tab' or 1 | to movel

Figure 65: The T.O.V.A. in “Test mode”

The purpose of Test mode is to allow you to do everything the T.O.V.A. can’t do under Windows, and a

little bit more:

e Display stimuli

e Administer a Practice Test

e Administer the T.O.V.A. Test

e Interpret a T.O.V.A. Test

e Print reports (to a DOS printer)

e Select interventions for reports

e Display/Print a comparison graph

e Check Scorebox information

e Request additional interpretation credits
e Modify settings

e Peruse the Online Help

As you can see, many of the items you can perform in Windows mode you can also perform in Test mode.

You’'ll note that we make all of the Scorebox functions (interpreting a test, checking the Scorebox, adding
credits) available in both modes. That’s because they usually work in both modes. Some computers, however,
have Windows installations which block parallel port access. If this is the case, you’ll need to do all of your

Scorebox functions in Test mode.

Conspicuously absent from this list are functions to open files and start a new test data file. Test mode
really is only about testing: in Test mode, you administer the T.0O.V.A. Test to the data file you prepared
in Windows mode. To change the subject information, or do a new subject or new session, you’ll have to

exit to Windows mode first. It’s a bit of a bother, but it should be relatively quick and painless.

11.4 So How Does This Whole Process Work?

Now that you know a bit more, here, in a nutshell, is what you’ll usually do when you give a T.O.V.A. Test:

1. You start the T.O.V.A. in Windows.
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2. You choose to do a new subject, or a new session for an existing subject.
3. You fill in any subject information you need to.
4. You choose to ‘Enter Test mode’.
e Your computer automatically reboots and enters Test mode.
5. You administer the T.O.V.A. Test to your subject.
6. You interpret the T.O.V.A. Test and get a T.O.V.A. Report.
7. You choose to exit test mode.
e Your computer automatically reboots and starts Windows.

8. You print the T.O.V.A. Report to your Windows printer.

It seems like a lot, but it’s really not that much. And we know that results you’ll get from the T.O.V.A.
will be second to none.

11.5 Detailed T.O.V.A. 7.3 Walk-through for Windows 2000 and XP

OK, you're now ready for the full walk-through. This is how you administer the T.0O.V.A. Test, with all of
the sordid details. Note that if you can’t find a particular detail in this section, see the ‘Using the T.O.V.A.
7.3” section (section IV on page 128). If you can’t find what you’re looking for in that, then check the
‘Reference’ section (section VI on page 153)... or, call us for some T.0.V.A. Technical Support, on the
house.

11.5.1 Start the T.O.V.A. in Windows

Let’s start by running the T.0.V.A. Double-click on the ‘T.O.V.A.” desktop icon or choose it from the Start
menu under the ‘T.O.V.A.” program group. This launches the T.0O.V.A. in Windows mode.

Note: If this is the first time you’ve run the T.O.V.A. 7.3 then you’ll be asked to select preferences for a
variety of settings. See “Setting up the T.O.V.A.” in section 11.1 on page 42 for more information.

One thing you might notice is that the T.0.V.A. takes over your whole screen. To get back to Windows, you
can either exit the T.O.V.A., or you can hit the Windows key on your keyboard (or press ‘Alt’ and ‘Tab’ at
the same time). Once your monitor switches back to the Windows desktop, you’ll immediately notice the
T.0.V.A. dialog (Figure 66). To return to the T.O.V.A., simply click on ‘Return to the T.O.V.A.".

‘ Return to the T.0M A |

Quit the T.0M.A, ‘

Figure 66: Click on ‘Return to the T.O.V.A.” to get back to T.O.V.A.

Sometimes, for no good reason, Windows will display a notification on your desktop which will kick you out of
the T.O.V.A. screen and back to the desktop. If this happens, simply click on the same button. If that doesn’t
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seem to work, then click on the black icon in your Task bar that says something like ‘C:\Windows\System. ..’
once or twice. And if for whatever reason you end up with a blank, black screen, just hit ‘Esc’ and the
T.0.V.A. should pop back up.

Getting back to the T.0O.V.A.: go ahead and explore the various menus. You’ll notice that everything is
available to you in Windows mode, except administering the T.O.V.A. Let’s start the test administration
process by entering in some subject information.

11.5.2 Creating a new subject or a new session

Once you've started the T.O.V.A., you will arrive at the T.O.V.A. main screen (Figure 67). This is where
you can add/modify subject information or use the various menus to access other T.O.V.A. features.

File Setup Test Interpretation Interventions Display Uindow FHelp

[To use the menu bar press 'Alt' + Letter and 1 4] [Use 'Tab' or to_move]

Figure 67: The T.0.V.A. Main Screen

Don’t panic if it seems unfamiliar; remember to refer to the ‘Quick Reference Card’ that came in your
T.0.V.A. 7.3 CD case, and to the ‘Navigating around the T.0.V.A." section (see section 10 on page 40).

Choose ‘New Test’ from the File menu (or press the F2 key). Here (Figure 68) you have a choice between
creating a new subject or a new session for an existing subject.

File Setup Test Imterpretation ions Display iindow fielp

tinuous Performance Tes

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 68: Choosing a New Test

Creating a New Subject

If you choose ‘New Subject’, the T.O.V.A. will clear the main screen and instruct you (Figure 69) to enter
in the new subject’s data. By the way, this first step — creating a new subject — has actually already been
done. Whenever you start the T.O.V.A. in Windows mode, you will be brought to a main screen empty of
subject information. So in the case of a new subject, you can immediately start entering subject information
as soon as the T.O.V.A. starts up.

The TOVA Company 800.729.2886 562.594.7700 infoQ@tovatest.com 50



T.0.V.A. 7.3 User’s Manual 11 ADMINISTERING THE T.O.V.A. IN WINDOWS 2000 & XP

aaaaa

[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 69: New subject instructions

Note: The only subject information we require for you to administer a T.O.V.A. Test is the Subject Number,
Gender, Date of Birth, and Test Date. The Subject Number and Test Date should be provided automatically
by the T.O.V.A., and should not be modified without advice from T.0O.V.A. Technical Support. Do make
sure that the date is correct, of course. Adding other information, such as Medications and Dosages, will
aid interpreting the test so we encourage you to fill out the form as much as you want.

Note: It is critical that the subject’s gender and age is correct. An mistake here will invalidate the accuracy
of the T.O.V.A. Report, since comparison to the T.0.V.A. norming study must be done for the proper
gender and age group.

For the purposes of this walk-through, go ahead and enter in your name and date of birth (or someone
else’s!). We'll proceed with the walk-through after discussing new sessions.

Creating a New Session

If you are about to test a subject who has already had a T.O.V.A. Test, then use ‘New Session’. This allows
you to pull in subject information from a previous test. In particular, this keeps the same subject number
for the subject, which is an important way of keeping track of your subjects.

If there’s already a file open in memory, then the T.O.V.A. will first ask you if you want to use the subject
information from that file (Figure 70). This is handy when you’re giving a baseline test immediately followed
by a medication challenge test.

ormance Test

[Press 'Esc' to cancel] [Use 1 | ¢ » 'Tab' to move]

Figure 70: Use the Active File or Open another?

If there is no open, active file or if you chose to use an unopened file, you will be instructed (Figure 71) to
browse (Figure 72) for the data file containing the latest session for that subject.
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 71: New session instructions

erformance Test

[Pre: el] [Use 1 4 « -+ 'Tab' to nmove]

Figure 72: Select the latest session data file for the subject

Note: When creating a new T.0O.V.A. session, make sure you base it on the data file with the latest
available session. In Figure 72, if you were creating a new session for Subject Number ‘0023’, you would
select ‘01002305.m13’, which is the latest session (session ‘05’, in this case) for this subject. For more
information about filenames, and how they are created, see section 36 on page 175.

When you see Figure 73, you've successfully created a new session for this subject. All of the subject
information will be carried over to the new data file, but information such as Tester, Medications, etc., will,
of course, be reset for this new session.

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 73: You've created a new session

11.5.3 Entering Test mode

When you’ve finished entering the necessary subject information, you’re ready to enter Test mode and
administer the T.O.V.A. Test. Choose, from the Test menu, ‘Enter Test Mode’, or press F6. This will
automatically save the current T.O.V.A. data file. Click ‘OK’ on the Autosave dialog.
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Next you’ll see the dialog in Figure 74.

Your computer must be restarted in order to administer the T.0W A, test.

Run the T.0.Y A using:

% Precision Test Environment (FTE)

" T.0V.A. boot media [CD, flappy. etc.)

Cancel
Festart when?

o |mmediately

Help

EN
[ ]

" Later (when | restart the computer)

Figure 74: Options for rebooting to Test mode

As you can see, you have a few options on how to enter Test mode.

Using the Precision Test Environment (PTE): The simplest way to enter Test mode (and thus ad-
minister a T.O.V.A. Test) is the PTE. Think of it like a temporary operating system for your computer:
the T.0.V.A. will automatically start it up when you enter Test mode, and then turn it off when you
want to come back into Windows mode (for you geeks who want to know more, please see the Reference
section of this manual). It’s all handled automatically: once you choose to enter Test mode, or go back
to Windows mode, you literally shouldn’t have to do anything. The T.0O.V.A. 7.3 should handle it all.

T.O.V.A. boot media (CD, floppy, etc.): We prefer that you use the PTE as it is easy, automatic, and
safe. If the PTE will not work for you, we provide the T.0.V.A. 7.3 CD as an alternative.

The T.0O.V.A. 7.3 CD is actually a boot CD; meaning, if you leave it in your CD drive and reboot
your computer, it will automatically try to start up the T.O.V.A. in Test mode. However, the boot
CD requires you to have a FAT32 partition in order to access the T.O.V.A. on disk. If you don’t
know what FAT32 is, don’t worry about it: just use the PTE. For those who know, and want to use a
FAT32 partition without the PTE, the boot CD is for you. For more information on the Boot CD see
section 20 on page 141, or contact T.O.V.A. Technical Support.

In this walk-through, we’ll assume you are using the PTE. So make sure the ‘Precision Test Environment
(PTE)’ is selected in the dialog.

The second selection you’ll need to make is when to restart into Test mode. ‘Immediately’ is usually the
right answer, unless you have other things you need to do first. Before you click on ‘OK’, however, be
sure to safely close any other applications you are running: entering Test mode requires you
to reboot your computer. When you are ready to restart your system into Test mode, choose ‘OK’.

11.5.4 What happens next?

There’s a lot that happens between your choosing to enter the ‘PTE’ ‘Immediately’ and arriving in Test
mode, and you don’t need to understand any of it. We’ll briefly describe what you can expect to see, but
feel free to skip immediately to ‘T.O.V.A. in Test mode’ section below.

Note: You will encounter a couple timed menus along the way. You may ignore them completely. They
are available to T.O.V.A. Technical Support should we need to help you in resolving any problems in the
process.

Note: If you encounter any errors that halt this process at any point, don’t panic! Contact T.O.V.A.
Technical Support: it’s free, and we’re happy to help you with any problems.
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e As you begin your journey to the PTE, you will see a sequence of three or more windows pop up and
then disappear.

e Eventually, Windows will shut down (some systems can take more than a minute to shut down) and
your system will restart.

e After restarting, a menu will appear for about 3 seconds. It will present you with the options of
our ‘T.O.V.A. Precision Test Environment’ or booting to your operating system (‘Windows XP’ or
‘Windows 2000’). You shouldn’t do anything. After the time is up, it will automatically proceed to
our destination, the T.O.V.A. Precision Test Environment.

e Next, a bunch of technical information about ‘Grub’ and ‘FreeDOS’ and such will appear. If you want
to know more about any of our tools, we again refer all you computer nerds to the ‘T.O.V.A. Modes’
in the reference section (section 37 on page 176).

e You'll be presented with a second timed menu, this one giving you the option to ‘[1] Run the T.O.V.A.
7.3 in Test mode (starts automatically in 3 sec)’ or ‘[X] Exit to DOS (FreeDOS 1.0)’. Again, you
should ignore this menu and it will disappear in about 3 seconds and proceed finally to...

11.5.5 T.O.V.A. in Test mode

At last, we are here! It was a busy and possibly confusing journey, though hopefully brief and automatic.

You will see the familiar T.O.V.A. splash screen and then the main screen. Note that under the ‘T.O.V.A.
Continuous Performance Test” banner it now says ‘Test mode’. Filled in on that main screen you should
also see the subject information you entered back in Windows mode. The T.0.V.A. data file you created in
Windows mode has been carried with you into Test mode, and automatically loaded. The file is automatically
loaded because in Test mode, you have no options to open any other existing data files or create new data
files: again, Test mode really is just for testing.

11.5.6 Checking the T.0.V.A. hardware

Before administering a T.O.V.A. Test, you should select ‘Check Hardware’ from the Setup menu, or press
F3. The purpose of the Check Hardware process is to verify that all the hardware pieces are working before
administering a T.0.V.A. Test. This is a three-step process, and all three steps are available separately
under the Setup menu as well.

First, the T.O.V.A. checks the system timing to ensure that the T.0.V.A. Test can be administered with
precision and accuracy. If you see Figure 76 then something is wrong with the timing on your computer;
please see ‘Troubleshooting T.0.V.A. Hardware’ (section 26 on page 154) in the reference section.

Figure 75: Checking the system timing
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Figure 76: Bad system timing

Check Hardware next confirms that a valid T.O.V.A. 7.3 Scorebox is attached. If it succeeds, you’ll see
nothing, but if it fails, you’ll see the dialog in Figure 77.

Tarning:

Figure 77: Scorebox not found

Again, if you have trouble getting your Scorebox to be read, please see ‘Troubleshooting T.O.V.A. Hardware’
(section 26 on page 154).

Finally, Check Hardware verifies that the microswitch is working by asking you (Figure 78) to click the
microswitch exactly ten times over a period of ten seconds (Figure 79).

Elapsed Time: 2 =seconds

Microswitch Pr = O

Figure 79: Testing the microswitch

If it fails, you'll get a message like this (Figure 80). Try it again, and if continues to fail, please see
‘Troubleshooting T.0.V.A. Hardware’ (section 26 on page 154) in the reference section.

Figure 80: Microswitch failure

If your hardware has passed (Figure 81) the tests successfully, you should be okay to administer a T.O.V.A.
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Test. If it does not (Figure 82), you should consult Troubleshooting, section 26 on page 154 or contact
T.O.V.A. Technical Support before administering a T.O.V.A. Test.

Check Hardware

The T

Tou

Figure 82: Hardware error

11.5.7 Present the T.O.V.A. stimuli

The next step is to present the T.O.V.A. stimuli to the subject, which you can do by choosing ‘Present
Stimuli’ from the Test menu or by pressing F4.

File Setup Test

‘ontinuous Performance Test

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 83: Present visual or auditory stimuli?

Note: If you have a T.O.V.A. Scorebox enabled for both Visual and Auditory tests, you will be greeted
first by Figure 83. There’s nothing really to see when presenting Auditory stimuli, so we did not include any
screen-shots.
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Figure 84: Target

Figure 85: Nontarget

Figure 86: Focus Point

Choose ‘Display stimuli’ from the Test menu, and you will be shown a screen presenting (as you would
expect) the Target (Figure 84) and Nontarget (Figure 85) stimuli, as well as the Focus Point (Figure 86)
the subject will see in between stimuli. Or, if this is to be an Auditory T.0.V.A. Test, you will hear the
Target/Nontarget tones, instead.

One of the most critical parts of the T.O.V.A. is preparing the subject to take the test. To
help you with this, we have recommended text for each section that involves the subject.

It is VERY important that you read or paraphrase this text with all subjects, especially subjects
who have never taken the T.0.V.A. Test. How they take the T.O.V.A. is critical to the T.O.V.A.’s
accuracy, so we recommend you read and understand these instructions. As a handy reference, your ‘Quick
Reference Card’ in your CD case has all of this text.

Slowly read or paraphrase the following (vary as needed for the auditory test):

This test measures your ability to pay attention. Two different kinds of squares will flash on the
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computer screen. The squares will differ only in that one of them will have a square near the top
(indicate the target image) and one will have the square near the bottom (indicate). We want
you to press this button (indicate) every time you see the white square with the black square
near the top (indicate). I want you to hold this button in your writing hand (find out which
hand they use for writing) with your thumb resting lightly on top, like this (indicate). When you
press the button, let up when you hear the click. Don’t hold the button down for long, and push
it down only once for each correct square.

Now we are going to flash the squares on the screen, and your job is to press the button AS
FAST AS YOU CAN every time you see a square with the square near the top (indicate). But
the trick is that you are NOT to press the button when the square is near the bottom (indicate).
Remember; press the button as fast as you can but only for the square with the square near the
top. The idea of this test is for you to be as fast, but also as accurate, as you can. Try not to
make any mistakes. But if you do, don’t worry; everyone makes mistakes on this test. Try and
press the button as fast as you can but only for the square with the square in the top. Don’t
be too fast - take enough time to see which square it is. Don’t guess. Once you’ve pressed the
button, let up and don’t press it more than once when you see the correct square. Any questions?

Not terribly exciting, but a good demonstration for a new subject. Besides, if this is too boring for your
subject, they will never survive the T.O.V.A.

When you’re done...wait for it...choose ‘Done’.

11.5.8 Administer the Practice Test

Next you will want to administer the Practice Test to the subject by choosing ‘Practice Test’ from the Test
menu or by pressing F5. Introduce this to your subject by slowly reading or paraphrasing this statement:

Now we are going to do a practice test for about 3 minutes to see if you understand how to take
the test.

The T.O.V.A. Practice Test lasts 144 seconds, displaying 72 stimuli, once every two seconds. A Visual and
Auditory enabled Scorebox will first be given a choice of which type of Practice Test to give (Figure 87):

File Setup Test Imterpretation

[Press 'Esc' to cancel] [Use 1 = 'Tab' to move]

Figure 87: Choose the type of Practice Test
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Figure 88: Press the microswitch button to start the test

Once you select the type of Practice Test, or if your Scorebox only has one type enabled, you will see
Figure 88, and it will be time to start the test. Pressing the microswitch button will start a countdown and,
after three seconds, the test has begun. As the dialog mentions, hit the ‘Esc’ key to abort the Practice Test.

Figure 89: The results of the Practice Test

At the end of the test, you will hear a quick series of tones, indicating that the test has ended, and then
you will see the Practice Test Results (Figure 89). These will help indicate to you whether the subject
understood the test directions and whether any hardware failure might have occurred.

Check the Practice Test results for:

e A low number of omissions and commissions (high numbers of both may indicate that the subject
misunderstood the test instructions and is pressing the button on the wrong stimuli).

e A low number of multiples
e A low number of anticipatory errors

A reasonable average response time: for example, a response time > 300 ms but less than < 1500 ms.

11.5.9 Administer the T.0O.V.A. Test

Choose ‘T.0.V.A. Test’ from the Test menu, or press F6 to administer the T.O.V.A. Test.

As with the previous steps, if you have a Visual-only T.O.V.A., you won’t see the dialog in (Figure 90). If
you do see the dialog, select the type of T.O.V.A. Test you want to administer to this subject.
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 90: Choose the type of T.O.V.A. Test

If you see Figure 91, then you already have Response Data from a previous T.0.V.A. Test saved to this
file. Taking the T.O.V.A. Test now will destroy that data, so verify that you do want to
OVERWRITE the existing test data before continuing.

File Setup Test Imterpretation

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 91: Destroy existing Response Data?

WARNING! This dialog really does mean what it says: taking another test will overwrite existing data.
If you need to test your subject again, but you want to preserve the previous data, instead create a New
Session for this subject (see section 11.5.2 on page 50 for details).

The T.0.V.A. will automatically save (Figure 92) before and after the T.O.V.A. Test.

File Setup Test Imterpretation

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 92: File is automatically saved

You will arrive at Figure 93. Before the subject begins, you should slowly read or paraphrase the following,
modifying it particularly for the Auditory test:

Now we are going to do the real test for about 20 minutes. Do the best job you can. Also, you
should know that your eyes are probably going to get a little tired. Even so, try and do the best
job you can... press the button as quickly as you can but only for the square with the black
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square on the top. Click the button to begin the test.

Figure 93: Press the microswitch button to start the test

Once the test has begun, we do not recommend you interrupt it until it is complete. Any interruption will
affect interpretation of the test. However, should it be necessary, you can interrupt the T.O.V.A. Test just
like the Practice Test by pressing the ‘Esc’ key.

Figure 94: T.0O.V.A. Test interrupted

Aborting the test will give you a dialog (Figure 94) with the following options:

‘Abort’: This will immediately end the test, and save whatever data has been accumulated so far. The
partial test may be interpreted, but it cannot be continued later.

‘Restart’: All response data will be cleared away, and the test will start over from the beginning, asking you
to press the microswitch to start. If it is just a few minutes into the test, this is what we recommend
doing.

‘Continue’: If you choose to continue an interrupted test, you will see Figure 95: continue the test from
here, without restarting, and the test will be invalid. For more information on valid/invalid tests, see
the T.O.V.A. 7.3 Clinical (or Screening) Manual. You may again choose to ‘Continue’, or you may
choose instead to ‘Restart’.
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tab' to move]

Figure 95: Continuing isn’t always the best thing to do; consider restarting.

Once the test is completed or aborted, you will hear the same series of tones as at the end of the Practice
Test. Your test will be automatically saved again (Figure 92), and you will be returned to the main screen.

Congratulations! You and your subject have suffered through a T.O.V.A. Test. But remember, there’s a
very good reason it’s so boring: it wouldn’t be as good of a test of attention if it wasn’t obnoxiously boring!

11.5.10 Interpreting the T.O.V.A. Test

Once you’ve taken the T.O.V.A. Test, it will need to be interpreted in order to generate a T.O.V.A. Report.
Note that you don’t have to interpret it immediately; once the test data has been saved, you can interpret
it weeks, months, even years later. In fact, you can even go back and interpret or re-interpret older 7.2, 7.1
or even 7.0.x tests. And once a data file has been interpreted, it’s interpreted forever so you can view its
report whenever you like.

Again, just to be clear: you may take or administer the Practice Test and even the T.0O.V.A. Test as many
times as you like, but interpreting a test to generate a T.O.V.A. Report will require an Interpretation credit.

So what do you get with a T.O.V.A. report? The short answer is that you get the comparison of the subject’s
performance to the T.O.V.A. norming study, graphs, comparisons to an ADHD study, raw data, etc. But
that’s just the short answer: see the T.0.V.A. 7.3 Clinical (or Screening) Manual for the long answer. And
for the neuropsychology nerds among you, see the T.O.V.A. 7.3 Professional Manual for the gory neuropsych
details of the T.O.V.A. Test.

To interpret a test choose ‘Interpret Test’ from the Interpretation menu or press F7.

Of course, in order to interpret a test and generate a T.O.V.A. Report, you’ll need a data file with test data
in it. Else you’ll see Figure 96.

aaaaa

[Press 'Esc' to cancel] [Use 1 | ¢ » 'Tab' to move]

Figure 96: You must have test data to interpret
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If the test has not been interpreted before, your data file will be automatically saved (Figure 92). You will
then be warned that the interpretation will cost you one credit (Figure 97). Choose ‘OK’ and the credit will
be decremented from your Scorebox, the file will be interpreted and the interpreted file automatically saved
again.

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 97: Interpretation will cost a credit

After you ‘OK’ the autosave dialog, you'll be asked if you want to display the report. Choose ‘OK’, and
‘Form 1’ of the T.O.V.A. Report will be displayed. Choose ‘Cancel’, and you will be returned to the main
screen.

File Setup Test Intes

[Press 'Esc' to cancel] [Use 1 L« » 'Tab' to move] ['Pagelp'/'PageDown' for m

Figure 98: Display the T.O.V.A. Report now?

Finally, to check how many interpretation credits you have, go to ‘Check Scorebox’ under the Setup menu.
The Check Scorebox dialog will display all of the relevant information about your Scorebox, including serial
number, number of interpretation credits, and the version of your test (screening or clinical).

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 99: All about the attached Scorebox
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11.5.11 Exiting Test mode

You've seen the report now, so the next logical thing to do is to print it out. But before we do that, we have
to get back to Windows mode.

Choose, from File menu, ‘Exit Test Mode...” and ‘OK’ to reboot your system back to Windows. Your
computer will restart, and Windows will start up.

11.5.12 Back in Windows mode

When Windows has finished started up, the T.0.V.A. will automatically run, and you will see the
dialog in Figure 100 appear, counting down the seconds until the T.0.V.A. launches in Windows mode. For
more information on why this delay exists (and instructions how to modify it), see the ‘T.O.V.A. Settings
in Windows 2000 and XP’ in the reference section (section 34 on page 170).

Fauzing the T.0.%. A, while Windows finizhes starting up..

11 geconds remaining...
Continue 4 Cancel

Figure 100: Waiting to launch T.O.V.A. Windows mode

When the time is up, you’ll see the familiar T.O.V.A. splash screen and at last, the main screen. As we can
see beneath the ‘T.0.V.A. Continuous Performance Test’ banner, we’re back in Windows mode, and just
like when we went to Test mode, our T.O.V.A. data file has been automatically opened. This time, however,
the file has T.O.V.A. Test data in it and has been interpreted.

11.5.13 Displaying, printing and exporting the T.O.V.A. Report

At this point in the walk-through, there should be an interpreted data file loaded in the memory.
Viewing the T.0.V.A. Report on screen

You can immediately view the results by choosing any of the report form numbers (e.g., ‘1’) from the Display
menu. If the Form entries are a light gray in the Display menu, then this means that there isn’t an interpreted
data file in memory.

Note that some of the forms are multiple screens long, so press the ‘page down’ and ‘page up’ keys to flip
pages. Hitting the ‘Esc’ key will get you back to the main screen at any time.

Printing the T.0.V.A. Report

Although you can review the T.O.V.A. Report, on your computer, you most likely will want to print out the
report to file away in your notes. You can print the T.O.V.A. Report easily by choosing ‘Print...” from the
File menu. Figure 101 shows the dialog that allows you to specify which forms you want to print.
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Figure 101: Select the forms to be printed

Note: Sometimes not every form you see in Figure 101 will appear in the list to be printed.

e Only the ‘Table of Contents’ will appear if you have no data files open, or if the active data file has
not been interpreted.

e ‘Form 6’ will not appear if you have a Screening version of the T.O.V.A.

e ‘Interventions’ will only be listed if you have already selected one or more interventions. See section 25
on page 150 for more details.

e The Comparison Graph will compare one or more opened data files. If you only have one data file
open in the T.0.V.A., the ‘Comparison Graph’ will not appear.

When you choose ‘OK’, the T.O.V.A. will turn over control of printing to a program called DOSPRINT.
DOSPRINT allows the T.O.V.A. to print to any Windows printer, including USB and network printers
(Figure 102). Click on the ‘Print’ button to print to your default printer.

Figure 102: The DOSPRINT screen

Once DOSPRINT has closed, you’ll have to click on the ‘Return to the T.O.V.A.” button in order to return
to the T.O.V.A. (see all the way back to Figure 66).

Exporting the T.O.V.A. Report

Exporting works similarly to printing, except it ‘prints’ a T.O.V.A. Report directly to a text file. This text
file can then be opened by any word processor, which is sometimes a handy way to create an electronic
report. Choose ‘Export...” from the File menu, and you will select the forms to export (Figure 103) and
choose ‘OK’.
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Figure 103: Select the forms to be exported
Afterward, you will have to specify the export file name (Figure 104), or accept the default.

File Setup Test Interpretation Interventions Display Uindow Felp

. Continuous Performance Test

jo1000101. Tx

[Press 'Esc' to cancel] [Use 1 | ¢ » 'Tab' to move]

Figure 104: Specify the export filename

File Setup Test Interpretation Interventions Display Uindow Felp

. Continuous Performance Test

[To use the menu bar press 'Alt' + Letter and 1 1] [Use 'Tab' or 1 I to movel

Figure 105: Export in progress

You will then be notified that the export is in progress (Figure 105), and, when completed (Figure 106),
where the export file was saved.
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Figure 106: Export complete!

Note: By default, your file will be exported to...you’ll never guess...your ‘Export Path’. This is something
you can set yourself, which is sometimes very handy. For example, if you're running on a Windows computer,
you can export your T.0.V.A. Reports directly to your Windows desktop if you wanted to. To review/modify
your Export Path, find in the File menu ‘File Management’, ‘Change Export Path’. See the File Management
section (section 30 on page 163) for details.

Note: If you know you always want to export the report rather than print it, you can actually set your
default printer to ‘export’. That way you can just hit F8 and your file will automatically be exported. Under
the Setup menu, choose ‘Settings’. Then choose ‘Select Printer’ and finally choose ‘Export to Text File’ as
your printer.

11.5.14 You’re done!

Finally, let’s choose, from the File menu, ‘Exit...” or F12 to exit the program. The T.O.V.A. will exit and
return you to Windows.

Congratulations! You’ve successfully navigated a full T.O.V.A. session!
11.5.15 Handy Reference Sections to know about

Finally, there are a reference sections you will want to know about:

e Requesting additional interpretation credits: section 15 on page 129
e Comparing multiple T.O.V.A. tests with the comparison graph: section 24 on page 149

e Selecting and generating an Interventions Report: section 25 on page 150
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12 Administering the T.O.V.A. in Windows 95 & 98

The important thing to remember when running the T.O.V.A. 7.3 in Window 95 or 98 is that you may only
administer tests in DOS mode. This means restarting your computer into MS-DOS mode, and not just using
a DOS command window in Windows.You can reboot into MS-DOS mode in one of a variety of ways.

12.1 Getting to DOS Mode

The easiest way to run T.O.V.A. in DOS mode was described back in section 5.5 on page 30, ‘Creating a
T.0.V.A. shortcut (Windows 95 or 98 only)’. See that section for details.

Here are a few other ways:

e In the Start menu, go to ‘Shutdown...” and choose to ‘Restart into MS-DOS mode’. Once you reach the
command prompt, you should be able run the T.O.V.A. by simply typing ‘tova’ and pressing ‘Enter’.

b

e Reboot your system, and when you see the ‘Starting Windows 9x...” message, you can press F8 to
bring up a boot menu. Choose ‘Command prompt only’ to boot to MS-DOS. Again, once you reach the
command prompt, you should be able run the T.O.V.A. by simply typing ‘tova’ and pressing ‘Enter’.

e T.O.V.A. 7.3 introduces a new environment, the Boot CD environment. Insert the T.O.V.A. 7.3 CD,
restart your system, and boot to the CD: the T.O.V.A. should start up automatically. If the CD
doesn’t start automatically when you restart your computer, you may have to change your BIOS boot
settings. See the Reference Section (section 20 on page 141) for details, or call T.O.V.A. Technical
Support.

The T.0.V.A. Boot CD will automatically search for your installation of the T.O.V.A. 7.3 and, if it
finds it, will run the T.O.V.A. in DOS mode. If the T.O.V.A. Boot CD cannot find your T.O.V.A. 7.3
installation, and fails with an error message, please contact T.O.V.A. Technical Support for assistance.

12.2 Setting up the T.O.V.A.

Figure 107: Time to setup the T.O.V.A.

When you run the T.O.V.A. 7.3 for the first time, or if something should happen to corrupt or destroy the
existing preferences file, you will encounter the T.0.V.A. setup (Figure 107).

The quickest and easiest way to get through this is simply to accept all defaults. Press ‘Enter’ repeatedly to
accept each of the dialogs. They are the correct settings for most users, and if they turn out to be wrong,
you can always go back and change the settings under ‘Settings’ in the Setup menu. See section 19 on page
134 for more details on T.0.V.A. Settings and Preferences.
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If you decide to accept all defaults, you may skip right to ‘Hardware Check’, section 14.2.10 on page 112
below. If you want to learn more about each of these settings, let’s look at them now.

12.2.1 Setup requirements

Make sure that you fulfill the requirements listed in Figure 107 before continuing with the setup. If you
cannot, you may choose ‘Cancel’ or simply accept all defaults and make changes to the settings later. Once
you’ve attached all the necessary hardware, press ‘Enter’ to choose ‘OK’ to proceed.

12.2.2 Setup instructions

Figure 108: Navigating the T.O.V.A. setup

You will come to the setup instructions (Figure 108). They are self-explanatory. Choose ‘OK’ to proceed.

12.2.3 Monitor type

Figure 109: Choosing your monitor type

There are still a few of you out there with monochrome or non-color monitors. The rest of us can accept the
default of ‘Color’ (Figure 109). Choose ‘OK’ to proceed.
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12.2.4 Units of measurement

Figure 110: Choosing your units of measurement

In this dialog (Figure 110) select the type of units you want to use and choose ‘OK’ to proceed.

12.2.5 Printer

Figure 111: Selecting your printer
Will you use a Windows printer (Windows 2000 and XP only), a parallel port DOS printer (the first three

choices), or print your reports to a text file? This dialog (Figure 111) lets you choose. Choose ‘OK’ to
proceed.

12.2.6 Sound source

Figure 112: Source for Auditory T.O.V.A. sound

If you'll be administering the Auditory T.0.V.A. Test (Figure 112), you will need to generate the audio either
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through the T.0O.V.A. Speaker Driver or through a Sound Blaster-compatible sound card. Most T.O.V.A.
users use the T.0.V.A. Speaker Driver. Choose ‘OK’ to proceed.

12.2.7 Ports

Figure 113: Printer port

eeeeeeeeee

Figure 114: Scorebox port

Figure 115: Microswitch port

Figure 116: Speaker port
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Most of our users will use a single parallel port, LPT1, for their Printer (Figure 113), Scorebox (Figure 114),
Microswitch (Figure 115), and T.O.V.A. Speaker Driver (Figure 116). Some of them may even be combined
into a single device. Choose ‘OK’ to proceed.

12.2.8 Show subject names in dialog boxes

Figure 117: Show Subject Names

It will probably help you to include Subject Names in the T.O.V.A. data file dialogs, but if other sub-
jects might watch you while browsing for their data file, you likely want to hide that information. If you

choose to ‘Show Subject Names’ and choose ‘OK’, you will be reminded to “protect subject confidentiality”
(Figure 117). Choose ‘OK’ to proceed.

12.2.9 Confirming settings

Figure 118: Confirm your settings

This dialog (Figure 118) is to confirm your choices. Choose ‘OK’ to proceed or ‘Redo’ to start over.

section 14.2.10 on page 112

12.2.10 Checking the T.0O.V.A. hardware

After you’ve made all your T.O.V.A. Setup selections, the T.O.V.A. will automatically check your hardware
(Figure 119). Choose ‘OK’ to proceed.
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[Press 'Enter’ to select or 'Esc' to cancel] ([Use t | « » 'Tab' to move]

Figure 119: Checking the hardware

First, the T.O.V.A. checks the system timing to ensure that the T.O.V.A. Test can be administered with
precision and accuracy. If you see Figure 121 then something is wrong with the timing on your computer;
please see ‘Troubleshooting T.0.V.A. Hardware’ (section 26 on page 154) in the reference section.

Syatem timing

Figure 120: Checking the system timing

Figure 121: Bad system timing

Check Hardware next confirms that a valid T.O.V.A. 7.3 Scorebox is attached. If it succeeds, you’ll see
nothing, but if it fails, you'll see the dialog in Figure 122.

Figure 122: Scorebox not found

Again, if you have trouble getting your Scorebox to be read, please see ‘Troubleshooting T.O.V.A. Hardware’
(section 26 on page 154).

Finally, Check Hardware verifies that the microswitch is working by asking you (Figure 123) to click the
microswitch exactly ten times over a period of ten seconds (Figure 124).
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Elapsed Time:

Microswitch Pres

Figure 124: Testing the microswitch

If it fails, you'll get a message like this (Figure 125). Try it again, and if continues to fail, please see
‘Troubleshooting T.0.V.A. Hardware’ (section 26 on page 154) in the reference section.

Figure 125: Microswitch failure

If your hardware has passed (Figure 126) the tests successfully, you should be okay to administer a T.O.V.A.
Test. If it does not (Figure 127), you should consult Troubleshooting, section 26 on page 154 or contact
T.O.V.A. Technical Support before administering a T.O.V.A. Test.

Figure 127: Hardware error

12.2.11 Setup complete!

Congratulations! You’ve finished setting up the T.O.V.A. Don’t forget: you can always go back and change
any of these settings individually by choosing ‘Settings’ under the Setup menu.
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12.3 Detailed T.O.V.A. 7.3 Walk-through for Windows 95 and 98

Once you've reached DOS (see section 12.1 on page 68), and you've gone through the T.O.V.A. Setup
(see section 12.2 on page 68), you're now ready for the full walk-through. This is how you administer the
T.O.V.A. Test, with all of the sordid details. Note that if you can’t find a particular detail in this section,
see the ‘Using the T.0.V.A. 7.3’ section (section IV on page 128). If you can’t find what you’re looking for in
that, then check the ‘Reference’ section (section VI on page 153)... or, call us for some T.0.V.A. Technical
Support, on the house.

12.3.1 Creating a new subject or a new session

Once you've started the T.O.V.A., you will arrive at the T.O.V.A. main screen (Figure 128). This is where
you can add/modify subject information or use the various menus to access other T.O.V.A. features.

‘ontinuous Performance Test

Figure 128: The T.0.V.A. Main Screen

Don’t panic if it seems unfamiliar; remember to refer to the ‘Quick Reference Card’ that came in your
T.0.V.A. 7.3 CD case, and to the ‘Navigating around the T.0.V.A.” section (see section 10 on page 40).

Choose ‘New Test’ from the File menu (or press the F2 key). Here (Figure 129) you have a choice between
creating a new subject or a new session for an existing subject.

Figure 129: Choosing a New Test

Creating a New Subject

If you choose ‘New Subject’, the T.O.V.A. will clear the main screen and instruct you (Figure 130) to enter
in the new subject’s data. By the way, this first step — creating a new subject — has actually already been
done. Whenever you start the T.O.V.A., you will be brought to a main screen empty of subject information.
So in the case of a new subject, you can immediately start entering subject information as soon as the
T.O.V.A. starts up.
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 130: New subject instructions

Note: The only subject information we require for you to administer a T.O.V.A. Test is the Subject Number,
Gender, Date of Birth, and Test Date. The Subject Number and Test Date should be provided automatically
by the T.O.V.A., and should not be modified without advice from T.0O.V.A. Technical Support. Do make
sure that the date is correct, of course. Adding other information, such as Medications and Dosages, will
aid interpreting the test so we encourage you to fill out the form as much as you want.

Note: It is critical that the subject’s gender and age is correct. An mistake here will invalidate the accuracy
of the T.O.V.A. Report, since comparison to the T.0.V.A. norming study must be done for the proper
gender and age group.

For the purposes of this walk-through, go ahead and enter in your name and date of birth (or someone
else’s!). We'll proceed with the walk-through after discussing new sessions.

Creating a New Session

If you are about to test a subject who has already had a T.O.V.A. Test, then use ‘New Session’. This allows
you to pull in subject information from a previous test. In particular, this keeps the same subject number
for the subject, which is an important way of keeping track of your subjects.

If there’s already a file open in memory, then the T.O.V.A. will first ask you if you want to use the subject
information from that file (Figure 131). This is handy when you're giving a baseline test immediately followed
by a medication challenge test.

ormance Test

[Press 'Esc' to cancel] [Use 1 | ¢ » 'Tab' to move]

Figure 131: Use the Active File or Open another?

If there is no open, active file or if you chose to use an unopened file, you will be instructed (Figure 132) to
browse (Figure 133) for the data file containing the latest session for that subject.
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 132: New session instructions

erformance Test

[Pre: el] [Use 1 4 « -+ 'Tab' to nmove]

Figure 133: Select the latest session data file for the subject

Note: When creating a new T.0O.V.A. session, make sure you base it on the data file with the latest
available session. In Figure 133, if you were creating a new session for Subject Number ‘0023’, you would
select ‘01002305.m13’, which is the latest session (session ‘05’, in this case) for this subject. For more
information about filenames, and how they are created, see section 36 on page 175.

When you see Figure 134, you’ve successfully created a new session for this subject. All of the subject
information will be carried over to the new data file, but information such as Tester, Medications, etc., will,
of course, be reset for this new session.

[Press 'Esc' to cancel] [Use 1 | ¢ » 'Tab' to move]

Figure 134: You’ve created a new session

12.3.2 Checking the T.O.V.A. hardware

Just like you did in the original setup above (section 12.2 on page 68), it’s always a good idea to check the
T.O.V.A. hardware before administering a test.

Choose ‘Check Hardware’ from the Setup menu, or press F3, to check the hardware. Again, see section 12.2
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on page 68 for the step-by-step instructions for checking the hardware.

12.3.3 Present the T.0O.V.A. stimuli

The next step is to present the T.O.V.A. stimuli to the subject, which you can do by choosing ‘Present
Stimuli’ from the Test menu or by pressing F4.

inuous Performance Test

Figure 135: Present visual or auditory stimuli?

Note: If you have a T.O.V.A. Scorebox enabled for both Visual and Auditory tests, you will be greeted
first by Figure 135. There’s nothing really to see when presenting Auditory stimuli, so we did not include
any screen-shots.

Figure 136: Target

Figure 137: Nontarget
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Figure 138: Focus Point

Choose ‘Display stimuli’ from the Test menu, and you will be shown a screen presenting (as you would
expect) the Target (Figure 136) and Nontarget (Figure 137) stimuli, as well as the Focus Point (Figure 138)
the subject will see in between stimuli. Or, if this is to be an Auditory T.O.V.A. Test, you will hear the
Target /Nontarget tones, instead.

One of the most critical parts of the T.0O.V.A. is preparing the subject to take the test. To
help you with this, we have recommended text for each section that involves the subject.

It is VERY important that you read or paraphrase this text with all subjects, especially subjects
who have never taken the T.0.V.A. Test. How they take the T.O.V.A. is critical to the T.O.V.A.’s
accuracy, so we recommend you read and understand these instructions. As a handy reference, your ‘Quick
Reference Card’ in your CD case has all of this text.

Slowly read or paraphrase the following (vary as needed for the auditory test):

This test measures your ability to pay attention. Two different kinds of squares will flash on the
computer screen. The squares will differ only in that one of them will have a square near the top
(indicate the target image) and one will have the square near the bottom (indicate). We want
you to press this button (indicate) every time you see the white square with the black square
near the top (indicate). I want you to hold this button in your writing hand (find out which
hand they use for writing) with your thumb resting lightly on top, like this (indicate). When you
press the button, let up when you hear the click. Don’t hold the button down for long, and push
it down only once for each correct square.

Now we are going to flash the squares on the screen, and your job is to press the button AS
FAST AS YOU CAN every time you see a square with the square near the top (indicate). But
the trick is that you are NOT to press the button when the square is near the bottom (indicate).
Remember; press the button as fast as you can but only for the square with the square near the
top. The idea of this test is for you to be as fast, but also as accurate, as you can. Try not to
make any mistakes. But if you do, don’t worry; everyone makes mistakes on this test. Try and
press the button as fast as you can but only for the square with the square in the top. Don’t
be too fast - take enough time to see which square it is. Don’t guess. Once you’ve pressed the
button, let up and don’t press it more than once when you see the correct square. Any questions?

Not terribly exciting, but a good demonstration for a new subject. Besides, if this is too boring for your
subject, they will never survive the T.O.V.A.

When you're done...wait for it...choose ‘Done’.
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12.3.4 Administer the Practice Test

Next you will want to administer the Practice Test to the subject by choosing ‘Practice Test’ from the Test
menu or by pressing F5. Introduce this to your subject by slowly reading or paraphrasing this statement:

Now we are going to do a practice test for about 3 minutes to see if you understand how to take
the test.

The T.O.V.A. Practice Test lasts 144 seconds, displaying 72 stimuli, once every two seconds. A Visual and
Auditory enabled Scorebox will first be given a choice of which type of Practice Test to give (Figure 139):

File Setup Test Inmterpretation Interventions Display [indow FHelp

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 139: Choose the type of Practice Test

Figure 140: Press the microswitch button to start the test

Once you select the type of Practice Test, or if your Scorebox only has one type enabled, you will see
Figure 140, and it will be time to start the test. Pressing the microswitch button will start a countdown
and, after three seconds, the test has begun. As the dialog mentions, hit the ‘Esc’ key to abort the Practice
Test.

[Press 'Esc' to cancel] [Use 1 | & » 'Tab' to move]

Figure 141: The results of the Practice Test
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At the end of the test, you will hear a quick series of tones, indicating that the test has ended, and then
you will see the Practice Test Results (Figure 141). These will help indicate to you whether the subject
understood the test directions and whether any hardware failure might have occurred.

Check the Practice Test results for:

e A low number of omissions and commissions (high numbers of both may indicate that the subject
misunderstood the test instructions and is pressing the button on the wrong stimuli).

e A low number of multiples
e A low number of anticipatory errors

e A reasonable average response time: for example, a response time > 300 ms but less than < 1500 ms.

12.3.5 Administer the T.0O.V.A. Test

Choose ‘T.O.V.A. Test’ from the Test menu, or press F'6 to administer the T.O.V.A. Test.

As with the previous steps, if you have a Visual-only T.0.V.A., you won’t see the dialog in (Figure 142). If
you do see the dialog, select the type of T.O.V.A. Test you want to administer to this subject.

inuous Performance Test

Figure 142: Choose the type of T.O.V.A. Test

If you see Figure 143, then you already have Response Data from a previous T.0.V.A. Test saved to this
file. Taking the T.O.V.A. Test now will destroy that data, so verify that you do want to
OVERWRITE the existing test data before continuing.

Figure 143: Destroy existing Response Data?

WARNING! This dialog really does mean what it says: taking another test will overwrite existing data.
If you need to test your subject again, but you want to preserve the previous data, instead create a New
Session for this subject (see section 12.3.1 on page 75 for details).
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The T.0.V.A. will automatically save (Figure 144) before and after the T.O.V.A. Test.

Figure 144: File is automatically saved

You will arrive at Figure 145. Before the subject begins, you should slowly read or paraphrase the following,
modifying it particularly for the Auditory test:

Now we are going to do the real test for about 20 minutes. Do the best job you can. Also, you
should know that your eyes are probably going to get a little tired. Even so, try and do the best
job you can... press the button as quickly as you can but only for the square with the black
square on the top. Click the button to begin the test.

Figure 145: Press the microswitch button to start the test

Once the test has begun, we do not recommend you interrupt it until it is complete. Any interruption will
affect interpretation of the test. However, should it be necessary, you can interrupt the T.O.V.A. Test just
like the Practice Test by pressing the ‘Esc’ key.

Figure 146: T.O.V.A. Test interrupted

Aborting the test will give you a dialog (Figure 146) with the following options:
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‘Abort’: This will immediately end the test, and save whatever data has been accumulated so far. The
partial test may be interpreted, but it cannot be continued later.

‘Restart’: All response data will be cleared away, and the test will start over from the beginning, asking you
to press the microswitch to start. If it is just a few minutes into the test, this is what we recommend
doing.

‘Continue’: If you choose to continue an interrupted test, you will see Figure 147: continue the test from
here, without restarting, and the test will be invalid. For more information on valid/invalid tests, see
the T.O.V.A. 7.3 Clinical (or Screening) Manual. You may again choose to ‘Continue’, or you may
choose instead to ‘Restart’.

[Press 'Esc' to cancel] [Use 1 | & » 'Tab' to move]

Figure 147: Continuing isn’t always the best thing to do; consider restarting.

Once the test is completed or aborted, you will hear the same series of tones as at the end of the Practice
Test. Your test will be automatically saved again (Figure 144), and you will be returned to the main screen.

Congratulations! You and your subject have suffered through a T.0.V.A. Test. But remember, there’s a
very good reason it’s so boring: it wouldn’t be as good of a test of attention if it wasn’t obnoxiously boring!

12.3.6 Interpreting the T.O.V.A. Test

Once you’ve taken the T.O.V.A. Test, it will need to be interpreted in order to generate a T.O.V.A. Report.
Note that you don’t have to interpret it immediately; once the test data has been saved, you can interpret
it weeks, months, even years later. In fact, you can even go back and interpret or re-interpret older 7.2, 7.1
or even 7.0.x tests. And once a data file has been interpreted, it’s interpreted forever so you can view its
report whenever you like.

Again, just to be clear: you may take or administer the Practice Test and even the T.O.V.A. Test as many
times as you like, but interpreting a test to generate a T.O.V.A. Report will require an Interpretation credit.

So what do you get with a T.O.V.A. report? The short answer is that you get the comparison of the subject’s
performance to the T.0.V.A. norming study, graphs, comparisons to an ADHD study, raw data, etc. But
that’s just the short answer: see the T.O.V.A. 7.3 Clinical (or Screening) Manual for the long answer. And
for the neuropsychology nerds among you, see the T.O.V.A. 7.3 Professional Manual for the gory neuropsych
details of the T.O.V.A. Test.

To interpret a test choose ‘Interpret Test’ from the Interpretation menu or press F7.

Of course, in order to interpret a test and generate a T.O.V.A. Report, you'll need a data file with test data
in it. Else you'll see Figure 148.
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 148: You must have test data to interpret

If the test has not been interpreted before, your data file will be automatically saved (Figure 144). You will
then be warned that the interpretation will cost you one credit (Figure 149). Choose ‘OK’ and the credit
will be decremented from your Scorebox, the file will be interpreted and the interpreted file automatically
saved again.

[Press 'Esc' ancel] [Use 1 | ¢+ 'Tab' to move]

Figure 149: Interpretation will cost a credit
After you ‘OK’ the autosave dialog, you'll be asked if you want to display the report. Choose ‘OK’, and
‘Form 1’ of the T.O.V.A. Report will be displayed. Choose ‘Cancel’, and you will be returned to the main

screen.

Continuous Performance Test

[Press 'Esc' ancel] [Use 1 |« » 'Tab' to move] ['Pagelp'/'PageDown' for m

Figure 150: Display the T.O.V.A. Report now?

Finally, to check how many interpretation credits you have, go to ‘Check Scorebox’ under the Setup menu.
The Check Scorebox dialog will display all of the relevant information about your Scorebox, including serial
number, number of interpretation credits, and the version of your test (screening or clinical).
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Figure 151: All about the attached Scorebox

12.3.7 Displaying, printing and exporting the T.0O.V.A. Report

At this point in the walk-through, there should be an interpreted data file loaded in the memory.
Viewing the T.0.V.A. Report on screen

You can immediately view the results by choosing any of the report form numbers (e.g., ‘1’) from the Display
menu. If the Form entries are a light gray in the Display menu, then this means that there isn’t an interpreted
data file in memory.

Note that some of the forms are multiple screens long, so press the ‘page down’ and ‘page up’ keys to flip
pages. Hitting the ‘Esc’ key will get you back to the main screen at any time.

Printing the T.0.V.A. Report

Although you can review the T.O.V.A. Report, on your computer, you most likely will want to print out the
report to file away in your notes. You can print the T.O.V.A. Report easily by choosing ‘Print...” from the
File menu. Figure 152 shows the dialog that allows you to specify which forms you want to print.

File Setup Test Imterpretation ions Display iindow fielp

.A. Continuous Performance Test

flcoccmcese

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 152: Select the forms to be printed

Note: Sometimes not every form you see in Figure 152 will appear in the list to be printed.

e Only the ‘Table of Contents’ will appear if you have no data files open, or if the active data file has
not been interpreted.

e ‘Form 6’ will not appear if you have a Screening version of the T.O.V.A.

e ‘Interventions’ will only be listed if you have already selected one or more interventions. See section 25
on page 150 for more details.
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e The Comparison Graph will compare one or more opened data files. If you only have one data file

open in the T.O.V.A., the ‘Comparison Graph’ will not appear.

Choose ‘OK’ to send your selected forms to your parallel port printer.

Exporting the T.O.V.A. Report

Exporting works similarly to printing, except it ‘prints’ a T.O.V.A. Report directly to a text file. This text
file can then be opened by any word processor, which is sometimes a handy way to create an electronic
report. Choose ‘Export...” from the File menu, and you will select the forms to export (Figure 153) and

choose ‘OK’.

Continuous Performance Test

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 153: Select the forms to be exported

Afterward, you will have to specify the export file name (Figure 154), or accept the default.

jo1000101. Tx

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 154: Specify the export filename

File Setup Tes: isplay Uindow felp

ntinuous Performance Test

Figure 155: Export in progress

You will then be notified that the export is in progress (Figure 155), and, when completed (Figure 156),

where the export file was saved.
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Figure 156: Export complete!

Note: By default, your file will be exported to...you’ll never guess...your ‘Export Path’. This is something
you can set yourself, which is sometimes very handy. For example, if you're running on a Windows computer,
you can export your T.0.V.A. Reports directly to your Windows desktop if you wanted to. To review/modify
your Export Path, find in the File menu ‘File Management’, ‘Change Export Path’. See the File Management
section (section 30 on page 163) for details.

Note: If you know you always want to export the report rather than print it, you can actually set your
default printer to ‘export’. That way you can just hit F8 and your file will automatically be exported. Under
the Setup menu, choose ‘Settings’. Then choose ‘Select Printer’ and finally choose ‘Export to Text File’ as
your printer.

12.3.8 You’re done!

Finally, let’s choose, from the File menu, ‘Exit...” or F12 to exit the program. The T.O.V.A. will exit and:

e if you used ‘Restart to MS-DOS Mode’, the T.O.V.A. 7.3 boot CD, or bypassed windows F8, will
return to a DOS prompt. You can restart your computer (by pressing ‘Ctrl’, ‘Alt’ and 'Del’ at the
same time), or you can just turn it off.

e If you used a MS-DOS mode shortcut, your computer will automatically restart back into Windows.

Congratulations! You’ve successfully navigated a full T.O.V.A. session!

12.3.9 Handy Reference Sections to know about

Finally, there are a reference sections you will want to know about:

e Requesting additional interpretation credits: section 15 on page 129
e Comparing multiple T.O.V.A. tests with the comparison graph: section 24 on page 149

e Selecting and generating an Interventions Report: section 25 on page 150
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13 Administering the T.O.V.A. in Windows ME

If you've installed the T.O.V.A. 7.3 on a Windows ME system, running the T.O.V.A. can be as easy as
inserting our T.0O.V.A. Boot CD (the same CD you used to install the T.O.V.A.) and restarting your
system.

Note: Your system will need to be configured to boot to a CD. This may require modifying your system
BIOS settings. For assistance with this, please contact T.O.V.A. Technical Support.

The T.O.V.A. Boot CD will present you with a timed menu you can ignore. After three seconds, it will
automatically default to the correct setting, and run the T.O.V.A. from where it is installed on your hard
drive. If the Boot menu does not find your T.O.V.A. 7.3 installation, or you encounter any other problems,
please contact T.O.V.A. Technical Support.

13.1 Setting up the T.O.V.A.

Figure 157: Time to setup the T.O.V.A.

When you run the T.O.V.A. 7.3 for the first time, or if something should happen to corrupt or destroy the
existing preferences file, you will encounter the T.O.V.A. setup (Figure 157).

The quickest and easiest way to get through this is simply to accept all defaults. Press ‘Enter’ repeatedly to
accept each of the dialogs. They are the correct settings for most users, and if they turn out to be wrong,
you can always go back and change the settings under ‘Settings’ in the Setup menu. See section 19 on page
134 for more details on T.O.V.A. Settings and Preferences.

If you decide to accept all defaults, you may skip right to ‘Hardware Check’, section 14.2.10 on page 112
below. If you want to learn more about each of these settings, let’s look at them now.

13.1.1 Setup requirements

Make sure that you fulfill the requirements listed in Figure 157 before continuing with the setup. If you
cannot, you may choose ‘Cancel’” or simply accept all defaults and make changes to the settings later. Once
you’ve attached all the necessary hardware, press ‘Enter’ to choose ‘OK’ to proceed.
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13.1.2 Setup instructions

Figure 158: Navigating the T.O.V.A. setup

You will come to the setup instructions (Figure 158). They are self-explanatory. Choose ‘OK’ to proceed.

13.1.3 Monitor type

Figure 159: Choosing your monitor type

There are still a few of you out there with monochrome or non-color monitors. The rest of us can accept the
default of ‘Color’ (Figure 159). Choose ‘OK’ to proceed.

13.1.4 Units of measurement

Figure 160: Choosing your units of measurement

In this dialog (Figure 160) select the type of units you want to use and choose ‘OK’ to proceed.
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13.1.5 Printer

Figure 161: Selecting your printer

Will you use a Windows printer (Windows 2000 and XP only), a parallel port DOS printer (the first three
choices), or print your reports to a text file? This dialog (Figure 161) lets you choose. Choose ‘OK’ to
proceed.

13.1.6 Sound source

[Press 'Enter' to select or 'Esc' to cancel] ([Use T4 + + 'Tab' to move]

Figure 162: Source for Auditory T.O.V.A. sound

If you’ll be administering the Auditory T.O.V.A. Test (Figure 162), you will need to generate the audio either
through the T.0O.V.A. Speaker Driver or through a Sound Blaster-compatible sound card. Most T.O.V.A.
users use the T.0.V.A. Speaker Driver. Choose ‘OK’ to proceed.

13.1.7 Ports

Figure 163: Printer port
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Figure 164: Scorebox port

Figure 165: Microswitch port

Figure 166: Speaker port

Most of our users will use a single parallel port, LPT1, for their Printer (Figure 163), Scorebox (Figure 164),
Microswitch (Figure 165), and T.O.V.A. Speaker Driver (Figure 166). Some of them may even be combined
into a single device. Choose ‘OK’ to proceed.
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13.1.8 Show subject names in dialog boxes

Figure 167: Show Subject Names

It will probably help you to include Subject Names in the T.0O.V.A. data file dialogs, but if other sub-
jects might watch you while browsing for their data file, you likely want to hide that information. If you
choose to ‘Show Subject Names’ and choose ‘OK’, you will be reminded to “protect subject confidentiality”
(Figure 167). Choose ‘OK’ to proceed.

13.1.9 Confirming settings

Figure 168: Confirm your settings

This dialog (Figure 168) is to confirm your choices. Choose ‘OK’ to proceed or ‘Redo’ to start over.

section 14.2.10 on page 112

13.1.10 Checking the T.O.V.A. hardware

After you’ve made all your T.O.V.A. Setup selections, the T.O.V.A. will automatically check your hardware
(Figure 169). Choose ‘OK’ to proceed.
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[Press 'Enter’ to select or 'Esc' to cancel] ([Use t | « » 'Tab' to move]

Figure 169: Checking the hardware

First, the T.O.V.A. checks the system timing to ensure that the T.O.V.A. Test can be administered with
precision and accuracy. If you see Figure 171 then something is wrong with the timing on your computer;
please see ‘Troubleshooting T.0.V.A. Hardware’ (section 26 on page 154) in the reference section.

Syatem timing

Figure 170: Checking the system timing

Figure 171: Bad system timing

Check Hardware next confirms that a valid T.O.V.A. 7.3 Scorebox is attached. If it succeeds, you’ll see
nothing, but if it fails, you'll see the dialog in Figure 172.

Figure 172: Scorebox not found

Again, if you have trouble getting your Scorebox to be read, please see ‘Troubleshooting T.O.V.A. Hardware’
(section 26 on page 154).

Finally, Check Hardware verifies that the microswitch is working by asking you (Figure 173) to click the
microswitch exactly ten times over a period of ten seconds (Figure 174).
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Elapsed Time:

Microswitch Pres

Figure 174: Testing the microswitch

If it fails, you'll get a message like this (Figure 175). Try it again, and if continues to fail, please see
‘Troubleshooting T.0.V.A. Hardware’ (section 26 on page 154) in the reference section.

Figure 175: Microswitch failure

If your hardware has passed (Figure 176) the tests successfully, you should be okay to administer a T.O.V.A.
Test. If it does not (Figure 177), you should consult Troubleshooting, section 26 on page 154 or contact
T.O.V.A. Technical Support before administering a T.O.V.A. Test.

Figure 177: Hardware error

13.1.11 Setup complete!

Congratulations! You’ve finished setting up the T.O.V.A. Don’t forget: you can always go back and change
any of these settings individually by choosing ‘Settings’ under the Setup menu.
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13.2 Detailed T.O.V.A. 7.3 Walk-through for Windows ME

Once you've reached the T.O.V.A. via the boot CD and gone through the T.0.V.A. Setup once (see sec-
tion 13.1 on page 88), you're now ready for the full walk-through. This is how you administer the T.O.V.A.
Test, with all of the sordid details. Note that if you can’t find a particular detail in this section, see the
‘Using the T.0.V.A. 7.3’ section (section IV on page 128). If you can’t find what you're looking for in
that, then check the ‘Reference’ section (section VI on page 153)... or, call us for some T.0.V.A. Technical
Support, on the house.

13.2.1 Creating a new subject or a new session

Once you've started the T.O.V.A., you will arrive at the T.O.V.A. main screen (Figure 178). This is where
you can add/modify subject information or use the various menus to access other T.O.V.A. features.

File Setup Test T ation Interventions Display Uindow FHelp

Continuous Performance Test

Figure 178: The T.0O.V.A. Main Screen

Don’t panic if it seems unfamiliar; remember to refer to the ‘Quick Reference Card’ that came in your
T.0.V.A. 7.3 CD case, and to the ‘Navigating around the T.0.V.A.” section (see section 10 on page 40).

Choose ‘New Test’ from the File menu (or press the F2 key). Here (Figure 179) you have a choice between
creating a new subject or a new session for an existing subject.

ormance Test

[Pre; [Use 1 1+~ 'Tab' to move]

Figure 179: Choosing a New Test

Creating a New Subject

If you choose ‘New Subject’, the T.O.V.A. will clear the main screen and instruct you (Figure 180) to enter
in the new subject’s data. By the way, this first step — creating a new subject — has actually already been
done. Whenever you start the T.O.V.A., you will be brought to a main screen empty of subject information.
So in the case of a new subject, you can immediately start entering subject information as soon as the
T.O.V.A. starts up.
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 180: New subject instructions

Note: The only subject information we require for you to administer a T.O.V.A. Test is the Subject Number,
Gender, Date of Birth, and Test Date. The Subject Number and Test Date should be provided automatically
by the T.O.V.A., and should not be modified without advice from T.0O.V.A. Technical Support. Do make
sure that the date is correct, of course. Adding other information, such as Medications and Dosages, will
aid interpreting the test so we encourage you to fill out the form as much as you want.

Note: It is critical that the subject’s gender and age is correct. An mistake here will invalidate the accuracy
of the T.O.V.A. Report, since comparison to the T.0.V.A. norming study must be done for the proper
gender and age group.

For the purposes of this walk-through, go ahead and enter in your name and date of birth (or someone
else’s!). We'll proceed with the walk-through after discussing new sessions.

Creating a New Session

If you are about to test a subject who has already had a T.O.V.A. Test, then use ‘New Session’. This allows
you to pull in subject information from a previous test. In particular, this keeps the same subject number
for the subject, which is an important way of keeping track of your subjects.

If there’s already a file open in memory, then the T.O.V.A. will first ask you if you want to use the subject
information from that file (Figure 181). This is handy when you're giving a baseline test immediately followed
by a medication challenge test.

ormance Test

[Press 'Esc' to cancel] [Use 1 | ¢ » 'Tab' to move]

Figure 181: Use the Active File or Open another?

If there is no open, active file or if you chose to use an unopened file, you will be instructed (Figure 182) to
browse (Figure 183) for the data file containing the latest session for that subject.
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 182: New session instructions

Figure 183: Select the latest session data file for the subject

Note: When creating a new T.0O.V.A. session, make sure you base it on the data file with the latest
available session. In Figure 183, if you were creating a new session for Subject Number ‘0023’, you would
select ‘01002305.m13’, which is the latest session (session ‘05’, in this case) for this subject. For more
information about filenames, and how they are created, see section 36 on page 175.

When you see Figure 184, you’ve successfully created a new session for this subject. All of the subject
information will be carried over to the new data file, but information such as Tester, Medications, etc., will,
of course, be reset for this new session.

File Setup Test

[Press 'Esc' to cancel] [Use 1 | ¢ » 'Tab' to move]

Figure 184: You’ve created a new session

13.2.2 Checking the T.O.V.A. hardware

Just like you did in the T.O.V.A. Setup above (section 13.1 on page 88), it’s always a good idea to check
the T.O.V.A. hardware before administering a test.

Choose ‘Check Hardware’ from the Setup menu, or press F3, to check the hardware. Again, see section 13.1
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on page 88 for the step-by-step instructions for checking the hardware.

13.2.3 Present the T.O.V.A. stimuli

The next step is to present the T.O.V.A. stimuli to the subject, which you can do by choosing ‘Present
Stimuli’ from the Test menu or by pressing F4.

inuous Performance Test

Figure 185: Present visual or auditory stimuli?

Note: If you have a T.O.V.A. Scorebox enabled for both Visual and Auditory tests, you will be greeted
first by Figure 185. There’s nothing really to see when presenting Auditory stimuli, so we did not include
any screen-shots.

Figure 186: Target

Figure 187: Nontarget
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Figure 188: Focus Point

Choose ‘Display stimuli’ from the Test menu, and you will be shown a screen presenting (as you would
expect) the Target (Figure 186) and Nontarget (Figure 187) stimuli, as well as the Focus Point (Figure 188)
the subject will see in between stimuli. Or, if this is to be an Auditory T.O.V.A. Test, you will hear the
Target /Nontarget tones, instead.

One of the most critical parts of the T.0O.V.A. is preparing the subject to take the test. To
help you with this, we have recommended text for each section that involves the subject.

It is VERY important that you read or paraphrase this text with all subjects, especially subjects
who have never taken the T.0.V.A. Test. How they take the T.O.V.A. is critical to the T.O.V.A.’s
accuracy, so we recommend you read and understand these instructions. As a handy reference, your ‘Quick
Reference Card’ in your CD case has all of this text.

Slowly read or paraphrase the following (vary as needed for the auditory test):

This test measures your ability to pay attention. Two different kinds of squares will flash on the
computer screen. The squares will differ only in that one of them will have a square near the top
(indicate the target image) and one will have the square near the bottom (indicate). We want
you to press this button (indicate) every time you see the white square with the black square
near the top (indicate). I want you to hold this button in your writing hand (find out which
hand they use for writing) with your thumb resting lightly on top, like this (indicate). When you
press the button, let up when you hear the click. Don’t hold the button down for long, and push
it down only once for each correct square.

Now we are going to flash the squares on the screen, and your job is to press the button AS
FAST AS YOU CAN every time you see a square with the square near the top (indicate). But
the trick is that you are NOT to press the button when the square is near the bottom (indicate).
Remember; press the button as fast as you can but only for the square with the square near the
top. The idea of this test is for you to be as fast, but also as accurate, as you can. Try not to
make any mistakes. But if you do, don’t worry; everyone makes mistakes on this test. Try and
press the button as fast as you can but only for the square with the square in the top. Don’t
be too fast - take enough time to see which square it is. Don’t guess. Once you’ve pressed the
button, let up and don’t press it more than once when you see the correct square. Any questions?

Not terribly exciting, but a good demonstration for a new subject. Besides, if this is too boring for your
subject, they will never survive the T.O.V.A.

When you're done...wait for it...choose ‘Done’.

The TOVA Company 800.729.2886 562.594.7700 infoQ@tovatest.com 99



T.0.V.A. 7.3 User’s Manual 13  ADMINISTERING THE T.O.V.A. IN WINDOWS ME

13.2.4 Administer the Practice Test

Next you will want to administer the Practice Test to the subject by choosing ‘Practice Test’ from the Test
menu or by pressing F5. Introduce this to your subject by slowly reading or paraphrasing this statement:

Now we are going to do a practice test for about 3 minutes to see if you understand how to take
the test.

The T.O.V.A. Practice Test lasts 144 seconds, displaying 72 stimuli, once every two seconds. A Visual and
Auditory enabled Scorebox will first be given a choice of which type of Practice Test to give (Figure 189):

File Setup Test Inmterpretation Interventions Display [indow FHelp

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 189: Choose the type of Practice Test

Figure 190: Press the microswitch button to start the test

Once you select the type of Practice Test, or if your Scorebox only has one type enabled, you will see
Figure 190, and it will be time to start the test. Pressing the microswitch button will start a countdown
and, after three seconds, the test has begun. As the dialog mentions, hit the ‘Esc’ key to abort the Practice
Test.

[Press 'Esc' to cancel] [Use 1 | & » 'Tab' to move]

Figure 191: The results of the Practice Test
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At the end of the test, you will hear a quick series of tones, indicating that the test has ended, and then
you will see the Practice Test Results (Figure 191). These will help indicate to you whether the subject
understood the test directions and whether any hardware failure might have occurred.

Check the Practice Test results for:

e A low number of omissions and commissions (high numbers of both may indicate that the subject
misunderstood the test instructions and is pressing the button on the wrong stimuli).

e A low number of multiples
e A low number of anticipatory errors

e A reasonable average response time: for example, a response time > 300 ms but less than < 1500 ms.

13.2.5 Administer the T.0O.V.A. Test

Choose ‘T.O.V.A. Test’ from the Test menu, or press F'6 to administer the T.O.V.A. Test.

As with the previous steps, if you have a Visual-only T.0.V.A., you won’t see the dialog in (Figure 192). If
you do see the dialog, select the type of T.O.V.A. Test you want to administer to this subject.

inuous Performance Test

Figure 192: Choose the type of T.O.V.A. Test

If you see Figure 193, then you already have Response Data from a previous T.0.V.A. Test saved to this
file. Taking the T.O.V.A. Test now will destroy that data, so verify that you do want to
OVERWRITE the existing test data before continuing.

Figure 193: Destroy existing Response Data?

WARNING! This dialog really does mean what it says: taking another test will overwrite existing data.
If you need to test your subject again, but you want to preserve the previous data, instead create a New
Session for this subject (see section 13.2.1 on page 95 for details).
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The T.0.V.A. will automatically save (Figure 194) before and after the T.O.V.A. Test.

Figure 194: File is automatically saved

You will arrive at Figure 195. Before the subject begins, you should slowly read or paraphrase the following,
modifying it particularly for the Auditory test:

Now we are going to do the real test for about 20 minutes. Do the best job you can. Also, you
should know that your eyes are probably going to get a little tired. Even so, try and do the best
job you can... press the button as quickly as you can but only for the square with the black
square on the top. Click the button to begin the test.

Figure 195: Press the microswitch button to start the test

Once the test has begun, we do not recommend you interrupt it until it is complete. Any interruption will
affect interpretation of the test. However, should it be necessary, you can interrupt the T.O.V.A. Test just
like the Practice Test by pressing the ‘Esc’ key.

Figure 196: T.O.V.A. Test interrupted

Aborting the test will give you a dialog (Figure 196) with the following options:
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‘Abort’: This will immediately end the test, and save whatever data has been accumulated so far. The
partial test may be interpreted, but it cannot be continued later.

‘Restart’: All response data will be cleared away, and the test will start over from the beginning, asking you
to press the microswitch to start. If it is just a few minutes into the test, this is what we recommend
doing.

‘Continue’: If you choose to continue an interrupted test, you will see Figure 197: continue the test from
here, without restarting, and the test will be invalid. For more information on valid/invalid tests, see
the T.O.V.A. 7.3 Clinical (or Screening) Manual. You may again choose to ‘Continue’, or you may
choose instead to ‘Restart’.

[Press 'Esc' to cancel] [Use 1 | & » 'Tab' to move]

Figure 197: Continuing isn’t always the best thing to do; consider restarting.

Once the test is completed or aborted, you will hear the same series of tones as at the end of the Practice
Test. Your test will be automatically saved again (Figure 194), and you will be returned to the main screen.

Congratulations! You and your subject have suffered through a T.0.V.A. Test. But remember, there’s a
very good reason it’s so boring: it wouldn’t be as good of a test of attention if it wasn’t obnoxiously boring!

13.2.6 Interpreting the T.O.V.A. Test

Once you’ve taken the T.O.V.A. Test, it will need to be interpreted in order to generate a T.O.V.A. Report.
Note that you don’t have to interpret it immediately; once the test data has been saved, you can interpret
it weeks, months, even years later. In fact, you can even go back and interpret or re-interpret older 7.2, 7.1
or even 7.0.x tests. And once a data file has been interpreted, it’s interpreted forever so you can view its
report whenever you like.

Again, just to be clear: you may take or administer the Practice Test and even the T.O.V.A. Test as many
times as you like, but interpreting a test to generate a T.O.V.A. Report will require an Interpretation credit.

So what do you get with a T.O.V.A. report? The short answer is that you get the comparison of the subject’s
performance to the T.0.V.A. norming study, graphs, comparisons to an ADHD study, raw data, etc. But
that’s just the short answer: see the T.O.V.A. 7.3 Clinical (or Screening) Manual for the long answer. And
for the neuropsychology nerds among you, see the T.O.V.A. 7.3 Professional Manual for the gory neuropsych
details of the T.O.V.A. Test.

To interpret a test choose ‘Interpret Test’ from the Interpretation menu or press F7.

Of course, in order to interpret a test and generate a T.O.V.A. Report, you'll need a data file with test data
in it. Else you'll see Figure 198.
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 198: You must have test data to interpret

If the test has not been interpreted before, your data file will be automatically saved (Figure 194). You will
then be warned that the interpretation will cost you one credit (Figure 199). Choose ‘OK’ and the credit
will be decremented from your Scorebox, the file will be interpreted and the interpreted file automatically
saved again.

[Press 'Esc' ancel] [Use 1 | ¢+ 'Tab' to move]

Figure 199: Interpretation will cost a credit
After you ‘OK’ the autosave dialog, you'll be asked if you want to display the report. Choose ‘OK’, and
‘Form 1’ of the T.O.V.A. Report will be displayed. Choose ‘Cancel’, and you will be returned to the main

screen.

Continuous Performance Test

[Press 'Esc' ancel] [Use 1 |« » 'Tab' to move] ['Pagelp'/'PageDown' for m

Figure 200: Display the T.O.V.A. Report now?

Finally, to check how many interpretation credits you have, go to ‘Check Scorebox’ under the Setup menu.
The Check Scorebox dialog will display all of the relevant information about your Scorebox, including serial
number, number of interpretation credits, and the version of your test (screening or clinical).
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Figure 201: All about the attached Scorebox

13.2.7 Displaying, printing and exporting the T.0O.V.A. Report

At this point in the walk-through, there should be an interpreted data file loaded in the memory.
Viewing the T.0.V.A. Report on screen

You can immediately view the results by choosing any of the report form numbers (e.g., ‘1’) from the Display
menu. If the Form entries are a light gray in the Display menu, then this means that there isn’t an interpreted
data file in memory.

Note that some of the forms are multiple screens long, so press the ‘page down’ and ‘page up’ keys to flip
pages. Hitting the ‘Esc’ key will get you back to the main screen at any time.

Printing the T.0.V.A. Report

Although you can review the T.O.V.A. Report, on your computer, you most likely will want to print out the
report to file away in your notes. You can print the T.O.V.A. Report easily by choosing ‘Print...” from the
File menu. Figure 202 shows the dialog that allows you to specify which forms you want to print.

File Setup Test Imterpretation ions Display iindow fielp

.A. Continuous Performance Test
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[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 202: Select the forms to be printed

Note: Sometimes not every form you see in Figure 202 will appear in the list to be printed.

e Only the ‘Table of Contents’ will appear if you have no data files open, or if the active data file has
not been interpreted.

e ‘Form 6’ will not appear if you have a Screening version of the T.O.V.A.

e ‘Interventions’ will only be listed if you have already selected one or more interventions. See section 25
on page 150 for more details.
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e The Comparison Graph will compare one or more opened data files. If you only have one data file

open in the T.O.V.A., the ‘Comparison Graph’ will not appear.

Choose ‘OK’ to send your selected forms to your parallel port printer.

Exporting the T.O.V.A. Report

Exporting works similarly to printing, except it ‘prints’ a T.O.V.A. Report directly to a text file. This text
file can then be opened by any word processor, which is sometimes a handy way to create an electronic
report. Choose ‘Export...” from the File menu, and you will select the forms to export (Figure 203) and

choose ‘OK’.

Continuous Performance Test

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 203: Select the forms to be exported

Afterward, you will have to specify the export file name (Figure 204), or accept the default.

jo1000101. Tx

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 204: Specify the export filename

File Setup Tes: isplay Uindow felp

ntinuous Performance Test

Figure 205: Export in progress

You will then be notified that the export is in progress (Figure 205), and, when completed (Figure 206),

where the export file was saved.
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Figure 206: Export complete!

Note: By default, your file will be exported to...you’ll never guess...your ‘Export Path’. This is something
you can set yourself, which is sometimes very handy. For example, if you're running on a Windows computer,
you can export your T.0.V.A. Reports directly to your Windows desktop if you wanted to. To review/modify
your Export Path, find in the File menu ‘File Management’, ‘Change Export Path’. See the File Management
section (section 30 on page 163) for details.

Note: If you know you always want to export the report rather than print it, you can actually set your
default printer to ‘export’. That way you can just hit F8 and your file will automatically be exported. Under
the Setup menu, choose ‘Settings’. Then choose ‘Select Printer’ and finally choose ‘Export to Text File’ as
your printer.

13.2.8 You’re done!

Finally, let’s choose, from the File menu, ‘Exit...” or F12 to exit the program. The T.O.V.A. will exit to a
DOS prompt. At this point, you can:

e Restart your computer to Windows ME by removing the T.O.V.A. 7.3 CD from your CD drive and
by pressing ‘Ctrl’, ‘Alt’ and "Del’ at the same time).

e Remove the T.0.V.A. 7.3 CD from your CD drive and shutdown your computer.

Congratulations! You've successfully navigated a full T.O.V.A. session!

13.2.9 Handy Reference Sections to know about

Finally, there are a reference sections you will want to know about:

e Requesting additional interpretation credits: section 15 on page 129
e Comparing multiple T.O.V.A. tests with the comparison graph: section 24 on page 149

e Selecting and generating an Interventions Report: section 25 on page 150
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14 Administering the T.O.V.A. in DOS

The T.0.V.A. is a DOS application, and for those of you who have the T.O.V.A. 7.3 installed on a PC with
only DOS as its operating system, that still suits us just fine. These instructions are for all three of you.

14.1 Running the T.O.V.A. Application

When you installed the T.O.V.A. 7.3, a batch file will have been installed at the root of your hard drive. By
default, this will be C:\, and it’s the location we will assume for the purpose of these instructions. If you are
not already at the root of your install drive, type ‘C:’ and press ‘Enter’, then type ‘cd \’ and press ‘Enter’.

You should now be at the root of your install drive, and you will be prompted with something like ‘C:\)’.
At the prompt, type ‘tova’ and press ‘Enter’. That should be all you have to do to run the T.O.V.A. 7.3.
It will activate a batch file, ‘tova.bat’, which was installed in your C:\ directory.

Note: If the root of your install drive is in your path, you should be able to type ‘tova’ to run the T.O.V.A.
from any location. Alternatively, you may move ‘tova.bat’ from the root of the install drive to a location in
your path.

That file will go to the T.O.V.A. install path, run the T.O.V.A. executable, and, after you exit the T.O.V.A.,
return you to the root of your install drive. If it does not, contact T.O.V.A. Technical Support. It’s free,
and a call from somebody with a DOS system problem will be a nice change of pace for them.

14.2 Setting up the T.O.V.A.

Figure 207: Time to setup the T.O.V.A.

When you run the T.O.V.A. 7.3 for the first time, or if something should happen to corrupt or destroy the
existing preferences file, you will encounter the T.O.V.A. setup (Figure 207).

The quickest and easiest way to get through this is simply to accept all defaults. Press ‘Enter’ repeatedly to
accept each of the dialogs. They are the correct settings for most users, and if they turn out to be wrong,
you can always go back and change the settings under ‘Settings’ in the Setup menu. See section 19 on page
134 for more details on T.0.V.A. Settings and Preferences.

If you decide to accept all defaults, you may skip right to ‘Hardware Check’, section 14.2.10 on page 112
below. If you want to learn more about each of these settings, let’s look at them now.
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14.2.1 Setup requirements

Make sure that you fulfill the requirements listed in Figure 207 before continuing with the setup. If you
cannot, you may choose ‘Cancel’” or simply accept all defaults and make changes to the settings later. Once
you’ve attached all the necessary hardware, press ‘Enter’ to choose ‘OK’ to proceed.

14.2.2 Setup instructions

Figure 208: Navigating the T.O.V.A. setup

You will come to the setup instructions (Figure 208). They are self-explanatory. Choose ‘OK’ to proceed.

14.2.3 Monitor type

Figure 209: Choosing your monitor type

There are still a few of you out there with monochrome or non-color monitors. The rest of us can accept the
default of ‘Color’ (Figure 209). Choose ‘OK’ to proceed.
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14.2.4 Units of measurement

Figure 210: Choosing your units of measurement

In this dialog (Figure 210) select the type of units you want to use and choose ‘OK’ to proceed.

14.2.5 Printer

Figure 211: Selecting your printer
Will you use a Windows printer (Windows 2000 and XP only), a parallel port DOS printer (the first three

choices), or print your reports to a text file? This dialog (Figure 211) lets you choose. Choose ‘OK’ to
proceed.

14.2.6 Sound source

Figure 212: Source for Auditory T.O.V.A. sound

If you'll be administering the Auditory T.0.V.A. Test (Figure 212), you will need to generate the audio either
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through the T.0O.V.A. Speaker Driver or through a Sound Blaster-compatible sound card. Most T.O.V.A.
users use the T.0.V.A. Speaker Driver. Choose ‘OK’ to proceed.

14.2.7 Ports

Figure 213: Printer port

eeeeeeeeee

Figure 214: Scorebox port

Figure 215: Microswitch port

Figure 216: Speaker port
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Most of our users will use a single parallel port, LPT1, for their Printer (Figure 213), Scorebox (Figure 214),
Microswitch (Figure 215), and T.O.V.A. Speaker Driver (Figure 216). Some of them may even be combined
into a single device. Choose ‘OK’ to proceed.

14.2.8 Show subject names in dialog boxes

Figure 217: Show Subject Names

It will probably help you to include Subject Names in the T.O.V.A. data file dialogs, but if other sub-
jects might watch you while browsing for their data file, you likely want to hide that information. If you

choose to ‘Show Subject Names’ and choose ‘OK’, you will be reminded to “protect subject confidentiality”
(Figure 217). Choose ‘OK’ to proceed.

14.2.9 Confirming settings

Figure 218: Confirm your settings

This dialog (Figure 218) is to confirm your choices. Choose ‘OK’ to proceed or ‘Redo’ to start over.

section 14.2.10 on page 112

14.2.10 Checking the T.0.V.A. hardware

After you’ve made all your T.O.V.A. Setup selections, the T.O.V.A. will automatically check your hardware
(Figure 219). Choose ‘OK’ to proceed.
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[Press 'Enter’ to select or 'Esc' to cancel] ([Use t | « » 'Tab' to move]

Figure 219: Checking the hardware

First, the T.O.V.A. checks the system timing to ensure that the T.O.V.A. Test can be administered with
precision and accuracy. If you see Figure 221 then something is wrong with the timing on your computer;
please see ‘Troubleshooting T.0.V.A. Hardware’ (section 26 on page 154) in the reference section.

Syatem timing

Figure 220: Checking the system timing

Figure 221: Bad system timing

Check Hardware next confirms that a valid T.O.V.A. 7.3 Scorebox is attached. If it succeeds, you’ll see
nothing, but if it fails, you'll see the dialog in Figure 222.

Figure 222: Scorebox not found

Again, if you have trouble getting your Scorebox to be read, please see ‘Troubleshooting T.O.V.A. Hardware’
(section 26 on page 154).

Finally, Check Hardware verifies that the microswitch is working by asking you (Figure 223) to click the
microswitch exactly ten times over a period of ten seconds (Figure 224).
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Elapsed Time:

Microswitch Pres

Figure 224: Testing the microswitch

If it fails, you'll get a message like this (Figure 225). Try it again, and if continues to fail, please see
‘Troubleshooting T.0.V.A. Hardware’ (section 26 on page 154) in the reference section.

Figure 225: Microswitch failure

If your hardware has passed (Figure 226) the tests successfully, you should be okay to administer a T.O.V.A.
Test. If it does not (Figure 227), you should consult Troubleshooting, section 26 on page 154 or contact
T.O.V.A. Technical Support before administering a T.O.V.A. Test.

Figure 227: Hardware error

14.2.11 Setup complete!

Congratulations! You’ve finished setting up the T.O.V.A. Don’t forget: you can always go back and change
any of these settings individually by choosing ‘Settings’ under the Setup menu.
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14.3 Detailed T.O.V.A. 7.3 Walk-through for DOS

Once you’ve run the T.O.V.A. (see above) and you’ve gone through the T.O.V.A. Setup (see above), you're
now ready for the full walk-through. This is how you administer the T.O.V.A. Test, with all of the sordid
details. Note that if you can’t find a particular detail in this section, see the ‘Using the T.O.V.A. 7.3’ section
(section IV on page 128). If you can’t find what you’re looking for in that, then check the ‘Reference’ section
(section VI on page 153)... or, call us for some T.0.V.A. Technical Support, on the house.

14.3.1 Creating a new subject or a new session

Once you've started the T.O.V.A., you will arrive at the T.0.V.A. main screen (Figure 228). This is where
you can add/modify subject information or use the various menus to access other T.O.V.A. features.

File Setup Test Imterpretation

[To use the menu bar press 'Alt' + Letter and 1 1] [Use 'Tab' or 1 I to movel

Figure 228: The T.O.V.A. Main Screen

Don’t panic if it seems unfamiliar; remember to refer to the ‘Quick Reference Card’ that came in your
T.0.V.A. 7.3 CD case, and to the ‘Navigating around the T.O.V.A.” section (see section 10 on page 40).

Choose ‘New Test’ from the File menu (or press the F2 key). Here (Figure 229) you have a choice between
creating a new subject or a new session for an existing subject.

Tile Setup Test Inmcerprecation Interventions Display Uindow FHelp

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 229: Choosing a New Test

Creating a New Subject

If you choose ‘New Subject’, the T.O.V.A. will clear the main screen and instruct you (Figure 230) to enter
in the new subject’s data. By the way, this first step — creating a new subject — has actually already been
done. Whenever you start the T.O.V.A., you will be brought to a main screen empty of subject information.

So in the case of a new subject, you can immediately start entering subject information as soon as the
T.O.V.A. starts up.
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 230: New subject instructions

Note: The only subject information we require for you to administer a T.O.V.A. Test is the Subject Number,
Gender, Date of Birth, and Test Date. The Subject Number and Test Date should be provided automatically
by the T.O.V.A., and should not be modified without advice from T.0O.V.A. Technical Support. Do make
sure that the date is correct, of course. Adding other information, such as Medications and Dosages, will
aid interpreting the test so we encourage you to fill out the form as much as you want.

Note: It is critical that the subject’s gender and age is correct. An mistake here will invalidate the accuracy
of the T.O.V.A. Report, since comparison to the T.0.V.A. norming study must be done for the proper
gender and age group.

For the purposes of this walk-through, go ahead and enter in your name and date of birth (or someone
else’s!). We'll proceed with the walk-through after discussing new sessions.

Creating a New Session

If you are about to test a subject who has already had a T.O.V.A. Test, then use ‘New Session’. This allows
you to pull in subject information from a previous test. In particular, this keeps the same subject number
for the subject, which is an important way of keeping track of your subjects.

If there’s already a file open in memory, then the T.O.V.A. will first ask you if you want to use the subject
information from that file (Figure 231). This is handy when you're giving a baseline test immediately followed
by a medication challenge test.

ormance Test

[Press 'Esc' to cancel] [Use 1 | ¢ » 'Tab' to move]

Figure 231: Use the Active File or Open another?

If there is no open, active file or if you chose to use an unopened file, you will be instructed (Figure 232) to
browse (Figure 233) for the data file containing the latest session for that subject.
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 232: New session instructions

erformance Test

[Pre: el] [Use 1 4 « -+ 'Tab' to nmove]

Figure 233: Select the latest session data file for the subject

Note: When creating a new T.0O.V.A. session, make sure you base it on the data file with the latest
available session. In Figure 233, if you were creating a new session for Subject Number ‘0023’, you would
select ‘01002305.m13’, which is the latest session (session ‘05’, in this case) for this subject. For more
information about filenames, and how they are created, see section 36 on page 175.

When you see Figure 234, you've successfully created a new session for this subject. All of the subject
information will be carried over to the new data file, but information such as Tester, Medications, etc., will,
of course, be reset for this new session.

[Press 'Esc' to cancel] [Use 1 | ¢ » 'Tab' to move]

Figure 234: You’ve created a new session

14.3.2 Checking the T.O.V.A. hardware

Just like you did in the T.O.V.A. Setup above (section 14.2 on page 108), it’s always a good idea to check
the T.O.V.A. hardware before administering a test.

Choose ‘Check Hardware’ from the Setup menu, or press F3, to check the hardware. Again, see section 14.2
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on page 108 for the step-by-step instructions for checking the hardware.

14.3.3 Present the T.0O.V.A. stimuli

The next step is to present the T.O.V.A. stimuli to the subject, which you can do by choosing ‘Present
Stimuli’ from the Test menu or by pressing F4.

inuous Performance Test

Figure 235: Present visual or auditory stimuli?

Note: If you have a T.O.V.A. Scorebox enabled for both Visual and Auditory tests, you will be greeted
first by Figure 235. There’s nothing really to see when presenting Auditory stimuli, so we did not include
any screen-shots.

Figure 236: Target

Figure 237: Nontarget
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Figure 238: Focus Point

Choose ‘Display stimuli’ from the Test menu, and you will be shown a screen presenting (as you would
expect) the Target (Figure 236) and Nontarget (Figure 237) stimuli, as well as the Focus Point (Figure 238)
the subject will see in between stimuli. Or, if this is to be an Auditory T.O.V.A. Test, you will hear the
Target /Nontarget tones, instead.

One of the most critical parts of the T.0O.V.A. is preparing the subject to take the test. To
help you with this, we have recommended text for each section that involves the subject.

It is VERY important that you read or paraphrase this text with all subjects, especially subjects
who have never taken the T.0.V.A. Test. How they take the T.O.V.A. is critical to the T.O.V.A.’s
accuracy, so we recommend you read and understand these instructions. As a handy reference, your ‘Quick
Reference Card’ in your CD case has all of this text.

Slowly read or paraphrase the following (vary as needed for the auditory test):

This test measures your ability to pay attention. Two different kinds of squares will flash on the
computer screen. The squares will differ only in that one of them will have a square near the top
(indicate the target image) and one will have the square near the bottom (indicate). We want
you to press this button (indicate) every time you see the white square with the black square
near the top (indicate). I want you to hold this button in your writing hand (find out which
hand they use for writing) with your thumb resting lightly on top, like this (indicate). When you
press the button, let up when you hear the click. Don’t hold the button down for long, and push
it down only once for each correct square.

Now we are going to flash the squares on the screen, and your job is to press the button AS
FAST AS YOU CAN every time you see a square with the square near the top (indicate). But
the trick is that you are NOT to press the button when the square is near the bottom (indicate).
Remember; press the button as fast as you can but only for the square with the square near the
top. The idea of this test is for you to be as fast, but also as accurate, as you can. Try not to
make any mistakes. But if you do, don’t worry; everyone makes mistakes on this test. Try and
press the button as fast as you can but only for the square with the square in the top. Don’t
be too fast - take enough time to see which square it is. Don’t guess. Once you’ve pressed the
button, let up and don’t press it more than once when you see the correct square. Any questions?

Not terribly exciting, but a good demonstration for a new subject. Besides, if this is too boring for your
subject, they will never survive the T.O.V.A.

When you're done...wait for it...choose ‘Done’.
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14.3.4 Administer the Practice Test

Next you will want to administer the Practice Test to the subject by choosing ‘Practice Test’ from the Test
menu or by pressing F5. Introduce this to your subject by slowly reading or paraphrasing this statement:

Now we are going to do a practice test for about 3 minutes to see if you understand how to take
the test.

The T.O.V.A. Practice Test lasts 144 seconds, displaying 72 stimuli, once every two seconds. A Visual and
Auditory enabled Scorebox will first be given a choice of which type of Practice Test to give (Figure 239):

File Setup Test Inmterpretation Interventions Display [indow FHelp

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 239: Choose the type of Practice Test

Figure 240: Press the microswitch button to start the test

Once you select the type of Practice Test, or if your Scorebox only has one type enabled, you will see
Figure 240, and it will be time to start the test. Pressing the microswitch button will start a countdown
and, after three seconds, the test has begun. As the dialog mentions, hit the ‘Esc’ key to abort the Practice
Test.

[Press 'Esc' to cancel] [Use 1 | & » 'Tab' to move]

Figure 241: The results of the Practice Test
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At the end of the test, you will hear a quick series of tones, indicating that the test has ended, and then
you will see the Practice Test Results (Figure 241). These will help indicate to you whether the subject
understood the test directions and whether any hardware failure might have occurred.

Check the Practice Test results for:

e A low number of omissions and commissions (high numbers of both may indicate that the subject
misunderstood the test instructions and is pressing the button on the wrong stimuli).

e A low number of multiples
e A low number of anticipatory errors

e A reasonable average response time: for example, a response time > 300 ms but less than < 1500 ms.

14.3.5 Administer the T.0O.V.A. Test

Choose ‘T.O.V.A. Test’ from the Test menu, or press F'6 to administer the T.O.V.A. Test.

As with the previous steps, if you have a Visual-only T.0.V.A., you won’t see the dialog in (Figure 242). If
you do see the dialog, select the type of T.O.V.A. Test you want to administer to this subject.

inuous Performance Test

Figure 242: Choose the type of T.O.V.A. Test

If you see Figure 243, then you already have Response Data from a previous T.0.V.A. Test saved to this
file. Taking the T.O.V.A. Test now will destroy that data, so verify that you do want to
OVERWRITE the existing test data before continuing.

Figure 243: Destroy existing Response Data?

WARNING! This dialog really does mean what it says: taking another test will overwrite existing data.
If you need to test your subject again, but you want to preserve the previous data, instead create a New
Session for this subject (see section 14.3.1 on page 115 for details).
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The T.0.V.A. will automatically save (Figure 244) before and after the T.O.V.A. Test.

Figure 244: File is automatically saved

You will arrive at Figure 245. Before the subject begins, you should slowly read or paraphrase the following,
modifying it particularly for the Auditory test:

Now we are going to do the real test for about 20 minutes. Do the best job you can. Also, you
should know that your eyes are probably going to get a little tired. Even so, try and do the best
job you can... press the button as quickly as you can but only for the square with the black
square on the top. Click the button to begin the test.

Figure 245: Press the microswitch button to start the test

Once the test has begun, we do not recommend you interrupt it until it is complete. Any interruption will
affect interpretation of the test. However, should it be necessary, you can interrupt the T.O.V.A. Test just
like the Practice Test by pressing the ‘Esc’ key.

Figure 246: T.0O.V.A. Test interrupted

Aborting the test will give you a dialog (Figure 246) with the following options:
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‘Abort’: This will immediately end the test, and save whatever data has been accumulated so far. The
partial test may be interpreted, but it cannot be continued later.

‘Restart’: All response data will be cleared away, and the test will start over from the beginning, asking you
to press the microswitch to start. If it is just a few minutes into the test, this is what we recommend
doing.

‘Continue’: If you choose to continue an interrupted test, you will see Figure 247: continue the test from
here, without restarting, and the test will be invalid. For more information on valid/invalid tests, see
the T.O.V.A. 7.3 Clinical (or Screening) Manual. You may again choose to ‘Continue’, or you may
choose instead to ‘Restart’.

[Press 'Esc' to cancel] [Use 1 | & » 'Tab' to move]

Figure 247: Continuing isn’t always the best thing to do; consider restarting.

Once the test is completed or aborted, you will hear the same series of tones as at the end of the Practice
Test. Your test will be automatically saved again (Figure 244), and you will be returned to the main screen.

Congratulations! You and your subject have suffered through a T.0.V.A. Test. But remember, there’s a
very good reason it’s so boring: it wouldn’t be as good of a test of attention if it wasn’t obnoxiously boring!

14.3.6 Interpreting the T.O.V.A. Test

Once you’ve taken the T.O.V.A. Test, it will need to be interpreted in order to generate a T.O.V.A. Report.
Note that you don’t have to interpret it immediately; once the test data has been saved, you can interpret
it weeks, months, even years later. In fact, you can even go back and interpret or re-interpret older 7.2, 7.1
or even 7.0.x tests. And once a data file has been interpreted, it’s interpreted forever so you can view its
report whenever you like.

Again, just to be clear: you may take or administer the Practice Test and even the T.O.V.A. Test as many
times as you like, but interpreting a test to generate a T.O.V.A. Report will require an Interpretation credit.

So what do you get with a T.O.V.A. report? The short answer is that you get the comparison of the subject’s
performance to the T.0.V.A. norming study, graphs, comparisons to an ADHD study, raw data, etc. But
that’s just the short answer: see the T.O.V.A. 7.3 Clinical (or Screening) Manual for the long answer. And
for the neuropsychology nerds among you, see the T.O.V.A. 7.3 Professional Manual for the gory neuropsych
details of the T.O.V.A. Test.

To interpret a test choose ‘Interpret Test’ from the Interpretation menu or press F7.

Of course, in order to interpret a test and generate a T.O.V.A. Report, you'll need a data file with test data
in it. Else you'll see Figure 248.
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Figure 248: You must have test data to interpret

If the test has not been interpreted before, your data file will be automatically saved (Figure 244). You will
then be warned that the interpretation will cost you one credit (Figure 249). Choose ‘OK’ and the credit
will be decremented from your Scorebox, the file will be interpreted and the interpreted file automatically
saved again.

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 249: Interpretation will cost a credit

After you ‘OK’ the autosave dialog, you'll be asked if you want to display the report. Choose ‘OK’, and
‘Form 1’ of the T.O.V.A. Report will be displayed. Choose ‘Cancel’, and you will be returned to the main
screen.

[Press 'Esc' to cancel] [Use 1 L« » 'Tab' to move] ['Pagelp'/'PageDown' for m

Figure 250: Display the T.O.V.A. Report now?

Finally, to check how many interpretation credits you have, go to ‘Check Scorebox’ under the Setup menu.
The Check Scorebox dialog will display all of the relevant information about your Scorebox, including serial
number, number of interpretation credits, and the version of your test (screening or clinical).
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[Press 'Esc' to cancel] [Use t | ¢ » 'Tap' to move]

Figure 251: All about the attached Scorebox

14.3.7 Displaying, printing and exporting the T.0O.V.A. Report

At this point in the walk-through, there should be an interpreted data file loaded in the memory.
Viewing the T.0.V.A. Report on screen

You can immediately view the results by choosing any of the report form numbers (e.g., ‘1’) from the Display
menu. If the Form entries are a light gray in the Display menu, then this means that there isn’t an interpreted
data file in memory.

Note that some of the forms are multiple screens long, so press the ‘page down’ and ‘page up’ keys to flip
pages. Hitting the ‘Esc’ key will get you back to the main screen at any time.

Printing the T.0.V.A. Report

Although you can review the T.O.V.A. Report, on your computer, you most likely will want to print out the
report to file away in your notes. You can print the T.O.V.A. Report easily by choosing ‘Print...” from the
File menu. Figure 252 shows the dialog that allows you to specify which forms you want to print.

File Setup Test Imterpretation ions Display iindow fielp

.A. Continuous Performance Test

flcoccmcese

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 252: Select the forms to be printed

Note: Sometimes not every form you see in Figure 252 will appear in the list to be printed.

e Only the ‘Table of Contents’ will appear if you have no data files open, or if the active data file has
not been interpreted.

e ‘Form 6’ will not appear if you have a Screening version of the T.O.V.A.

e ‘Interventions’ will only be listed if you have already selected one or more interventions. See section 25
on page 150 for more details.
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e The Comparison Graph will compare one or more opened data files. If you only have one data file

open in the T.O.V.A., the ‘Comparison Graph’ will not appear.

Choose ‘OK’ to send your selected forms to your parallel port printer.

Exporting the T.O.V.A. Report

Exporting works similarly to printing, except it ‘prints’ a T.O.V.A. Report directly to a text file. This text
file can then be opened by any word processor, which is sometimes a handy way to create an electronic
report. Choose ‘Export...” from the File menu, and you will select the forms to export (Figure 253) and

choose ‘OK’.

Continuous Performance Test

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 253: Select the forms to be exported

Afterward, you will have to specify the export file name (Figure 254), or accept the default.

jo1000101. Tx

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 254: Specify the export filename

File Setup Tes: isplay Uindow felp

ntinuous Performance Test

Figure 255: Export in progress

You will then be notified that the export is in progress (Figure 255), and, when completed (Figure 256),

where the export file was saved.
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Figure 256: Export complete!

Note: By default, your file will be exported to...you’ll never guess...your ‘Export Path’. This is something
you can set yourself, which is sometimes very handy. For example, if you're running on a Windows computer,
you can export your T.0.V.A. Reports directly to your Windows desktop if you wanted to. To review/modify
your Export Path, find in the File menu ‘File Management’, ‘Change Export Path’. See the File Management
section (section 30 on page 163) for details.

Note: If you know you always want to export the report rather than print it, you can actually set your
default printer to ‘export’. That way you can just hit F8 and your file will automatically be exported. Under
the Setup menu, choose ‘Settings’. Then choose ‘Select Printer’ and finally choose ‘Export to Text File’ as
your printer.

14.3.8 You’re done!

Finally, let’s choose, from the File menu, ‘Exit...” or F12 to exit the program. The T.0O.V.A. will exit back
to a DOS prompt.

Congratulations! You’ve successfully navigated a full T.O.V.A. session!
14.3.9 Handy Reference Sections to know about

Finally, there are a reference sections you will want to know about:

e Requesting additional interpretation credits: section 15 on page 129
e Comparing multiple T.O.V.A. tests with the comparison graph: section 24 on page 149

e Selecting and generating an Interventions Report: section 25 on page 150
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Part IV

Using the T.O.V.A. 7.3

In Part IV of this manual, we’ll help you use the parts of the T.O.V.A. you’ll have to use on a regular basis,
but might not have been involved in administering the T.O.V.A. Test. The most important of these things
are:

Requesting Credits see section 15 on page 129

Settings and Preferences see section 19 on page 134

Using the Function Keys see section 17 on page 131

Preparing the Subject for Testing see section 16 on page 130

And last but not least:

e Using the T.0O.V.A. 7.3 Boot CD see section 20 on page 141
e The T.O.V.A. 7.3 Main Screen in Detail see section 18 on page 132
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15 Requesting Credits

15.1 About Interpretation Credits

In order to interpret a T.O.V.A. Test and thus generate a T.0.V.A. Report, you must have one or more
‘interpretation credits’ on your Scorebox.

To check the number of interpretation credits you have, select ‘Check Scorebox’ from the Setup menu.

The Check Scorebox dialog box will display the number of credits you have left. If this number is 0, you
must request more credits. Note that if there is an error reading the Scorebox, you must fix this problem
before requesting credits (see Troubleshooting, section 26 on page 154).

The way you add credits is by calling our 24 hour telephone credit system.

15.2 Requesting Interpretation Credits

Before proceeding, have a pencil and paper ready and find both your customer number and serial number.
Your customer number and your T.0.V.A. serial number were printed on stickers enclosed with your T.O.V.A.
software. Your serial number can be obtained from choosing ‘Check Scorebox’ from the Setup menu, but
if you do not have your customer number you must contact The TOVA Company directly (800.729.2886 /
+1.562.594.7700 / infoQtovatest.com).

Call 800.993.4343 (562.229.8783).

Listen to the message, then press the “#” key on your telephone.

Enter your customer number, followed by the “#” key.

Enter your serial number, followed by the “#” key.

Enter the number of credits you want, followed by the “#” key.

WRITE DOWN the 16 digit activation code, WITH the dashes, i.e., 1234-5678-8765-4321

Noe g e

Now that you have the activation code, choose ‘Request Credits’ from the Setup menu (or press ‘F10’)
and type in the 16-digit code WITH the dashes (-). Choose ‘OK’. See Figure 257.

up Test Interpretation Interventions Display  Window

T.0.V.A. Continuous Performance Test

cancel] [Use t } + + 'Tab' to move]

Figure 257: The request interpretation credits dialog
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Your Scorebox should now be credited with the number of credits you requested; select ‘Check Scorebox’
under the Setup menu to verify you have the correct number of credits.

If you have any problems requesting credits, please contact T.0.V.A. Technical Support before using the
Request Credits telephone system again. The T.0O.V.A. can not ‘skip’ an activation key, so if it doesn’t
work, we’ll need to fix that before you request credits again.

16 Preparing the Subject for Testing

In this section, we’ve collected the whole ‘script’ that we strongly encourage you to use in order to prepare
a subject to take the T.O.V.A. Test. Preparing the subject is crucial:

1. It assures that the test is administered properly.

2. Tt replicates the same conditions as the T.O.V.A. norms.

16.1 Pre-test Preparation

1. Prior to testing, explain to the subject (or to caregivers) that no caffeinated beverages (e.g. coffee, tea,
cocoa, or soft drinks) should be ingested on the day of a test. Nor should the subject have smoked.

2. Time of Day: Testing is best done between 5:00 AM to 1:30 PM to control any diurnal effects.

3. Setting: Testing should be done in a quiet, darkened room with a glare-free monitor screen. Clocks
should not be visible. It is best if the subject faces a neutral colored wall without distracting pictures.
The monitor should be placed so that the keyboard is not visible or available to the subject.

4. At test time:

e Introduce yourself to the subject.

e Ask if the subject needs to use the bathroom.

e Determine whether they have glasses or hearing aid if needed.
e Have subject remove his or her watch.

e Determine from subject or caregiver any medications taken in the last 12 hours (Ritalin, anti-
convulsants, and/or antihistamines). If so, record in Medication, Dosage, and Med-Test Interval
sections. See the Main Screen section (section 18 on page 132) for instructions.

e Position the subject and chair so he or she may sit with feet on the floor.

e Position the monitor so the screen is at, slightly above, or slightly below eye level.

16.2 Present the Stimuli

If the subject has never taken the T.O.V.A. Test before, we recommend displaying (or playing) the stimulus
to them and reading the full text below. Subjects who have taken the T.O.V.A. previously just need a quick
refresher about when to push the button, and to balance speed and accuracy.

This test measures your ability to pay attention. Two different kinds of squares will flash on
the computer screen. The squares will differ only in that one of them will have a hole near the
top (indicate) and one will have the hole near the bottom (indicate). We want you to press this
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button (indicate) every time you see the square with the hole near the top (indicate). (Find out
which hand they use for writing) I want you to hold this button in your writing hand with your
thumb resting lightly on top, like this (indicate). Take the button. Let up when you hear the
click; don’t hold the button down very long. Push it down only once for each correct square.

Now we are going to flash the squares on the screen, and your job is to press the button AS
FAST AS YOU CAN every time you see a square with the hole near the top (indicate). But
the trick is that you are NOT to press the button when the hole is near the bottom (indicate).
Remember, press the button as fast as you can but only for the square with the hole near the
top. The whole idea of this test is for you to be as fast, but also as accurate as you can. Try not
to make any mistakes. But, if you do make a mistake, don’t get upset, don’t worry. Everyone
makes mistakes on this test. Try and press the button as fast as you can but only for the square
with the hole in the top. Don’t be too fast: take enough time to see which picture it is. Don’t
guess. Once you’ve pressed the button, let up. Don’t press it more than once when you see the
correct signal. Any questions?

16.3 Practice Test

Now administer the Practice Test (see Part II, ‘Administering the T.O.V.A. Test’, section III on page 39)
with the following instructions:

Now we are going to do a practice test for about 3 minutes to see if you understand how to take
the test.

16.4 T.O.V.A. Test

Now administer the T.O.V.A. Test (see Part II, ‘Administering the T.O.V.A. Test’, section III on page 39)
with the following instructions:

OK, now we are going to do the test for about 20 minutes. Do the best job you can. Also, you
should know that your eyes are probably going to get a little tired. Even so, try and do the best
job you can. Press the button as quickly as you can but only for the square with the hole in the
top.

I’ll be right here while you do the test, but I can’t talk to you once the test starts. Do you have
any questions before we begin? Ready, here we go. Press the button to start.

17 Using the Function Keys

You can use the function keys - the keys located at the top of your keyboard labeled ‘F1’ through ‘F12’ - to
run the T.O.V.A.:

F1 How to navigate around the T.O.V.A.
F2 Prepare for a new subject or new session
F3 Check the T.O.V.A. hardware

F4 Display the T.0.V.A. stimuli
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F5 Administer the Practice Test

F6 Administer Test (Windows mode: Enter Test Mode)
F7 Interpret Test

F8 Print Report

F9 Open File

F10 Request Credits

F11 File Management

F12 Exit (Test mode: Exit Test Mode)

18 The T.O.V.A. 7.3 Main Screen in Detail

You can use the ‘Tab’, left and right arrow keys, ‘Enter’ and ‘Esc’ to navigate through the text entry fields
on the T.O.V.A. main screen. Hitting ‘Esc’ is always a good idea if the text entry seems to get ‘stuck’.

Below is an in depth discussion of all the fields on the T.O.V.A. 7.3 Main Screen. Note that the fields are
listed in the ‘Tab’ order, meaning as you hit the ‘Tab’ key, the fields will be lit up in the following order.

Subject information:

Name Optional The Subject’s name. Don’t forget that this is HIPAA protected
data.
Subject # Required Automatically generated 2 digit group number followed by an au-

tomatically generated 4 digit subject number. To change these
defaults, we strongly recommend you use the ‘Change the Group
Number’ and ‘Change the Subject Number’ in the Settings dialog
in ‘Settings’ under the Setup menu.

Session # Required Automatically generated 2 digit session number. Each subject can
have multiple T.O.V.A. sessions, and the session number keeps
track of this.

Gender Required ‘M’ for mail, ‘F’ for female.

Test Time Required Time of the test in HH:MM AM/PM format. This field is auto-
matically entered on a New Test (F2) using the computer’s built
in clock.

Test Date Required Date of test in the MM/DD/YY format. This field is automatically
entered on a New Test (F2) using the computer’s built in clock.

Birth Date Required The subject’s birth date in a MM/DD/YY format.

Age NA The automatically generated Age in years, months and days.

Please verify that the age in years and months is correct.

Test information:
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Tester
Test Version

Test Serial

ISI

Anticipatory

Test Format

Ontime

Offtime

Optional
NA

NA

NA

NA

NA

NA

NA

A 30 character space for the test giver’s name.

The 8 digit version of the T.O.V.A. Test that was used when the
data file was first saved.

The 6 digit serial number of the T.0.V.A. Scorebox used to inter-
pret the data file.

The Inter-Stimulus Interval, the time between T.0O.V.A. stimuli,
which can range from 1 to 9,999 milliseconds. This can be adjusted
in the Advanced Settings dialog of the T.O.V.A., but adjusting the
Test Format will invalidate the T.O.V.A. norms.

The response time cutoff (measured from the start of the stimulus
display) which defines an anticipatory response which can range
from 1 to 9,999 milliseconds This can be adjusted in the Advanced
Settings dialog of the T.O.V.A., but adjusting the Test Format will
invalidate the T.O.V.A. norms.

The T.O.V.A. Test Format. Ages < 5.5 are given Test Format 6
and > 5.5 are given Test Format 1. This can be adjusted in the
Advanced Settings dialog of the T.O.V.A., but adjusting the Test
Format will invalidate the T.O.V.A. norms.

The time from the start of the ISI to the time the stimulus is
displayed, which can range from 1 to 9,999 milliseconds. This can
be adjusted in the Advanced Settings dialog of the T.O.V.A. but
adjusting the Test Format will invalidate the T.O.V.A. norms.
The time from the start of the ISI to the time the stimulus is
stopped being displayed, which can range from 1 to 9,999 millisec-
onds. This can be adjusted in the Advanced Settings dialog of
the T.O.V.A., but adjusting the Test Format will invalidate the
T.O0.V.A. norms.

Medication Information:

Challenge medica- | Optional The medication for which the T.O.V.A. is measuring a response to

tion medication (30 digits).

Challenge Dosage Optional The dosage, in mg, of the challenge medication (3.2 digits).

Challenge Med-Test | Optional The time from the medication dosage to the test, in hours (2.1

Interval digits).

Med. #2 medication | Optional A secondary medication; meant to be a note to the clinician. (30
digits).

Med. #2 Dosage Optional The dosage, in mg, of the Med. #2 medication (3.2 digits).

Med. #2 Med-Test | Optional The time from the medication dosage to the test, in hours (2.1

Interval digits).

Med. #3 medication | Optional A tertiary medication; meant to be a note to the clinician. (30
digits).

Med. #3 Dosage Optional The dosage, in mg, of the Med. #3 medication (3.2 digits).

Med. #3 Med-Test | Optional The time from the medication dosage to the test, in hours (2.1

Interval digits).

Weight Optional Subject weight in pounds or kilograms, sometimes used for medi-
cation dosing (Metric vs. English units can be set in the ‘Settings’
option under the Setup menu (3 digits).

Height Optional Subject height in inches or centimeters, sometimes used for medi-
cation dosing (Metric vs. English units can be set in the ‘Settings’
option under the Setup menu (3 digits).

Comments:
’ Comments \ Optional 250 characters of comments for use by the clinician or researcher. ‘
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19 Settings and Preferences

In ‘Settings’, under the Setup menu, you can modify a variety of T.O.V.A. settings. In this section, we’ll
discuss each of these settings.

19.1 Parallel Port Settings

If your microswitch, Scorebox, Speaker Driver, and DOS printer are working correctly, you don’t want to
change these settings. If you're encountering problems with any of these, and you think the wrong parallel
port may be selected, here’s where you can specify a different port for each of those settings. Most people
will use LPT1 for all four.

aaaaa

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 258: We recommend LPT1 for most users

File Setup Test Imterpretation ions Display iindow fielp

tinuous Performance Test

[Press 'Esc' to cancel] [Use 1 | ¢ » 'Tab' to move]

Figure 259: You can specify the port for each device

19.2 Select Sound Source

If you are going to administer Auditory T.O.V.A. tests, you will need to select how the T.O.V.A. generates
the auditory stimuli. We recommend using the T.0.V.A. Speaker Driver, since we provide it with the
Auditory T.0.V.A. You may instead use your Sound Blaster-compatible sound card.
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Figure 260: Your sound source for an auditory test

19.3 Select Printer

formance Test

[Pre: ancel] [Use 11 ¢ 'Tab' o <]

Figure 261: Select your printer

From the ‘Select Printer’ dialog you can identify the type of printer on which you intend to print T.O.V.A.
reports.

If you are printing from DOS, you should use ‘HP DOS Printer’ or ‘Canon DOS Printer’ if you are using
those printer brands. If those settings don’t work for you, or you have another brand of DOS printer, select
‘Generic ASCII DOS Printer’. If you do not have a printer attached, you may always select ‘Export to Text
File’. You can copy the exported file and print it on another system if you wish.

Some notes about selecting Windows printer:

e Windows printing is only available in T.0.V.A. Windows mode. T.0.V.A. Windows mode is only
available to Windows 2000 or XP.

e If you are printing in Windows mode to a Windows printer, use the ‘Windows Printer’ option.

e If you select the ‘Windows Printer’ option, you will not be able to print to a DOS printer in Test mode.
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“ontinuous Perfor

Figure 262: Don’t select ‘Windows Printer’ in DOS mode

e You can select ‘Windows Printer’ in DOS mode, but the T.O.V.A. will give warnings (Figure 262) and
still default to ‘Generic ASCII DOS Printer’ when printing.

19.4 Change the Group Number

erformance

Figure 263: Select your Group Number

The Group Number can be used to organize T.O.V.A. data files.

For the Group Number, you can enter a number between ‘00’ - ‘99’. You must enter a leading zero for values
less than ‘10’ (e.g. ‘07’).

Changing the Group Number will change the default filename of the T.0O.V.A. data file, and even if you
assign it a different name, files can be sorted on Group, Subject, and Session Number.

You should use care when modifying the Group and Subject Numbers, either for an individual T.O.V.A.
data file on the main screen or the defaults in the T.O.V.A. settings, since they are used to create a unique
filename for each T.O.V.A. data file.

Each Group Number is associated with a different Subject Number. If you are on Subject Number ‘0734’
in Group Number ‘02’, and you change the setting to Group Number ‘65’, the next Subject Number will be
drawn from the last Subject Number used in that Group, by default ‘0001’.
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19.5 Change the Subject Number

Figure 264: Select the Subject Number

The Subject Number is used to uniquely identify T.O.V.A. data files. When a file with the default Subject
Number is saved, the default Subject Number for the next file automatically increments.

For the Subject Number, you can enter a number between ‘0000 and ‘9999’. You must enter leading zeroes
for values less than ‘1000’ (e.g. ‘0007, ‘0832’, etc.).

Changing the Subject Number will change the default filename of the T.O.V.A. data file, and even if you
don’t use the default filename, files can be sorted on Group, Subject, and Session Number.

You should take care when modifying the Group and Subject Numbers, either for an individual T.O.V.A.
data file on the main screen or the defaults in the T.O.V.A. settings, since they are used to create a unique
filename for each T.O.V.A. data file. Changing the Subject Number could cause you to accidentally overwrite
an older T.O.V.A. data file with a new one.

Each Group Number is associated with a different Subject Number. If you are on Subject Number ‘0734’

in Group Number ‘02’, and you change the setting to Group Number ‘65’, the next Subject Number will be
drawn from the last Subject Number used in that Group, by default ‘0001’.

19.6 Select File Sorting Method

erformance Test

Figure 265: How are files sorted?

This setting selects how files are sorted in file or directory browse dialogs. We allow the following kinds of
sorting:

Test Date This is the default sorting and sorts the latest Test Dates to the top. If two Test Dates are
identical, the T.O.V.A. sorts by the Subject Name, then the filename.

The TOVA Company 800.729.2886 562.594.7700 infoQ@tovatest.com 137



T.0.V.A. 7.3 User’s Manual 19 SETTINGS AND PREFERENCES

Subject Name Sorts alphabetically by the Subject Name (starting at the first character in the field, not
the last name). If Subject Names are identical, the T.O.V.A. sorts by the Test Date, then by the
filename.

Group, Subject, and Session Number Sorts by Group Number, Subject Number, then Session Num-
ber. If the Group, Subject, and Session Numbers are identical, the T.0O.V.A. sorts by the Subject
Name, then by the filename.

Filename Uses the 8.3 filename to sort all files (not just T.0.V.A. files) and directories alpha-numerically.

Do Not Sort Filenames Displays the files as opened by any DOS calls; ordered by location in the FAT
(File Allocation Table). This is the fastest option, especially for directories containing many files.

Unless options 4 or 5 are chosen, directories and non-T.0.V.A. files are grouped (in that order) and sorted
at the end of the list by File Name.

)

In all cases ‘Current directory (.)’ and ‘Up one directory (..)’ are the first two entries (in browses

where they appear at all).

The following screen shot (Figure 266) is a sample of the sorting order when sorted by Test Date:

Figure 266: Files sorted by Test Date

19.7 Show Subject Names in Dialog Boxes

Figure 267: Show Subject Names in lists?

You can select either ‘Show subject names in lists’ or ‘Do not show subject names in lists.” Selecting ‘Show
subject names in lists’ will show the subject’s name next to the filename in the file dialog boxes. Showing the
subject’s name can jeopardize the confidentiality of the subject, so you should insure confidentiality when
viewing the lists.
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19.8 Show File Information on the Main Screen

[Press 'Esc' to cancel] [Use 1 = 'Tab' to move]

Figure 268: Show information on the main screen
This dialog allows you to select whether data file information is displayed as a banner on the top of the main

screen, just below the menu and title header. Specifically displayed is the filename (with path), the test type
(‘Visual’, ‘Auditory’, or ‘None’), and the Interpretation type (‘Clinical’, ‘Screening’, or ‘None’).

19.9 Visual Stimulus Size

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 269: Change the size of the stimuli

The T.O.V.A. visual stimuli were normed with the following conditions:

a 12 inch (diagonally measured) monitor,

a stimulus size of roughly 3 inches (again, measured diagonally),

e an eye-to-monitor distance of roughly 24 - 36 inches (with an emphasis on 36 inches), and

the stimuli appeared at roughly eye level for the subject.

We recommend trying to mimic these conditions as closely as possible. However, given that monitor size,
monitor resolution and distance from the eyes can all vary, we recommend that the stimuli take 25% of the
monitor (diagonal length).

It’s not always possible to hit 25%, so we recommend a range of 15% - 30% of the monitor (diagonal length),
varying this percentage for the distance from the subject’s eyes to the monitor. The larger the distance, the
larger the stimuli can be.

There are two important reasons to have the correct target size:
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1. Stimuli which are two small (or too far away) can be visually fatiguing to discern. Since the T.O.V.A.
is a test of attention, not visual acuity, the subject should have no difficulty in discerning if the stimuli
is a target or nontarget.

2. Stimuli which are too big (or too close) require large eye sweeps to discern targets from nontargets. This
sweep can slow response time and be visually fatiguing. The subject should be able to see the complete
stimuli on the screen at once, without having to sweep their eyes to discern the target/nontarget.

Most monitors will easily fit between these bounds. However, sometimes a laptop with a large screen does
not have the capability to “expand” the T.O.V.A. ‘s smaller VGA testing screen to its maximum size. This
artificially small screen can cause the stimuli to appear very small on the screen. This is why there are four
stimuli sizing options:

e 1.0x (normal stimuli)

1.5x ( 50% larger)

e 2.0x (100% larger)

(
(
(
2.5x (150% larger)

We recommend choosing the option that fits the 25% rule, if possible. If the stimuli is still too small, we
recommend using an external CRT monitor for T.O.V.A. testing.

Finally, note that the stimuli are squares. If a wide-screen LCD panel noticeably distorts the image into a
rectangle, consider either using an external monitor or turning off screen expansion mode in your system
setup.

19.10 Stimulus Color

[Press 'Esc' to cancel] [Use 1 4 ¢ » 'Tab' to move]

Figure 270: Change the stimulus color

The default color setting for the T.O.V.A. visual stimuli is ‘white’, which is actually a very light gray color.
This color was chosen to be maximally visible against a black screen while not overly fatiguing to the eye.
However, sometimes it is necessary to change the color of the T.O.V.A. visual stimuli to compensate for a
particular monitor which may be too dim or too bright:

e Choose ‘Light White’ for monitors that have poor brightness (the stimuli are faint, or overly gray).

e Choose ‘Gray’ for monitors that have very high brightness and are fatiguing to see flash.
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The original T.0.V.A. norming study was carried out on Apple Ile computers with amber monitors. Some
researchers may wish to exactly mimic this display by choosing the fourth option, ‘yellow’. We believe, and
there is psychophysical research to demonstrate this, that there is a negligible difference between yellow and
white stimuli colors as long as neither is visually fatiguing.

20 Using the T.O.V.A. 7.3 Boot CD

Your T.O.V.A. 7.3 CD not only allows you to install the T.0.V.A. and our fine manuals, it also acts as a
boot CD. A boot CD is like the boot floppies of yesteryear; put the T.O.V.A. 7.3 CD in your CD (or DVD)

drive, restart your computer, and then your computer boots (starts up from) the CD instead of from your
hard drive.

Why would you ever need this? Well, it turns out Windows ME users can’t reboot into MS-DOS mode (unlike
Windows 95 and 98 users) so they need to use the boot CD to start up the T.O.V.A. And sometimes, for
whatever reason, the Precision Test Environment (PTE) doesn’t work correctly on a Windows 2000/XP
system. In that case, a Windows 2000/XP user may be forced to use the boot CD.

There are two catches to using the boot CD:

1. Your computer needs to have the CD listed first in its ‘boot order’ so that it actually does boot from
the CD before the hard drive. See the ‘Getting the CD to Boot’ section (section 35 on page 172)
for help with this if your computer doesn’t boot from the CD when the CD is in the drive and your
computer has been restarted.

2. Once your boot CD does indeed boot, the boot CD environment needs to have a hard disk format that
it understands so that it can launch the T.O.V.A. from, and save data to, that hard disk. The format
is called ‘FAT32’, and it’s not the default format for Windows 2000/XP computers. Which means you
have to add a FAT32 partition to your disk, which is not exactly a walk in the park. If you have an IT
department, they can (hopefully) easily add a small (> 50 MB - and no, that’s not a typo, a teeny-tiny
FAT32 partition is just fine) FAT32 partition and then you (or they) can install the T.O.V.A. on that
partition. It’s hard to add partitions to your drive by yourself, and we just can’t recommend it: it’s
hard, and dangerous to the existing data on your drive. But we’ve had many a brave user who has
partitioned their drive to use the T.O.V.A. Contact T.O.V.A. Technical Support for more information
on this process.

So: your computer needs to use the boot CD, it actually boots the boot CD, and you have a small FAT32
partition on your hard drive (or, for Windows 95/98 /ME users, your whole hard drive is a FAT32). You're
set!

There are two ways to use the T.O.V.A. with the boot CD.

20.1 Using the T.O.V.A. 7.3 CD to Start the T.O.V.A. in DOS mode

Windows 95, 98 and ME users must use the boot CD in this way. Windows 2000/XP users with a FAT32
partition can use the boot CD this way as well, but the second option is open to them if they want (and we
think you’ll want to, if that’s you).

e Put the CD in your CD drive.

e Restart your machine.
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e The CD will boot, and will automatically launch the T.O.V.A. from your hard drive in DOS mode (see
the Windows ME instructions, section 13 on page 88, for details on using the T.O.V.A. in this way).

e When you’re done, pop the CD out of the drive and reset or turn off your computer.

That’s really it. You get to run the T.O.V.A. in DOS mode, which means you do everything you want to,
including file operations, test administration, etc. The only real problem is that you can only print to a
DOS-compatible parallel port printer.

20.2 Using the T.O.V.A. 7.3 CD to Start the T.O.V.A. in Test mode

Windows 2000/XP users can set up their T.O.V.A. to use Windows and Test mode, which is what we
strongly recommend.

Install your T.O.V.A. to the FAT32 partition on your computer, and then run the T.O.V.A. from windows
just like in the ‘Administering the T.O.V.A. in Windows 2000 & XP’ section (section 11 on page 42). Except
instead of choosing the Precision Test Environment (PTE), you’ll choose the ‘TOVA Boot Media’ as the
Test mode environment. To summarize:

e Run T.O.V.A. in Windows (as detailed in the Windows 2000/XP section).

e Choose to enter Test mode.

e Choose the ‘TOVA boot media’ if it’s not already selected.

e Insert the CD into the CD drive and press ‘OK’ to immediately restart your computer.

e The CD will boot, and will automatically launch the T.O.V.A. from your hard drive in Test mode (see
the Windows 2000 and XP instructions, section 11 on page 42, for details on using the T.O.V.A. in
this way).

e When you exit the T.O.V.A., also eject the CD and remove from the drive.

e Your computer will restart, go back into Windows, and the T.O.V.A. will start automatically.

20.3 Other Booting Choices with the T.O.V.A. 7.3 CD

In both cases above, the T.0.V.A. 7.3 CD automatically chose the right thing to do. Sometimes, however,
you’ll need to do something different. Which is why there’s a 5 second ‘boot menu’ when the T.O.V.A. starts
up. Here are your choices, explained:

20.3.1 [1] Automatically run the T.0.V.A. 7.3 (default, in 5 sec)

This will search for FAT32 partitions, look for a T.O.V.A. 7.3 installation, and attempt to run it in Test
mode. If that fails, it will try and run it in DOS mode. If that fails, then the CD exits to DOS and at that
point, you should call us.

20.3.2 [2] Run the T.0.V.A. 7.3 in Test mode

You can force the T.O.V.A. CD to run the T.O.V.A. 7.3 in Test mode from a FAT32 partition by choosing
this option. Of course, that means that you have to had entered Test mode from Windows before choosing
this option (in which case this will fail).
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20.3.3 [3] Run the T.0.V.A. 7.3 in DOS mode (from a FAT32 partition)

You can force the T.O.V.A. CD to run the T.0.V.A. 7.3 in DOS mode from a FAT32 partition by choosing
this option. It requires no setup before hand, and is what most users of the boot CD use.

20.3.4 [4] Run the T.0.V.A. 7.3 in DOS mode (in Boot CD Environment)

If you just want to try out the T.O.V.A., you can choose this option and run the T.O.V.A. from the boot CD.
The T.0.V.A. will work beautifully in this environment, and you won’t even have to install the T.O.V.A. to
try it out.

Warning: although the T.O.V.A. will work, it will not save any data files!! Data files, unless you specifically
intervene to save them to a FAT32 partition, will be saved to the local memory and be lost when your system
is rebooted.

20.3.5 [5] Run an old T.0.V.A. 7.0 installation (from a FAT32 partition)

If you have an older T.O.V.A. 7.0 installation that was renamed into tova_70 during the T.O.V.A. 7.3
installation, then the boot CD can automatically call launch that older version of the T.O.V.A. if you must
use it again.

20.3.6 [X] Exit to DOS (FreeD0S 1.0)

And, sometimes, you just need to exit to DOS to test your computer, play around, or whatnot. Go nuts!
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Part V

The T.O.V.A. Report

In Part V of this manual, we’ll teach about how to generate and distribute the T.O.V.A. Report. We won’t
mention anything about how to understand and use the T.O.V.A. Report: for that kind of clinical guidance,
please see the T.O.V.A. Clinical (or Screening) Manual and the T.0O.V.A. Professional Manual.

e The Forms of the T.0O.V.A. Report see section 21 on page 145

Printing/Viewing the T.0.V.A. Report see section 22 on page 146

Exporting a T.O.V.A. Report to a file see section 23 on page 147

The T.0.V.A. Comparison Graph see section 24 on page 149

e The T.0O.V.A. School and Home Intervention Report see section 25 on page 150
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21 The Forms of the T.O.V.A. Report

For in-depth information on the T.0.V.A. Report, please see the T.O.V.A. Clinical (or Screening) Manual.
But here’s a non-clinical explanation of what each of the pages (forms) of the T.O.V.A. Report is all about.

21.1 Table of Contents

The table of contents page lists all of the forms you’re currently printing out, and provides a brief introduction
to the T.O.V.A. for the non-T.O.V.A. experienced. If you print out nothing but the table of contents, it
becomes a handy single page about the T.O.V.A. you should feel free to distribute.

21.2 Form 1: Interpretation

The T.0O.V.A. interpretation is the summarizes the outcome of this T.O.V.A. The T.0.V.A. interpre-
tation is not, we repeat NOT, a diagnosis!. It is simply a summary statement of the results of this
T.0.V.A., which must be interpreted by a clinician.

Further down that form, you’ll see validation notes, which will give you a brief summary of what problems
the T.O.V.A. had interpreting this test.

21.3 Form 2: Analysis Graph

The analysis graph visually displays most of the information that is given in the Analysis Data. In other
words, it’s a handy visual way of showing how the subject did with respect to the T.0O.V.A. norming study.
The graph is in standard scores, and both standard scores and standard deviations are listed below the graph
columns.

21.4 Form 3: Analysis Data

The analysis table shows, in detail, how the subject did compared to normals of the same age and gender (as
measured by all of the T.O.V.A. norming studies). This includes standard scores and standard deviations.
There are notes on validity and whether the particular part of the T.O.V.A. test was normal, borderline, or
not within the normal range (abnormal).

21.5 Form 4: Signal Detection Data

The signal detection data is a measure of how well the subject does a ‘signal to noise’ detection task. It’s
used as part of the ADHD Score, which is how the T.O.V.A. compares the subject’s score to those of people
diagnosed with ADHD.

21.6 Form 5: Information & Results

The results are the scored data from the test: raw numbers of errors, response times in milliseconds, etc.
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21.7 Form 6: Notes to Clinician

This form is meant for the clinician only, and is not available for the screening version of the T.O.V.A. It
alerts the clinician to various complicating factors, as well as some of our clinical insights on what the test
results might mean.

21.8 Comparison Graph

The comparison graph allows you to compare two or more T.O.V.A. together by generating a combined
analysis graph of all the tests. This is extremely handy for measuring response to treatment (e.g., medica-
tion), or for tracking the subject over time. For instructions on generating the comparison graph, pleas see
section 24 on page 149.

21.9 Interventions

The T.O.V.A. interventions allow a clinician to select various interventions appropriate to the home and
school settings. See section 25 on page 150 for instructions on how to use this handy report.

21.10 Raw Data

The raw data is the report of the stimulus-by-stimulus responses of the subject. The stimulus type (tar-
get, nontarget), the response type (correct response, omission, commission, etc), and the reaction type are
reported for each stimulus in the test.

22 Printing/Viewing the T.O.V.A. Report

22.1 Opening or Interpreting a T.O.V.A. Data File

In order to print or view a T.O.V.A. report, you must have a T.O.V.A. data file in memory that has test
data from a T.O.V.A. Test and has been interpreted.

To open a data file, choose ‘Open’ from the File menu (or press ‘F9’).

To interpret a test, see section 14.3.6 on page 123.

22.2 Viewing a T.0O.V.A. Report on the Screen

If you have just interpreted a test, the T.O.V.A. Interpretation (Form 1) will be displayed on your screen.

To view other forms of the T.O.V.A. report, use the Display menu. Press ‘Alt’ + ‘D’; and then the number
of the form you wish to view. Note that the forms may be larger than just one screen; press ‘Page Down’ to
view the rest of the form.

Simply press ‘Esc’ to get back to the main screen.
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22.3 Printing the T.O.V.A. Report

Before printing, first make sure that you have chosen the correct printer type and port. Choose the Setup
menu, ‘Settings’, then ‘Parallel Port Settings’ or ‘Select Printer’ to set these options.

To print a report, choose ‘Print’ from the File menu (or press ‘F8’). Select all of the forms you wish to print
by checking the appropriate check boxes using your mouse or using the space bar. Press ‘Tab’ to move to
the dialog box buttons and choose ‘OK’.

For more help on printing, see section 26 on page 154.

22.4 Printing under Windows

The default setup for the T.O.V.A. under Windows is to use the ‘Windows printer’. This option allows the
T.O.V.A. to print to any Windows-compatible printer through a 3rd-party program called ‘DOSPRINT’
that has been installed along with the T.O.V.A.

After you have chosen to print, the T.O.V.A. will call DOSPRINT which will allow you to preview the
T.0O.V.A. Report. You can select ‘Print’ from the top row of buttons to print the T.O.V.A. Report to your
default Windows printer or choose the ‘Options’ button to select a different printer.

Finally, note that if you have PDF-generating software such as Adobe Acrobat or the free and open-source
PDF Creator (see http://pdfcreator.sourceforge.net/), you can use DOSPRINT to generate a PDF of the
T.O.V.A. Report. This is useful for sharing T.O.V.A. reports with other clinicians or even with your subjects.

22.5 Exporting the T.O.V.A. Report

The T.0.V.A. Report can be ‘exported’ as an ASCII text file. This enables you to edit the report in any
standard word processor. This is particularly useful for inserting parts of the T.O.V.A. Report directly into
another report or paper.

For more information on exporting, please see section 23 on page 147.

23 Exporting a T.O.V.A. Report to a File

The T.0.V.A. Report can be ‘exported’ as an ASCII text file. This enables you to edit the report in any
standard word processor. This is particularly useful for inserting parts of the T.O.V.A. Report directly into
another report or paper.

Note: The T.O.V.A. Report cannot be exported in Test mode.
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File Setup Test Interpretation Interventions Display Uindow Felp
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Figure 271: Select the forms to be exported

Exporting a report is much like printing a report. Choose ‘Export’ from the File menu. Select all of the
forms you wish to export by checking the appropriate check boxes using your mouse or using the space bar
(Figure 271). Press ‘Tab’ to move to the dialog box buttons and choose ‘OK’.

File Setup Test Interpretation Interventions Display Uindow Felp

[Press 'Esc' to cancel] [Use 1 | ¢ » 'Tab' to move]

Figure 272: Specify the export filename
Afterward, you will have to specify the export file name (Figure 272), or accept the default.

File Setup Test Interpretation Interventions Display Uindow Felp

7.A. Continuous Performance Test

[To use the menu bar press 'Alt' + Letter and 1 1] [Use 'Tab' or 1 I to movel

Figure 273: Export in progress
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Continuous Perfor
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Figure 274: Export complete!
You will then be notified that the export is in progress (Figure 273), and, when completed (Figure 274),
where the export file was saved. The forms will be saved as a single file with multiple pages under the

specified filename. To avoid overwriting existing files, we recommend using the default export filename
generated by the T.O.V.A.

23.1 Changing the Export Path

The file will be automatically exported to the Export Path. By default, this is usually the EXPORT directory in
the T.0.V.A. installation directory (i.e., ‘C:\TOVA_7\EXPORT’). You can change the path where the exported
report files are saved to by choosing, under the File menu, ‘File Management’, ‘Change Export Path’. See
File Management, section 30 on page 163, for details.

23.2 Setting Up Export as the T.O.V.A. ‘Printer’

You can also configure the T.O.V.A. to ‘print’ to the export function by choosing from the Setup menu,
‘Settings’, ‘Select Printer’, ‘Export to Text File’. See section 19 on page 134 for more details.

Note: Exporting a report can be done or re-done at any time. You can always go back and re-export an
interpreted test.

24 The T.0O.V.A. Comparison Graph

24.1 Why Compare T.O.V.A. Tests?
You’ll want to compare the results of several T.O.V.A. tests when you are:

e Measuring response to treatment (e.g., medication), as you would in a baseline/challenge protocol.
e Tracking how a subject’s attention changes over time.

e Comparing a subject’s auditory and visual performance.

24.2 Generating a T.O.V.A. Comparison Graph

To generate a T.O.V.A. Comparison Graph,
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1. Choose ‘Open’ from the File menu (or press ‘F9’) and load the files in the order you want them to be
compared. In other words, the order in which you open them determines their order in the Comparison
Graph. If you want to reorder the Comparison Graph, you’ll need to choose ‘Close’ from the File menu
and close all the data files in memory, then re-open them in the order you want.

2. Choose ‘Compare Tests’ in the Interpretation menu.

3. Once the Comparison Graph has been generated, it will be displayed on the screen. Use ‘Page Down’
to display the second set of graphs on the screen.

Note that you must have at least two interpreted T.O.V.A. data files loaded in memory to generate a
Comparison Graph, and up to four tests may be compared at one time.

e To print the Comparison Graph, choose ‘Print’ from the File menu (or press ‘F8’), check ‘Comparison
Graph’, and choose ‘OK’.

e To export the Comparison Graph, choose ‘Export’ from the File menu, check ‘Comparison Graph’,
and choose ‘OK’.

For more information on comparing tests, see the T.0O.V.A. Clinical Manual.

25 The T.O.V.A. Intervention Report

25.1 About the Intervention Reports

The T.O.V.A. Intervention Reports contain a list of recommendations from which a clinician may select
appropriate and practical interventions for teachers and parents of children and teenagers with an attentional
deficit.

There are two categories of interventions: School Interventions, which generate interventions for teachers,
and Home Interventions, which generate home-based interventions for parents.

File Setup Test T play Uindow FHelp

Figure 275: About Interventions

For more information on Interventions, including how to choose and print appropriate interventions, choose
‘About Interventions’ under the Interventions menu (Figure 275).
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25.2 Choosing a Personalization Option

T.0O.V.A. Intervention Reports can be ‘personalized’. This means that the standard ‘generic’ interventions
which refer to ‘the student’ and ‘the individual’ can be replaced with the subject’s first name as entered in
the Subject Name field, as well as ‘he’/‘she’ as appropriate.

Continuous Performance

Figure 276: Personalized interventions?
To choose whether the interventions will be personalized, choose ‘Personalization’ from the Interventions

menu (Figure 276). The default choice is for generic interventions. If the Gender and Subject Name fields
have not been set, you will not be able to choose ‘Personalized’.

25.3 Choosing Interventions

sscosoooooffs
cosoooooooo

Figure 277: Selecting School Interventions

To generate a School Intervention Report, choose ‘Select School Interventions’ from the Interventions menu
(Figure 277).

Figure 278: Selecting Home Interventions
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To generate a Home Intervention Report, choose ‘Select Home Interventions’ from the Interventions menu
(Figure 278).

Press ‘Page Up’ and ‘Page Down’ to switch between the five pages of interventions in either category. Use the

Arrow keys and the ‘Tab’ key to move your selection, and press ‘Space Bar’ to “check” any intervention. To
see the full text of an intervention, press ‘Enter’. Choose ‘Done’ when you are done selecting interventions.

25.4 Viewing, Printing, and Exporting an Intervention Report

ention Report

[ PageUp’ /' PageDown’ for more]

Figure 279: A page of your T.O.V.A. Intervention Report

Once you have chosen ‘Done’, the T.O.V.A. Intervention Report will be displayed on the screen (Figure 279).
Since the report may be larger than one screen, press ‘Page Down’ to see more of the report.

To print the Intervention report, choose ‘Print’ from the File menu, check ‘Interventions’, and choose ‘OK’.

To export the Intervention report, choose ‘Export’ from the File menu, check ‘Interventions’, and choose
‘OK’.

For more information on the interventions, see the T.0.V.A. User’s Manual and the T.0O.V.A. Clinical
Manual.
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Part VI

Reference

This is the reference section, where we answer all the questions we didn’t answer in the rest of the manual.
If you can’t find your answer here, don’t forget, you can always call T.O.V.A. Technical Support!
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26 Troubleshooting T.O.V.A. Hardware

Sometimes things don’t work quite right. This section briefly discusses how to fix some common hardware
problems with the T.O.V.A. 7.3. As always, feel free to call our friendly and available T.O.V.A. Technical
Support staff for help as well!

26.1 Why isn’t my microswitch working?

First, make sure the microswitch ‘feels’ right. With a gentle press, it should make a sudden transition to
the pressed state with a single click. If it feels mushy, or very hard to press, or something is rattling in
the case, you're going to need a new microswitch. See section 28 on page 160 for details on replacing your
microswitch.

Second, make sure the Scorebox (which the microswitch is connected to) is correctly and securely plugged
into the parallel port of your computer. Also, some computers have multiple parallel ports: make sure
you know which one it’s plugged into. If you do have multiple parallel ports, make sure that the correct
parallel port is selected for the microswitch in the Setup menu under ‘Settings’, ‘Parallel Port Settings’,
‘Microswitch’. Note that if all you have is ‘LPT4’ in the list, it’s likely that your computer can’t find your
parallel port.

Third, if you have other parallel port peripherals (like the T.O.V.A. Speaker Driver, or a parallel port
printer), try removing those peripherals and seeing if the microswitch works. If the microswitch works
without the other peripherals, begin adding them back on until the microswitch fails and give T.O.V.A.
Technical Support a call. We'll help you figure out how to resolve the conflict. Note that often a parallel
port ‘switch’ box can help separate hardware that doesn’t play well together.

Fourth, your parallel port may not be up to the parallel port specification (IEEE 1284). This is true on
lower end computers in particular. In that case, you'll need an external way to terminate the port, either
by using a parallel printer (which is turned on, and really does have paper in it) or by using the T.O.V.A.
loop back plug, which simulates a printer being plugged in.

Fifth, try checking to see if your parallel port is working at all. If you have a parallel port printer, try printing
to it. Successfully printing to the printer means your parallel port is OK, and the problem is probably in
the microswitch.

Finally, if the microswitch intermittently works and then doesn’t, it should be replaced IMMEDIATELY;
a test taken with a faulty microswitch can’t be considered reliable. Again, see section 28 on page 160 for
details on replacing your microswitch.

26.2 Why did the Scorebox check fail?

If ‘Check Scorebox’ in the Setup menu fails, then first make sure the Scorebox is correctly and securely
plugged into the parallel port of your computer. Also, some computers have multiple parallel ports: make
sure you know which one it’s plugged into. If you do have multiple parallel ports, make sure that the correct
parallel port is selected for the microswitch in the Setup menu under ‘Settings’, ‘Parallel Port Settings’,
‘Scorebox’.

Second, if you have other parallel port peripherals (like the T.O.V.A. Speaker Driver, or a parallel port
printer), try removing those peripherals and seeing if the Scorebox works. If the Scorebox works without the
other peripherals, begin adding them back on until the Scorebox check fails again and then give T.O.V.A.
Technical Support a call. We’ll help you figure out how to resolve the conflict. Note that often a parallel
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port ‘switch’ box can help separate hardware that doesn’t play well together.

Third, your parallel port may not be up to the parallel port specification (IEEE 1284). This is true on lower
end computers in particular. In that case, you'll need an external way to terminate the port, either by using
a parallel printer (which is turned on, and really does have paper in it) or by using the T.0.V.A. loop back
plug, which simulates a printer being plugged in.

Fourth, try checking to see if your parallel port is working at all. If you have a parallel port printer, try
printing to it. Successfully printing to the printer means your parallel port is OK, and the problem is
probably in the Scorebox.

Finally, note that the Scorebox may not be accessible from within Windows at all, and may only be accessible
to the T.O.V.A. when in Test mode. If this is the case, you'll need to do all of your hardware checking and
use while in Test mode. Enter Test mode (see the ‘Administering the T.0.V.A. in Windows 2000 & XP’
section (section 11 on page 42).

26.3 Why did the system timing test fail?

The T.O.V.A. Test relies on your computer’s hardware for accurate and precise timing. Sometimes, however,
your hardware may not be up to the task. If when doing a ‘Check Hardware’ or administering a Practice
and/or T.0.V.A. Test, the hardware timing test fails, you’ll need to do a bit of investigation as to what’s
going on. Here are some of the most common problems:

1. Make sure you're not trying to Check Hardware or administer a test in Windows. Windows just does
not allow for the precision timing necessary for a continuous performance test like the T.O.V.A., so
you should never administer the T.O.V.A. under Windows. Enter Test mode, or restart your computer
into DOS, in order to check Hardware or administer a T.O.V.A. Test.

2. We use your computer’s real time clock as a comparison to the regular high precision timer, so if your
real time clock is not working correctly, the timing test will fail. If this is the case, you’ll notice that
your computer isn’t keeping track of the time correctly. In this case, you’ll need to replace the small
coin cell battery that runs the real time clock. Depending on your computer, this is sometimes best
done by a technician.

3. If you are running in a DOS mode provided to you by your operating system (e.g., MS-DOS mode
in Windows 95 and 98) then remove any software that may interfere with timing. In particular, this
means removing any TSRs (Terminate-and-Stay-Resident programs), DOS screen savers, disk doublers
or compression schemes, and custom virtual memory drivers.

4. Some computers have settings in their computer setup (BIOS setup) that affect T.O.V.A. timing. Go
into your BIOS (for reference, see ‘Getting the T.O.V.A. 7.3 CD to Boot’ (section 35 on page 172) and
look for references to ‘System Shadow’, ‘ROM Shadow’ and ‘Video Shadow’. Enabling these ‘shadows’
may fix your hardware timing issues.

5. This can be a tricky problem. As always, give us a call at T.0.V.A. Technical Support and we’ll help
you figure out what’s going on.

26.4 Why isn’t the auditory test working?
Let’s get two basic things out of the way first:

1. The most basic question is: did you purchase the auditory T.0O.V.A.? If so, then when you do ‘Check
Scorebox’ under the Setup menu you should see ‘Visual and Auditory’ in the ‘Testing Type’ section.
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2. Your Scorebox needs to be attached and working for the auditory features to be enabled. So if ‘Check
Scorebox’ complains about the lack of a T.O.V.A. Scorebox, you’ll need to fix that problem first. See
the above section, ‘Why did the Scorebox check fail?’.

Next, we’ll divide fixing your hardware into two sections: whether you have the speaker driver or whether
you’re using a Sound Blaster-compatible sound card.

26.4.1 Getting your T.0O.V.A. Speaker Driver to work

Unless you have an older Windows 95/98 era computer, it is unlikely that you have a Sound Blaster-
compatible sound card. In that case, you’ll need to use the T.O.V.A. Speaker Driver to generate your
auditory stimuli. The Speaker Driver is the ‘T’-shaped beige box on the ribbon cable that you installed
in Part I of this manual. The powered computer speakers that came with the T.O.V.A. kit plug into the
Speaker Driver, and together they make the auditory stimuli for the auditory T.O.V.A. Test.

We'll start with the basics, and work our way up:

1. Are your powered speakers on? There should be a green or red light on if they’re on.
2. Is the volume turned up (go ahead and crank it up for now)?

3. Are your powered speakers plugged into the back of the T.O.V.A. Speaker Driver? If the speakers are
on and the volume is set high, then gently inserting and removing the plug into the Speaker Driver
should make some clicking noise in the speakers (which will at least verify that you have the right cable
plugged in).

4. Is the Speaker Driver securely attached to the ribbon cable? And is the ribbon cable securely attached
to the computer and Scorebox?

5. Sometimes other parallel port peripherals get in the way of the Speaker Driver. Go ahead and remove
everything from your computer’s parallel port, and just plug in the Scorebox, and then the Speaker
Driver plugged into that. If it suddenly starts working, start adding back peripherals until it fails
again. Note that often a parallel port ‘switch’ box can help separate hardware that doesn’t play well
together.

6. Make sure you have the right ‘Sound Source’ selected. From the Setup menu, choose ‘Settings’, ‘Select
Sound Source’, and choose T.0O.V.A. Speaker Driver.

7. Make sure you have the right parallel port selected. Go to ‘Settings’ under the Setup menu and choose
‘Parallel Port Settings. Then choose ‘Scorebox’ and set it to the correct value. Note that if all you
have is ‘LPT4’ in the list, it’s likely that your computer can’t find your parallel port.

8. At this point, everything should be working, so try doing a ‘Check Sound’ from the Setup menu and
see if the tone is working now. If not, go ahead and give us a call and we’ll help you figure out what
is going wrong.

26.4.2 Getting your Sound Blaster-compatible sound card to work

If you do have a Sound Blaster-compatible sound card on your older PC, and you know that your DOS-mode
has the support for that card built in, then you can use your internal sound card.

We'll start with the basics, and work our way up:
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1. Are your powered speakers on? There should be a green or red light on if they’re on.
2. Is the volume turned up (go ahead and crank it up for now)?

3. Are your powered speakers plugged into the correct jack of your sound card? Make sure they’re plugged
into ‘line out’.

4. Make sure you have the right ‘Sound Source’ selected. From the Setup menu, choose ‘Settings’, ‘Select
Sound Source’, and choose ‘Sound Blaster-compatible Sound Card’.

5. At this point, everything should be working, so try doing a ‘Check Sound’ from the Setup menu and
see if the tone is working now. If not, go ahead and give us a call and we’ll help you figure out what
is going wrong.

26.4.3 Why do my auditory tests have 100% anticipatory errors?

100% anticipatory errors are usually the result of a parallel port printer interfering with the Speaker Driver.
First try turning off your printer and seeing if that helps. If it doesn’t, unplug your printer’s parallel port
cable and see if that helps. You can fix this problem by using a parallel port ‘switch’ box to switch between
your printer and the T.0.V.A. hardware, or by getting another parallel port card, or (the best from our
point of view) move to a USB printer if you have Windows 2000/XP computer.

If the problem persists, please do contact T.O.V.A. Technical Support.

26.5 Why can’t I print a report?
26.5.1 Windows Printer:

Note that the T.O.V.A. can only print to a Windows printer on Windows 2000 and XP systems only.

Also, note that printing to a parallel port printer as a Windows printers is not recommended: the background
printing process gets in the way of the T.O.V.A. accessing the Scorebox, which can sometimes lock up either
the T.O.V.A. or the background printing. We recommend a USB or network printer instead. If you really
want to print to the parallel port printer, then we recommend not printing under Windows. Instead, switch
your printer selection to the DOS printer which best matches your printer, and then only print when the
T.0.V.A. is in Test or DOS mode.

1. Is your printer working from Windows?

Open up any Windows application (e.g., Notepad) and try printing. If it prints correctly, then you're
set. If not, please fix that problem before continuing. Often we find that people don’t actually have
any printers installed on their computer (you can open up the Control Panel under the Start menu in
Windows and check how many printers are installed and which one is default).

2. Are you in Windows mode?
You can only print to a Windows printer from the T.O.V.A. in Windows mode. And again, Windows
mode is only available for T.O.V.A. installations on Windows 2000 and XP computers. It’ll say
‘Windows mode’ on the main screen of the T.O.V.A. when it’s in Windows mode.

3. Do you have ‘Windows Printer’ selected?

Confirm that you have ‘Windows Printer’ selected in the Setup menu under ‘Settings’, ‘Parallel Port
Settings’, ‘Printer’.

If you can answer ‘yes’ to these questions, and you still can’t print, contact T.O.V.A. Technical Support.
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26.5.2 DOS Printer:

Note that the T.O.V.A. can only print to a DOS printer from, surprise, DOS. Unexpected things may happen
if you try printing to a DOS printer and the T.0.V.A. is running under Windows, so please don’t do that.

If you can’t print from the T.0.V.A.| first make sure that the printer is correctly attached (See the printer’s
User’s Manual), is turned on, has paper and is “online”. Next, check under the Setup menu, ‘Settings’,
‘Parallel Port Settings’, ‘Printer’, to ensure the proper parallel port is selected for the Printer.

If you still can’t get it to work, change the printer port. Choose each one successively to determine which
one works. Note that if all you have is ‘LPT4’ in the list, it’s likely that your computer can’t find your
parallel port.

Try changing your printer type in the Setup menu, ‘Settings’, ‘Select Printer’, ‘Generic ASCII DOS Printer’
is the best choice to use if you are unsure of which option to choose.

If you are trying to print to a DOS printer from Windows mode, please don’t do that, since unexpected
things are bound to happen. Either print to the printer as a Windows Printer (through DOSPRINT), or
use your printer as a DOS printer in Test or DOS mode.

If you still can’t print, please contact T.O.V.A. Technical Support!

27 Troubleshooting T.O.V.A. Software

27.1 Why does the T.O.V.A. keep freezing (or crashing)?

If the T.O.V.A. is crashing with a specific error message, please write the message down — word-for-word if
possible — and contact T.0.V.A. Technical Support. We're always very interested in tracking down bugs in
the T.0.V.A., and we’ll shower you with praise and respect (and maybe even more!) if you help us track
down a bug. So, please, give us a call!

However, there are some things you can take care of by yourself fairly easily:

27.1.1 The T.O.V.A. freezes when starting in Windows 2000/XP

Most likely, there’s a conflict between your computer’s version of Windows and the T.O.V.A., which is trying
to access the Scorebox on the parallel port. This only happens on certain computers — usually Dells — and
it can be fixed by setting the ‘ScoreboxEnabled’ setting to ‘No’ in a file called tovastart.ini. For more
information, see section 34 on page 170.

27.1.2 The T.O.V.A. suddenly exits, complaining about lack of memory

The T.O.V.A. is a very complex software program and thus needs most of the memory your computer has
available for DOS applications. When running under Test mode or the T.O.V.A. 7.3 boot CD, you won’t
have to worry about memory (since we’ve taken care of it for you). But with DOS, or MS-DOS mode under
Windows 95/98, you do have to make sure you have at least 450 KB (500 KB recommended).

We won’t get into the gory details here, but what you’ll want to do is to remove as many TSRs and other
resident drivers as possible, and set DOS and other drivers to 'High’. Go ahead and give us a call, we’ll help
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you modify your CONFIG.SYS and AUTOEXEC.BAT to work for the T.O.V.A.

27.1.3 The T.O.V.A. freezes randomly

The T.O.V.A. is a bit of a touchy program. We’ll eventually fix that problem (permanently!), but for now
we’ll need to handle the T.O.V.A. a bit carefully. In particular, the T.O.V.A. doesn’t like a lot of random
characters from the keyboard sent to it. So if you have a wireless keyboard that sometimes generates lots of
random characters, this could kill the T.O.V.A.

Another reason could be low memory. If the T.O.V.A. always starts up OK, but after a test or two it gets
flaky, then go ahead and give it more memory to play with.

You'’re actually reading the manual? We're a little shocked, actually. Most people don’t, but you, you’ve
braved it!

Perhaps you’re determinedly trying to fix your problem. Or, possibly, you're bored out of your mind because
you forgot something to read while administering the T.O.V.A. So you’re reading the only thing available,
to make losing yet another 22 minutes of your life a bit more bearable...

In either case, we’re sorry.

But we are pretty pleased you’re reading this manual, because it was a lot of work to write. So give us a
call. Let us know that you read page 159 of the User’s Manual. Really. We dare you.

27.2 File and Disk Problems
27.2.1 Where are the T.O.V.A. files saved?

Sometimes people can’t find the T.O.V.A. files that they’ve been saving to disk. T.O.V.A. files are stored
in the Data Path, by default ‘C:\TOVA_7\FILE’. Export files are stored in the Export Path, by default
‘C:\TOVA_7\EXPORT’. ‘File Management’, under the File menu, allows you to designate a different Data Path
and Export Path (see section 30 on page 163).

27.2.2 Why can’t the T.O.V.A. save any of my files?

If you can’t save any data your drive may be full. If your drive isn’t full, and the T.O.V.A. can’t save files,
something is very, very wrong. Please call T.O.V.A. Technical Support immediately!

27.2.3 Why has my file been ‘corrupted’?

If the T.O.V.A. claims that a file has been corrupted, then either you or someone else has modified that data
file using another program (which you should NEVER do), or there may be a problem with your disk drive
and that file has been damaged. If you haven’t touched this file (in anyway), then you should check your
drive immediately. And at this point, let us remind you again to always make backups of your T.O.V.A.
datal
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27.3 Miscellaneous Issues
27.3.1 I have a file in memory; why is the main screen blank?

If you had a file in memory, and all of the information seemed to suddenly disappear, check to make sure
that your file is the Active File. Use the Window menu (‘Alt’ + ‘W’) to choose the active file.

27.3.2 Why can’t I interpret a test?
There are three reasons you may not be able to interpret a test:

e You do not have enough credits. See section 15 on page 129 for instructions on ordering additional
credits.

e Your Scorebox is not correctly attached or is malfunctioning. Check your Scorebox using the ‘Check
Scorebox’ option of the Setup menu; if it is not operating correctly, see section 26 on page 154.

e There is no valid test data in memory. In order to do an interpretation, there must be a T.O.V.A.
data file with test data in memory. Either administer a new test or open a file with test data.

27.3.3 Why is the subject’s age always wrong?

This is actually a hardware problem in the guise of a software problem. The date and time in your computer’s
clock may be wrong. Set the time and date using the Control Panel in the Start Menu (in Windows) or the
‘time’ and ‘date’ commands in DOS. Also, make sure the battery which runs the clock when you turn off the
computer is not dead; otherwise, you must reprogram the time and date every time you run the T.O.V.A.
This may also affect the hardware timing on the T.O.V.A. (see section 26 on page 154).

28 Replacing the T.O.V.A. Microswitch

The T.0.V.A. microswitch has been designed to stand up to the day-to-day wear of T.O.V.A. testing. It
has been designed for millions of button presses, it has been epoxied to its case with high strength epoxy,
and we even examine the broken microswitches we get back for quality control and to improve the design.

But, sometimes, our poor microswitches meet that 8 year-old boy who repeatedly smashes it against the
concrete floor in frustration. Or the cord is chewed through by the bored-silly 5 year old girl. We're sorry,
but when the case is cracked open, or the wires chewed through, or whatnot, you're just going to have to
replace the microswitch.

If you need a new microswitch, give us a call as soon as possible and let us know how fast you need a new
one. We'll send you a new one right away, and note that we might ask to have the old one sent to us for
quality control purposes.

To disconnect the microswitch from the Scorebox:

1. Locate the black in-line connector between the Scorebox and the Microswitch (Figure 280).

2. Grasp the left half of the connector with your left hand, and gently twist the inner ring on the right
side of the connector 90 degrees counter-clockwise (looking from the cable to the connector) with your
right hand.
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3. Once the inner ring has been rotated, pull the two ends gently apart. It should come apart with almost
no effort once the ring has rotated.

To connect the new microswitch to the Scorebox:

1. Push the two connectors together. The connectors are keyed (Figure 281), so you’ll have to twist one
side until you feel the connectors slide together.

2. Once they’ve slid together, they should be keyed together so they can’t rotate independently.

3. Now rotate the inner ring on the right side clockwise (looking from the cable to the connector) until it
clicks into place.

4. Pull gently on both ends of the connector; it should hold tight.

Figure 281: The T.O.V.A. microswitch’s connector, apart.

29 Using and Customizing Windows Printers

If you have the T.O.V.A. installed on a Windows 2000 or XP computer, you’ll be able to print to any
Windows-compatible printer. This even includes USB and network printers, which are usually not accessible
to DOS programs like the T.O.V.A. The way we do this is through a program called DOSPRINT.

DOSPRINT takes a file that is generated by the T.O.V.A., previews it to the user, and then prints it to the
default Windows printer. Note that DOSPRINT is a commercial piece of software which we’ve licensed for
you; you may not copy or distribute it except as distributed with the T.O.V.A. (sorry).

29.1 Using DOSPRINT

DOSPRINT is pretty self explanatory. You can zoom into the preview (which doesn’t help, sorry; for some
reason the Windows previewer that DOSPRINT uses doesn’t like the T.O.V.A. font), preview the different
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pages of your printout, and of course, print it. You can also cancel the print job.

The only thing you might want to do differently when you print the T.O.V.A. is send it to a non-default
printer. IN that case, select the ‘Options’ button at the top of the DOSPRINT screen (Figure 282).
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Figure 282: The DOSPRINT screen.

29.2 Customizing DOSPRINT

You have a bit of leeway to customize what DOSPRINT does. In particular, you can:

e Skip the preview screen altogether, and just have DOSPRINT print the file and exit.
e Choose what the default printer for DOSPRINT is.

The way to do this is to:

1. Double-click on ‘My Computer’ to open a window.
2. Find and double-click on the TOVA_7 folder.
3. Find and double-click on the DOSPRINT folder.

4. Right-click on the file called dosprint or dosprint.bat. The icon should look like a blue window
with a gear in the center of it.

5. Choose ‘Edit’ from the context menu that pops up after you have right-clicked on the file.
Read and choose which DOSPRINT option is best for you.
Edit the text so that the option you want does not have the REM in front of it, but all the rest do.

Choose ‘Save’ from the File menu, and close the editor that opened.

© o N >

Give it a try! It should work as you expect, and if it doesn’t, please give T.O.V.A. Technical Support
a call and we’ll help you out!

29.3 Important DOSPRINT Files

First of all, the important files involved are all in the DOSPRINT directory in the TOVA_7 directory which is
usually located right off your C: drive.
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TOVA_7\dosprint\TEMPFILE.PRT: The temporary file that the T.O.V.A. saves to send to DOSPRINT.

TOVA_7\dosprint\dosprint.bat: This is the batch file that TOVA uses to launch DOSPRINT.

TOVA_7\dosprint\dosprint.ini: The default settings for DOSPRINT. We don’t recommend you edit
this file, but sometimes you have to in order to get DOSPRINT to do the right thing.

TOVA_7\dosprint\dosprint.hlp: A Windows help file for DOSPRINT.

30 File Management Options

Figure 283: The File Management dialog

The File Management dialog (Figure 283) displays the current Data Path and Export Path. The Data Path
names the drive and directory where the T.O.V.A. subjects’ data files are stored. The default Data Path is
‘C:\TOVA_7\FILE'. The Export Path names the drive and directory where files are exported. The default
Export Path is ‘C:\TOVA_7\EXPORT’.

You may select one of the seven File Management options by highlighting the option’s radio button and
selecting ‘OK’. You may use the left button of your mouse to select the radio button and the ‘OK’ button.
If you are using your keyboard, you may select the radio button with your up and down arrow keys. Use
the ‘Tab’ key to switch between the radio buttons and the ‘OK’ button.

30.1 Change Data Path

When you access the browse dialogs for opening files, as well as for other operations, the files or directories
located in the Data Path are displayed. Although the browse dialogs allow you to access files which are
located in locations other than the Data Path, it those are the most convenient to access.

By default, the T.O.V.A. stores all the data files in one default data directory. In most instances, the factory-
selected Data Path is located at ‘C:\TOVA_7\FILE’. However, you may choose to keep T.O.V.A. data files in
different directories and/or drives. (For example, you may want to keep older files in an archive directory).

Selecting the Data Path:

If the desired Data Path is located on a different disk drive:

1. Select the ‘Disk’ button found at the bottom of the browse dialog.
2. Select the radio button for the disk drive of the desired data path.
3. Select ‘OK’
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After the correct disk drive is selected you may browse for the new Data Path. Two selection methods are
available:

e Selecting radio buttons in the browse list.

e Using the ‘Specify Path:’ field, type in a directory.

30.1.1 Selecting radio buttons

The browse dialog displays a list of the directories found in the current path. In addition, ¢ Select this directory (.)’
and ¢ Up one directory (..)’ are listed as options. This selection method only allows you to move up or
down one directory at a time.

If you want to go down one directory, select the radio button displayed next to the name of the directory.
Choose ‘OK’. Now, the dialog is browsing the selected directory.

Example: The current path is the disk’s root directory, ‘C:\’. You want to change the current path to
‘C:\TOVA_7\FILE'. From the browse list, select ‘\TOVA_7’ and choose ‘OK’. The current path becomes
‘C:\TOVA_7". Select ‘\FILE’ and choose ‘OK’. The current path now is ‘C:\TOVA_7\FILE".

If you want to go up one directory, select * Up one directory (..)’. After you choose ‘OK’, you will be
browsing the directory above the previous directory.

Example: The current path is ‘C:\TOVA_7\FILE’. You want to change the path to ‘C:\ARCHIVE’. From
the browse list, select ¢ Up one directory (..)’ and choose ‘OK’. The current path becomes ‘C:\TOVA_7’.
Select ¢ Up one directory (..)’ again and the current path becomes ‘C:\’. Select ‘\ARCHIVE’ and choose
‘OK’. The current path becomes ‘C: \ARCHIVE’.

30.1.2 Typed-in filename selection

You may also just type the desired path into the ‘Specify Path:’ field (Example: ‘C:\TOVA_7\FILE’).

30.1.3 Selecting the directory

Once you are browsing the desired directory, choose the ¢ Select this directory (.)’ radio button and
choose ‘OK’; and you will have selected that path to be the new Data Path.

30.2 Change Export Path

When you export files, a text report file is created in the Export Path. By default, the T.O.V.A. stores all
exported files in one default export directory. In most instances, the factory-selected Export Path is located
at ‘C:\TOVA_7\EXPORT’. However, you may choose to export files to a different directory and/or drive.

Selecting the Export Path

If the desired Export Path is located on a different disk drive:

1. Select the ‘Disk’ button found at the bottom of the browse dialog.
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2. Select the radio button for the disk drive of the desired data path.
3. Select ‘OK’

After the correct disk drive is selected you may browse for the new Export Path. T'wo selection methods are
available:

e Selecting radio buttons in the browse list.

e Using the ‘Specify Path:’ field, type in a directory.

30.2.1 Selecting radio buttons

The browse dialog displays a list of the directories found in the current path. In addition, * Select this directory (.)’
and ‘ Up one directory (..)’ are listed as options. This selection method only allows you to move up or
down one directory at a time.

If you want to go down one directory, select the radio button displayed next to the name of the directory.
Choose ‘OK’. Now, the dialog is browsing the selected directory.

Example: The current path is the disk’s root directory, ‘C:\’. You want to change the current path to
‘C:\TOVA_7\EXPORT’. From the browse list, select ‘\TOVA_7’ and choose ‘OK’. The current path becomes
‘C:\TOVA_7’. Select ‘\EXPORT’ and choose ‘OK’. The current path now is ‘C:\TOVA_7\EXPORT".

If you want to go up one directory, select ©* Up one directory (..)’. After you choose ‘OK’, you will be
browsing the directory above the previous directory.

Example: The current path is ‘C:\TOVA_7\EXPORT’. You want to change the path to ‘C:\ARCHIVE’. From
the browse list, select ¢ Up one directory (..)’ and choose ‘OK’. The current path becomes ‘C:\TOVA_7’.
Select ¢ Up one directory (..)’ again and the current path becomes ‘C:\’. Select ‘\ARCHIVE’ and choose
‘OK’. The current path becomes ‘C:\ARCHIVE'.

30.2.2 Typed-in filename selection

You may also just type the desired path into the ‘Specify Path:’ field (Example: ‘C:\TOVA_7\EXPORT’).

30.2.3 Selecting the directory

Once you are browsing the desired directory, choose the ¢ Select this directory (.)’ radio button and
choose ‘OK’, and you will have selected that path to be the new Export Path.

30.3 Copy Files

The T.0.V.A. equips you with the ability to copy multiple files easily from within the program.

1. You will first be prompted with a browse dialog, titled ‘Choose a Directory to Copy Files FROM’
where you can select which directory you want to copy the files from. You may enter the path into the
‘Specify Path:’ field, or you may browse up and down in the directory tree. Once you've arrived at the
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desired directory, choose the radio button labeled ¢ Select this directory (.)’ and then choose
‘OK".

2. You are next prompted with a similar browse dialog, titled ‘Select the Files to Copy’. This dialog lists
files instead of directories and allows you to mark the files you want to copy. Note that each has a
checkbox instead of a radio button, indicating that you may choose more than one. You may also enter
the name of a single file in the ‘Specify Filename:’ field.

3. The last browse dialog is similar to the first, titled ‘Choose a Directory to Copy Files TO’. This dialog
once again lists directories, this time prompting you to select the destination directory. You will select
the directory just as you did above in #1.

If any of the filenames copied already exist in the destination directory, you will be prompted to verify if
you want to overwrite them. Otherwise, upon completion, the T.O.V.A. will notify you of how many files
were successfully copied.

30.4 Move Files

The T.O.V.A. equips you with the ability to move multiple files easily from within the program.

Note: When you move files, they no longer exist in the original directory.

1. You will first be prompted with a browse dialog, titled ‘Choose a Directory to Move Files FROM’
where you can select which directory you want to move the files from. You may enter the path into the
‘Specify Path:’ field, or you may browse up and down in the directory tree. Once you’ve arrived at the

desired directory, choose the radio button labeled ¢ Select this directory (.)’ and then choose
‘OK”.

2. You are next prompted with a similar browse dialog, titled ‘Select the Files to Move’. This dialog lists
files instead of directories and allows you to mark the files you want to move. Note that each has a
checkbox instead of a radio button, indicating that you may choose more than one. You may also enter
the name of a single file in the ‘Specify Filename:’ field.

3. The last browse dialog is similar to the first, titled ‘Choose a Directory to Move Files TO’. This dialog
once again lists directories, this time prompting you to select the destination directory. You will select
the directory just as you did above in #1.

Because moving files deletes them from their original location, you will be prompted to verify that you want
to proceed.
If any of the filenames moved already exist in the destination directory, you will be prompted to verify if

you want to overwrite them. Otherwise, upon completion, the T.O.V.A. will notify you of how many files
were successfully moved.

30.5 Delete Files

The T.O.V.A. equips you with the ability to delete multiple files easily from within the program.

Note: Be sure you want to remove the information from your system. Once a file is deleted, it cannot be
recovered.
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1. You will first be prompted with a browse dialog, titled ‘Choose a Directory to Delete Files From’ where
you can select which directory you want to copy the files from. You may enter the path into ‘Specify
Path:’ field or you may browse up and down in the directory tree. Once you’ve arrived at the desired
directory, choose the radio button labeled ¢ Select this directory (.)’ and then choose ‘OK’.

2. You are next prompted with a similar browse dialog, titled ‘Select Files to DELETE’. This dialog lists
files instead of directories, and allows you to select the files you want to copy. Note that each has a
checkbox instead of a radio button, indicating that you may choose more than one. You may also enter
the name of a single file in the ‘Specify Filename:’ field.

3. The last dialog confirms that you want to go through with the deletion.

30.6 Import HomeTOVA Files

HomeTOVA files can be opened by the T.O.V.A. as T.O.V.A. data files. The HomeTOVA import feature
simply enables you to copy those files from the root directory of your floppy drive (‘A:\’) to the Data Path
(usually ‘C:\TOVA_7\FILE’).

If there is not floppy disk found, the browse will display instead the contents of the ‘C:\’ directory.

If you are copying files from any other drive or directory to any other drive or path, select the File menu,
‘File Management’, ‘Copy files’. If you would like to change the Data Path, select the File menu, ‘File
Management’, ‘Change Data Path’.

30.7 Import T.O.V.A. 6.0.08 Files

Information which was created and stored in T.O.V.A. 6.0.08 may be reviewed in this version of T.O.V.A.
However, the 6.0.08 information was stored in a different format. Therefore, you must import the information
so that it will conform to the current T.O.V.A. format.

See section 32 on page 168 for more information.

31 HIPAA and the T.O.V.A. 7.3

The Health Insurance Portability and Accountability Act (HIPAA) has had far reaching consequences, as
we're certain you know all about. We’ve designed some features of the T.O.V.A. 7.3 to help you fit the
T.0.V.A. 7.3 into your HIPAA-compliance procedures.

e The only required individually identifiable health information is the subject’s Date of Birth. The
subject’s name, while useful for the test administrator, is not necessary for the T.O.V.A. The subject
number can suffice, given the appropriate cross references by the test administrator.

e Although T.O.V.A. data files are encrypted, anyone with an installed T.O.V.A. 7.3 application will be
able to decrypt the file.

e The T.O.V.A. 7.3 does not have any kind of built-in authorization protocol, like a login and password.
Instead, the T.O.V.A. 7.3 assumes that the hospital has standard physical and computer security
measures in place that meet HIPAA requirements. A T.O.V.A. 7.3 on such a computer should be
protected enough for HIPAA compliance.
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However, there are some ‘best practices’ that we recommend to improve HIPAA compliance with the
T.O.V.A.:

Store Data on Protected Network Drives: The T.O.V.A. can read and write files to an arbitrary 8.3
path with less than 66 characters using the ‘Data Path’ (see section 30 on page 163) setting. Thus,
protected network shares (protected in the sense that they require logins and passwords) that are
mapped to Windows drives can work as protected data storage for the T.O.V.A. 7.3.

Do not use patient names: Instead, record the automatically generated T.O.V.A. subject number in the
subject’s Electronic Medical Records for future cross reference.

Remove all temporary T.0.V.A. 7.3 files: For robustness, the T.O.V.A. leaves two temporary files on
the hard drive that contain subject information. These files can be automatically deleted by adjusting
an ‘INT file: see ‘T.0.V.A. Settings in Windows 2000 and XP’ (section 34 on page 170).

And as always, if you need more information, please contact T.0.V.A. Technical Support, and we’d be happy
to help you with your HIPAA needs.

32 Importing T.O.V.A. 6.0.08 Data

If you have tests from the previous PC version of the T.O.V.A., the T.O.V.A. 6.0.08, you may “import”
them into this version of the T.O.V.A. in order to obtain a more in-depth analysis than was available in the
previous version.

Choose ‘File Management’ from the File menu (or press ‘F11’). Then choose ‘Import T.O.V.A. 6.0.08 files’.
Note: You must have a valid 7.x Scorebox attached in order to import 6.0.08 files.

The 6.0.08 import process will begin by searching the standard data file directories for potential 6.0.08 files.
These are:

Default drive):\NEWTOVA\TOVADATA\DATA\*.DAT

(
(Default drive):\TOVA\TOVADATA\DATA\*.DAT
(

Default drive):\TOVADATA\DATA\*.DAT

A:\TOVADATA\DATA\*.DAT

B:\TOVADATA\DATA\*.DAT

If the files are found, you can choose to browse the path where they were found or select a different path. If
files are not found you may still select a path to check for 6.0.08 files. Selecting a path for importing 6.0.08
files is like selecting any other path: use the directory selection dialog to navigate to where your files are.

Once you've identified the directory to use, a file browse dialog will appear. This dialog lets you choose
one or more files to import. Note: just because a file appears on the list does not mean that the file is a
T.0.V.A. 6.0.08 file or that all the information needed to import it is there. When you choose a data file
to be imported, the T.0.V.A. will automatically look for and process the other related 6.0.08 files (‘. ANZ’,
“.RPT’, ‘.RDT").

Indicate the files you wish to import by clicking on the checkboxes at the left. Click ‘OK’ once you have
finished.
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Once the importing process has completed, a dialog will be displayed reporting the success or failure of the
import. All successfully imported files will be placed in the Data Path, by default ‘C:\TOVA_7\FILE. If
there were errors, an import log will be displayed containing specifics on which files failed and why.

32.1 Import T.O.V.A. 6.0.08 Full and Partial Success Codes

If the T.O.V.A. 7.3 can successfully import enough data to be useful, you’ll get the following messages:

OK All necessary files found, saved, and interpreted.
###NO INTERP#itt No *.ANZ’ or “.RPT’ file could be found; still imported but not interpreted.
###INVALID MEDICATION DATA### Medication data was invalid and could not be imported.

32.2 Import T.O.V.A. 6.0.08 Failure Codes

If the T.O.V.A. 7.3 can’t import enough files to be useful, you’ll get the following error messages:

### BAD DATA #i## Couldn’t open the *.DAT’ file or the ‘. DAT’ file was corrupt.
### NO RAW DATA ### The associated . RDT”’ file was not found.

### BAD RAW DATA #i#i# The associated . RDT’ file was corrupt.

### SUBJECT NUMBER OVERFLOW ### There were more than 99 files with one subject number.
### 1/0 ERROR ### Some disk related error occurred: disk locked, disk full, etc.
### INVALID OR NO SUBJECT INFO ### Some necessary subject info was missing or invalid.

### NOT A 6.0.08 FILE ### The file was not a 6.0.08 file.

Note that ‘IMPORT.LOG’ will be saved to the directory where the T.O.V.A. was installed, by default
‘C:\TOVA_7".

33 Advanced Settings
WARNING: DO NOT CHANGE ANY ADVANCED SETTINGS UNLESS ABSOLUTELY
NECESSARY.

We strongly encourage you to contact T.0.V.A. Technical Support before changing any setting; many of
these settings can have a lot of consequences on how the T.0O.V.A. operates.

Note: You must have a clinical version of the T.O.V.A. to access the expert settings.
To get to advanced settings, choose ‘Settings’ from the Setup menu. Then choose ‘Advanced Settings’.

Again, if you’d like to change these settings, we strongly encourage you to contact T.0.V.A. Technical Support
before changing them.

33.1 Visual Stimulus Flicker Compensation

This allows you to adjust a timing offset in the T.0.V.A. testing engine to compensate for certain video
hardware which might cause the stimulus to flicker (e.g., cross a VSYNC). Read the instructions carefully,
and then try different values of the compensation until the flicker no longer happens.
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33.2 EEG Communication Protocol

This turns on and off the EEG Communication Protocol in the T.0O.V.A. 7.3. In this mode, the T.O.V.A.
outputs a signal on the parallel port for the stimulus on, target vs. nontarget, and the T.O.V.A. microswitch.
This allows the T.O.V.A. to be used as a sort of evoked response stimulus in EEG research.

33.3 T.0O.V.A. Test Parameters

Researchers who are doing research on CPTs can force the T.O.V.A. Test Format, inter-stimulus interval,
stimulus on-time, stimulus off-time, and anticipatory cutoff time. It will completely invalidate the T.O.V.A.
norms, but sometimes that’s OK, especially for specialized research projects.

33.4 Autosave

You can’t really turn off autosaving permanently. But sometimes, you might want to test the T.O.V.A.
without doing any automatic disk access. In that case, you can turn it off for the current T.O.V.A. session
if you had to.

34 T.O.V.A. Settings in Windows 2000 and XP

The T.O.V.A. application is called through a secondary program called ‘TOVAStart.exe’. TOVAStart allows
the T.O.V.A., which is a 16 bit application, to run well in a 32 bit environment like Windows.

TOVAStart has a LOT of options in its initialization file, and in general, we strongly recommend that you
do not edit these settings without contacting T.O.V.A. Technical Support first. However, we’d be reticent
in our duties if we didn’t at least tell you how do edit it, and what options there are.

34.1 Editing TOVAStart.ini

The way to edit this ‘ini’ file is:

1. Double-click on ‘My Computer’ to open a window.
2. Find and double-click on the TOVA_7 folder.
3. Find and double-click on the tovastart folder.

4. Double-click on the file called TOVAStart or TOVASTart.ini. The icon should look like a notepad with
a gear on top of it.

5. Edit the options as you see fit in the text editor that pops up.

6. Choose ‘Save’ from the File menu, and close the editor that opened.
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34.2 TOVAStart Options

Below are the options in the ini file. We've listed them all, but we’ve bolded the ones we think are the
interesting ones you should know about. Also, you of course remember that PTE stands for the Precision
Test Environment, right?

[Version] Section

Setting Name | Values Description
TovaVersion text string | Please don’t edit this.

[Reboot Settings] Section

Setting Name Values Description

RebootNow Yes,No Sets the default option on the pre-PTE dialog when the T.O.V.A.
is on its way to Test mode. Yes means the ‘Immediately’ option is
set, and ‘No’ means the ‘Later’ option is set.

UsePTE Yes,No Sets the default option on the pre-PTE dialog when the T.O.V.A.
is on its way to Test mode. Yes means the ‘Use the PTE’ option
is set, and ‘No’ means the ‘Use the Boot Media’ option is set.

BootMenuTitle text string Please don’t edit this.

BootTimeout integer number | The number of seconds the T.O.V.A. pauses at the Windows vs.
PTE boot prompt (stored in the file BOOT.INI during the PTE
transition).

MouseEnabled | Yes,No ‘Yes’ enables the mouse driver in the PTE, and ‘No’ disables it.

Sometimes mice drivers cause all sorts of havoc in the PTE, so we
like to be able to disable them sometimes.

[Startup Settings] Section

Setting Name Values Description

Start Wait integer number | The number of seconds the T.O.V.A. pauses when Windows is
starting up. 15 seconds is the time we’ve found works the best; if
you don’t need Scorebox access in Windows and you don’t want to
wait, you can set this to ‘0.

ScoreboxEnabled | Yes,No ‘Yes’ enables the scorebox to be used in Windows, ‘No’ disables it.
On some Windows XP computers (especially Dells), the T.O.V.A.
will lock up when it runs because it’s trying to directly access the
parallel port. This will stop it. Of course, you can still access the
Scorebox in the PTE.

DeleteTempFile Yes,No “Yes’ deleted both of the temporary files with HIPAA protected
information in them, ‘No’ does not. Choosing ‘Yes’ is slightly dan-
gerous, because it removes a backup file that is sometimes very
handy in the case of a computer crash. But some hospitals will
require this.

[Paths and Files] Section
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Setting Name Values | Description

TestPathDat path Path to TESTPATH.DAT, which contains the path of the T.O.V.A.
data file that the T.O.V.A. is sending into the Test mode (via the
PTE or via the boot CD).

TOVAStartLog path Path to TOVAStart.Log, which is the log file for TOVAStart.

BootImageFile path Path to TOVABOOT . IMG, which is the PTE image file.

CleanBootImageFile path Path to CleanBoot.img, which is the clean (not modified) PTE
image file.

TOVAPath path Path to TOVA_7 folder.

TOVAFileDat path Path to TOVAFile.dat, which is a temporary copy of the file being
sent to Test mode (via the PTE or via the boot CD).

TOVAExe path Name of the T.O.V.A. executable.

PreferencesPath path Path to PREFEREN. INT file, which contains the T.O.V.A. applica-
tion’s settings.

MCopy path Path to mtools.exe, which allows TOVAStart to read and write
to the image files.

BOOTINI path Path to your computer’s BOOT. INT file.

BOOTALT path Path to the T.O.V.A.’s BOOT.ALT file used in the PTE to reset
BOOT.INI.

LatestBootINIBackupFile | path Path to the last copy made of your clean BOOT.INI file.

DefragExe path Path to JkDefragCmd.exe, which is the open source Windows
2000/XP defragmentation utility that must be run on three files
for the PTE to work.

DefraglLogFile path Path to Defrag.log, which is the log file for JkDefragCmd.exe.

[Image Paths] Section

Setting Name Values | Description
ImageTOVAFileDat | path Path to TOVAFILE.DAT in the image file.
ImagePreferenINI path Path to PREFEREN. INI in the image file.

35 Getting the T.O.V.A. 7.3 CD to Boot

If you insert the T.O.V.A. CD into your CD-ROM drive and restart your system, the system should boot
to the CD, meaning that it will try to run the T.O.V.A. in FreeDOS instead of running Windows. If it does
not, however, don’t panic! You probably just have a different boot configuration. We can probably change
your system so that it will try to boot to the CD before the hard drive. It just means we’re going to have
to change your BIOS settings. Okay, you can panic now.

Just kidding. The truth is that configuring your BIOS is pretty easy. Telling you how to configure your
BIOS is virtually impossible. This is because almost every system does it differently, and only some of them
give you helpful clues along the way. You may have to reboot your system two or three times before we
figure it out. But we will figure it out.

It may help you in performing this task to imagine that you are a BIOS ninja. It sounds ridiculous, and it
is. But to change your boot order, we will need to strike quickly and slip in and out without disturbing the
environment, and most of all, adapt to the unexpected. That sounds like a ninja to us, but if it sounds like
a platypus to you, hey, it’s your imagination.
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35.1 Reboot Your System

This is the easy step, because you’ll always have to do this first. Unless your computer is currently off, in
which case step one will be Turn your system on instead.

35.2 Getting to the BIOS

When you first reboot your system, you will likely see some kind of logo, and some information about your
RAM or processor you probably usually ignore. You will hopefully also see something like “Press F10 to
enter Setup” or “Hit DEL for BIOS”. If you don’t see it the first time, reboot your system and look again.

There is always a chance that there will not be any such helpful message. One of our test systems, for
instance, does not. As it turns out, the key to press is ‘F1’, but we’ve seen quite a few others. If you have
no message, try the following:

Delete’, ‘Esc’, F1°, ‘F107, ‘F12’

Here’s where you're gonna need those ninja-like reflexes. Whichever key it turns out to be, it will need to
be pressed while that initial splash screen appears, which could be as long as twenty seconds or as short as
one.. Furthermore, even if you press the right key, it may not immediately respond. If none of those work,
and you may have to try them more than once, you might need to contact your company or organizational
system support, the tech support that came with your system, or you can always try T.0.V.A. Technical
Support.

ROM PCI/ISA BIOS (2A6IKSNG)

CMOS SETUP UTILITY
AWARD SOFTWARE, INC.

STANDARD CMOS SETUP INTEGRATED PERIPHERALS
BIOS FEATURES SETUP SUPERVISOR PASSWORD
CHIPSET FEATURES SETUP USER PASSWORD

POMER MANAGEMENT SETUP IDE HDD AUTO DETECTION

PNP/PCI CONFIGURATION HDD LOW LEVEL FORMAT

LOAD SETUP DEFAULTS SAVE & EXIT SETUP
EXIT WITHOUT SAVING

Esc : Quit
710 : Save & Exit Setup

Figure 284: Award BIOS start screen, with the cursor on the correct section.

<Enable>

Figure 285: Intel BIOS start screen. You’ll want the ‘Boot’ tab (at the top).
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35.3 Using the BIOS Utility

When you've successfully entered the BIOS Configuration program, you will most likely see a DOS-style
application, without windows or a fancy GUI. Use your ninja powers of perception to examine your environ-
ment. There will probably be some basic directions somewhere on the screen telling you how to navigate the
program. As with the last step, no two BIOS utilities are alike, so we can’t give you any specific instructions.

We can tell you roughly what you are looking for. You want to change the “Boot order” or “Boot configu-
ration”. Again we can’t tell you how your BIOS is organized, but as you try this section and that, use your
keen ninja senses open for the word “Boot”. You will probably not find it in the top level menu, so don’t be
surprised if you have to check two or even three levels deep for the setting.

Note: You should be careful not to change anything else while you're here, but every BIOS utility we have
ever seen has a way to exit the BIOS without saving changes. If your ninja skills fail you, and you think
you might have accidentally changed a setting, Don’t panic! Slowly, carefully follow the instructions on the
screen to exit the BIOS without saving. Then reboot your system and try again.

35.4 Changing the Boot Order

Eventually, hopefully, you will find a setting for something like “Boot Order”, “Boot Priority”, or “Boot
Sequence”. This is your target! Again, we wish we could tell you specifically how to change this setting, but
we can tell you what you are trying to do.

Every time your system reboots, it checks a sequence of devices, one after the other, looking for an operating
system. Once it finds that operating system, it stops looking. Among these device may be: Floppy drive,
more than one hard disk drive (HDD), USB drive, CD and/or DVD drive, and more. What we want to do
is change this sequence so that before it checks your hard drive, it will check your CD drive. How all those
other devices get prioritized is up to you.

ROM PCI/ISA BIOS (2A69KSNG)
BIOS FEATURES SETUP
AWARD SOFTWARE, INC.

Virus Warning : Disabled | Video BIOS Shadow : Emabled
{ cru Internal Cache : Enabled | CB0OO-CBFFF Shadow : Disabled
External Cache : Enabled [ CCOOO-CFFFF Shadow : Disabled
CPU L2 Cache ECC Checking : Enabled | DOOOO-D3FFF Shadow : Disabled
Processor Number Feature : Disabled | D4000-DPFFF Shadow : Disabled
Quick Power On Self Test : Enabled | DBOOO-DBFFF Shadow : Disabled
Boot Sequence : CDROM,C,A| DCOOO-DFFFF Shadow : Disabled
Suap Floppy Drive : Disabled
Boot Up Floppy Seek : Enabled
Boot Up Mumlock Status  : OfF
| Gate A28 Option : Fast
Typematic Rate Setting  : Disabled
Typematic Rate (Chars/Sec) : 6
Typematic Delay (Msec)  : 250
I Security Option : Setup
PCI/GH Palette Snoop : Disabled | ESC @ Q
fssign 1RQ For UGA : Enabled | F1 : H
03 Select For DRAM > 64MB : Non-0S2

| Report No FDD For WIN 95 : Mo

Figure 286: Award BIOS setup page, with the boot order entry highlighted.
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<Enable>

Figure 287: Intel BIOS boot screen, with the boot order entry highlighted.

35.5 Exiting the BIOS Utility

Now that we’ve changed our boot order, we need to slip out of here unseen, without accidentally changing
anything else.Examine the directions carefully, looking for a key that will let you “Save and Exit” or “Save
Changes”. You may be able to do this from this screen or you may have to return to the main menu. If
you’ve changed the boot sequence and you haven’t touched anything else, save your changes and exit.

Now reboot your system with the T.O.V.A. CD in the drive and try again. This time it should boot to
the T.O.V.A., or at least to the T.O.V.A. boot menu. Congratulations, your mission is complete, and your
honor is intact.

If it didn’t work, you may want to review the directions, as unhelpful as they are, and try again. Or you may
want to call T.O.V.A. Ninja, er, we mean, Technical Support. Our highly-trained operators will be honored
to serve you.

36 T.O.V.A. Filenames

When you save a new data file in the T.O.V.A. it is automatically assigned a filename that can seem cryptic.
However, the name is not random, but, in fact, can give you some information about the subject, without
revealing anything personal.

The default filename is created as follows:
GGSSSSEE.MAA
Where:

GG = 2-digit group number (01 - 99)

SSSS = 4-digit subject number (0001 - 9999)
EE = 2-digit session number (01 - 99)

M = Gender (‘M’ or ‘F’)

AA = 2-digit age (04 - 99)
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On a new installation of the T.0O.V.A. 7.3, the default Group number is ‘01°, the default Subject number is
‘0001 and the default Session number is ‘01’. Therefore, on a new installation of the T.O.V.A., your first
filename will start with ‘01000101°. Next we add the gender (‘M’ or ‘F’) and the age (‘04’ to ‘99’).

For example, a filename of 01000902.M12 tells you that this data file is the second (‘02’) test session for your
ninth (‘0009’) subject, who is a 12-year-old male.

Note: Those zeroes are a clue to you. You may only have 99 sessions per Subject number (you could always
assign your subject an additional Subject number if you needed to give 100 or more), 9999 subjects per
group, and 99 groups per T.O.V.A. installation. If you find that you need to administer more than 100
million T.O.V.A. tests, we will be happy to oblige you with a customized version of the T.O.V.A.!

36.1 A Note about the Group Number

By default, all your files are a member of Group number ‘01’. The point of the Group number is pure
organizational. If you exceed Subject number ‘9999’ in a given Group, the Group number will automatically
increment. You can modify the Group number for a given subject on the main screen, though we prefer
that you use ‘Settings’ under the Setup menu to modify your Group, Subject, and Session numbers, so the
T.0.V.A. will perform auto-numbering correctly.

36.2 Export Files

When you export a T.O.V.A. report, a text filename is created as follows:
GGSSSSEE. TXT
Where:

GG = 2-digit group number (01 - 99)
SSSS = 4-digit subject number (0001 - 9999)
EE = 2-digit session number (01 - 99)

You’ll probably notice that this is the same as the default data filename, except that it has a .txt extension. To
avoid overwriting existing files, we recommend using the default export filename generated by the T.O.V.A.

37 T.O.V.A. Modes

Our goal for the new Windows 2000/XP version of the T.0.V.A. 7.3 — with its Windows mode and Test
mode — is that it just works. When you ‘go to Test mode’, we don’t want you to have to think about all that
that involves.

That having been said, some of you may want to know just what all that nonsense that pops up on the
screen is for. For you, we’ve written this section.
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37.1 The Players

Below is a list of all the files directly involved in making the test mode in the Precision Test Environment

(PTE) happen.
Files in C:\
ntldr
grldr
TOVABOOT . IMG

BOOT.INI

BOOT.ALT

The Windows 2000/XP application that reads and processes
BOOT.INI when you start your computer.

GRUB, the GRand Unified Bootloader, is called by ntldr to boot
our special image.

Our special boot image. It is exactly 2.88 MB in size and simulates
a floppy disk.

The Windows 2000/XP boot configuration file. The T.O.V.A. 7.3
modifies this file to provide a boot menu that includes the T.O.V.A.
Precision Test Environment (PTE).

A special backup copy of your original BOOT.INI. Both it and
BOOT.INT are padded with extra spaces so that they reach a size
greater than 4 KB.

Files in \TOVA_7 (The T.O.V.A. install path)

tova_app.exe

PREFEREN. INI

The T.0O.V.A. DOS executable. The same application is used in
DOS, Windows, and Test modes, but is flagged for the different
modes.

The T.O.V.A. preferences file. This is where all your settings (par-
allel port, file sorting, Data Path, etc.) are stored. It is a binary
file, so it cannot be modified in a text editor.

Files in \TOVA_7\tovastart (The TOVAStart path)

tovastart.exe

TOVAStart.ini

TOVAStart.log

The T.O.V.A. application launcher for Windows. When you choose
the T.O.V.A. shortcut in your Start menu, you run TOVAStart.exe
which, in turn, runs tova_app.exe. It also manages the process of
going to and returning from Test mode.

The TOVAStart configuration file. It contains all the paths and
filenames used by TOVAStart, as well as a number of other settings.
You can modify this file in a text editor, though we recommend you
consult T.O.V.A. Technical Support first.

This records every step (and misstep) that TOVAStart takes, and
is very useful to Technical Support in diagnosing any errors you
encounter.

Files in \TOVA_7\boot (The boot files path)
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mtools.exe
cleanboot.img
JkDefragCmd.exe
TESTPATH.DAT
TOVAFile.dat

BootOriginal.ini

An open-source tool used to manipulate the contents of TOV-
ABOOT.IMG.

The unaltered copy of TOVABOOT.IMG.

An open-source tool used defragment files.

When you elect to ‘Enter Test Mode’ from the T.O.V.A. applica-
tion, this contains the path to your T.0.V.A. data file.

This is a copy of your T.O.V.A. data file created for entering Test
mode with a Boot CD.

Because it is an important Windows system file, we always re-
store your original BOOT.INI after returning from Test mode.
Should our process fail before we can do so, this file contains the
original copy of your system’s BOOT.INI. If we detect changes
to your BOOT.INT (some users may re-configure their system for
dual-booting), we create additional date and time-stamped backup
copies.

Image Files (Files of note in the boot image used in the PTE)

: :\TOOLS\tova.bat

There are three versions of this file: one for the PTE, one for the
PTE that disables the mouse (for systems with hardware conflicts),
and one for the Boot CD. It displays the T.O.V.A. build you're run-
ning and provides a menu of available options that varies between
the PTE and the Boot CD. After a brief pause, it also automati-

cally runs the T.O.V.A. using default options.

: :\TOOLS\REBOOT . COM Just type reboot to reboot your system back to Windows.

::\TOOLS\rev.bat

Creates an environment variable with the current T.O.V.A. build.

::\TOVA_7\tova_app.exe The T.0.V.A. application for Test mode.
::\TOVA_7\TOVAFILE.DAT The PTE copy of your T.O.V.A. data file.
: :\TOVA_7\PREFEREN.INI The PTE copy of your T.O.V.A. preferences file.

Honorable Mention

FreeDOS This is the PTE operating system, an open-source DOS environ-

ment.

37.2 How it all works

1. When you click on an installed T.O.V.A. shortcut, you run TOVAStart.exe.

2. TOVAStart determines that you're not returning from Test mode, and so it just runs the T.O.V.A.
application (tova_app.exe).

3. You create a new T.0.V.A. data file, and choose to ‘Enter Test Mode’.

4. TOVAStart reads the data file path from TESTPATH.DAT, backs up BOOT.INI if modified, and
prompts you to choose your Reboot selections.

e which boot media to use:

— Precision Test Environment (default)
— Boot CD

e when to reboot:

— Immediately (default) - we reboot your system now

— Later (You reboot when you're ready.)
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5. If you chose the ‘Boot CD’, TOVAStart copies the T.O.V.A. data file specified in TESTPATH.DAT
to TOVAFILE.DAT in the TOVA_7\boot directory.

6. If you chose ‘PTE”:

(a) TOVAStart prepares TOVABOOT.IMG:
i. Restores the clean TOVABOOT.IMG from cleanboot.img.

ii. mtools copies your T.O.V.A. data file into the image file.

iii. mtools copies PREFEREN.INI into the image file.

iv. If the mouse was disabled in TOVAStart.INI, mtools updates tova.bat in the image file to the

‘no mouse’ version.

(b) TOVAStart creates BOOT.ALT with the original BOOT.INT contents.
(¢) TOVAStart modifies BOOT.INT to display a boot menu and launch the PTE by default.

(d) TOVAStart pads both BOOT.INT and BOOT.ALT to 5 KB. After we boot to the PTE, we’ll
want to copy BOOT.ALT to BOOT.INT to restore your normal boot process, and files smaller
than 4 KB cannot be easily accessed on an NTFS drive since they get tucked into the depths of
the file system.

(e) TOVAStart uses JkDefrag to defragment BOOT.INI, BOOT.ALT, and TOVABOOT.IMG. The
first two are defragmented so that the GRUB tool can copy the contents of BOOT.ALT to
BOOT.INT safely. TOVABOOT.IMG is defragmented because to access it on an NTFS drive
as a virtual floppy disk, all 2.88 MB must be contiguous on the hard drive.

7. TOVAStart then either reboots your system immediately or exits so you can reboot at your convenience.

37.2.1 The Precision Test Environment

If you chose the Precision Test Environment, here’s what happens next:

1. ntldr checks BOOT.INI to determine what operating system it should boot. BOOT.INI, as we have
modified it, tells it to display a menu offering a choice between the ‘T.O.V.A. Precision Test Environ-
ment’ and your usual operating system. This menu appears for only 3 seconds, after which it defaults
to the PTE.

2. ‘T.O.V.A. Precision Test Environment’ is actually our modified version of GRUB’s grldr, which per-
forms the following tasks:

(a) grldr copies BOOT.ALT back over BOOT.INI, restoring your normal boot process. The next
time you reboot, our menu should be gone, and ntldr should automatically boot your Windows
operating system.

(b) grldr finds TOVABOOT.IMG and maps it as A:, a virtual floppy disk.

(c) grldr boots to the T.O.V.A. image.

3. The T.0.V.A. boot image is the essence of the PTE. It is a 2.88 MB FreeDOS environment that,
through the magic of GRUB, reads from and writes to the boot image file just as if it were a real
disk drive. FreeDOS operates just as you remember DOS working: it loads command.com which calls
config.sys and then autoexec.bat. ‘config.sys’ enables XMS memory handling. ‘autoexec.bat’ loads the
mouse driver and then calls ‘tova.bat’.

4. ‘tova.bat’ shows you another menu, where you can run the T.O.V.A. or exit to FreeDOS. Like the boot
menu, after 3 seconds it proceeds with the default to run the T.O.V.A. in Test mode.

5. The T.0.V.A. loads your data from TOVAFILE.DAT and your preferences from PREFEREN.INI.
Both were added to the image, as you’ll remember, by TOVAStart above.
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In Test mode, the T.O.V.A. can only use the one data file passed to it from Windows mode. You
cannot open or save to any other files.

Once finished with Test mode, you may exit the T.O.V.A. You have the option to reboot back to
Windows or exit to FreeDOS.

If you do, at any point, exit to FreeDOS, you may be disappointed to find that your options are rather
limited. If your hard drive is NTFS, you will not be able to access them, any more than you would if
you booted your system to a floppy disk or a DOS system CD. Accessing NTFS from DOS is all but
impossible, which is why the PTE is a very powerful dedicated tool for running the T.O.V.A.

You can hit Ctrl-Alt-Del, type ‘reboot’ at a command-line, or just exit the T.0.V.A. normally to
reboot back to Windows.

37.2.2 The Boot CD

Your other option for T.O.V.A. testing on a Windows 2000/XP system is the T.0.V.A. Boot CD. This
requires that you installed the T.O.V.A. 7.3 to a FAT32 partition on your system. If you did not, you should
not use the Boot CD for testing, and should instead select the PTE.

37.2.3 Back in Windows

1.

Once back in Windows, TOVAStart will automatically launch itself (there’s a shortcut in the Startup
folder in your Start menu) and find that you’re returning from Test mode.

TOVAStart restores your BOOT.INT from the latest backup copy, just in case.

mtools extracts your T.O.V.A. data file from Test mode out of TOVABOOT.IMG and copies it over
the old T.O.V.A. data file.

mtools likewise extracts the preferences file from TOVABOOT.IMG and copies it over the old prefer-
ences file, in case you changed preferences in Test mode.

TOVAStart begins a countdown to launching the T.O.V.A. application. The countdown, 15 seconds
by default, is helpful in allowing your other automatic Windows processes to finish starting up.

TOVAStart launches the T.O.V.A. application.

The T.O.V.A. application automatically loads the file that has just returned from Test mode.

That’s it! That’s all the nitty-gritty details of the T.O.V.A. modes process.
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